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The manuals for this printer are arranged as follows. Please use them as a reference as needed.

CD-ROM Guides with this symbol are PDF manuals included in the accompanying CD-ROM.

• Installation
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• Troubleshooting

User's Guide
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Remote UI Guide CD-ROM
To view the manual in PDF format, Adobe Reader/Adobe Acrobat Reader is required. If Adobe Reader/Adobe Acrobat Reader is not installed on your 
system, please download it from the Adobe Systems Incorporated website.
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Preface
Thank you for purchasing the Canon LASER SHOT LBP3310. 
Please read this manual thoroughly before operating the printer in order to familiarize 
yourself with its capabilities, and to make the most of its many functions.  
After reading this manual, store it in a safe place for future reference.

How To Use This Manual

 

Symbols Used in This Manual
The following symbols in this manual are used to highlight procedures, restrictions, 
handling precautions, and instructions that should be observed for safety.

WARNING Indicates a warning concerning operations that may lead to death or 
injury to persons if not performed correctly. In order to use the printer 
safely, always pay attention to these warnings.

CAUTION Indicates a caution concerning operations that may lead to injury to 
persons, or damage to property if not performed correctly. In order to 
use the printer safely, always pay attention to these cautions.

IMPORTANT Indicates operational requirements and restrictions. Be sure to read 
these items carefully in order to operate the printer correctly, and to 
avoid damage to the printer.

NOTE Indicates a clarification of an operation, or contains additional 
explanations for a procedure. Reading these notes is highly 
recommended.

 

Keys and Buttons Used in This Manual
The following are a few examples of how keys and buttons are depicted in this 
manual:

• Control panel keys: Key icon + (Key Name)
Example: (Cancel Job)

• Buttons on Computer Operation Screen: [Button Name]
Example: [OK]

[Details]
ix



   
Displays Used in This Manual
Displays used in this manual may differ from those shown on your computer display, 
depending on the system.

The buttons to be clicked are marked with a  as shown below.

If multiple buttons can be clicked for a procedure, all such buttons will be marked on 
the illustration. Select the appropriate button.

Illustrations Used in This Manual
• The illustrations of the toner cartridge used in this manual mean the toner 

cartridge (Canon Genuine Cartridge) of which printable pages are approximately 
3,000 pages.

10 Click [Next].

Click this button for operation.
x



        
• Though not shown in the illustrations in this manual, the control panels are labeled 
with names in certain countries or regions.

• Although the power cord used in this manual is as the one in the following 
illustration, the form of the power cord may differ depending on the country or 
region.

Abbreviations Used in This Manual
In this manual, product names and model names are abbreviated as follows:

Microsoft Windows 2000 operating system: Windows 2000

Microsoft Windows XP operating system: Windows XP

Microsoft Windows Server 2003 operating system: Windows Server 2003

Microsoft Windows Vista operating system: Windows Vista

Microsoft Windows Server 2008 operating system: Windows Server 2008

Microsoft Windows 7 operating system: Windows 7

Microsoft Windows operating system: Windows
xi



Legal Notices
Product Name
Safety regulations require the product's name to be registered.

In some regions where this product is sold, the following name(s) in ( ) may be 
registered instead.

LBP3310 (F151800)

FCC (Federal Communications Commission)

■ 110 - 127 V model
This device complies with part 15 of the FCC Rules. Operation is subject to the following 
two conditions: (1) This device may not cause harmful interference, and (2) this device 
must accept any interference received, including interference that may cause undesired 
operation.
This equipment has been tested and found to comply with the limits for a class B digital 
device, pursuant to Part 15 of the FCC rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation.

If this equipment does cause harmful interference to radio or television reception, which 
can be determined by turning the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver 

is connected.
• Consult the dealer or an experienced radio/TV technician for help.
Use of shielded cable is required to comply with class B limits in Subpart B of Part 15 of 
FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in 
the manual. If such changes or modifications should be made, you could be required to 
stop operation of the equipment.
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Canon U.S.A. Inc.
One Canon Plaza, Lake Success, NY 11042, U.S.A.
Tel No. (516) 328-5600

EMC Directive (220 - 240 V model)
"This equipment has been tested in a typical system to comply with the technical 
requirements of EMC Directive."

• Use of shielded cable is necessary to comply with the technical requirements of 
EMC Directive.

The product is in conformity with the EMC directive at nominal mains input 230 V, 
50 Hz although the rated input of the product is 220 - 240 V, 50/60 Hz.

C-tick marking  on the rating label means that we declare the product is in 
conformity with the relevant requirements at nominal mains input 230 V, 50 Hz 
although the rated input of the product is 220 - 240 V, 50/60 Hz.

Laser Safety
This product complies with 21 CFR Chapter 1 Subchapter J as a Class I laser 
product under the U.S. Department of Health and Human Services (DHHS) 
Radiation Performance Standard according to the Radiation Control for Health and 
Safety Act of 1968. Also, this product is certified as a Class 1 laser product under 
IEC60825-1:1993 and EN60825-1:1994. This means that the product does not 
produce hazardous laser radiation.

Since radiation emitted inside the product is completely confined within protective 
housings and external covers, the laser beam cannot escape from the machine 
during any phase of user operation. Do not remove protective housings or external 
covers, except as directed by the equipment's manuals.
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The label shown below is attached to the laser scanner unit inside the machine.

CLASS 1 LASER PRODUCT
LASER KLASSE 1
APPAREIL A RAYONNEMENT LASER DE CLASSE 1
APPARECCHIO LASER DI CLASSE 1
PRODUCTO LASER DE CLASE 1
APARELHO A LASER DE CLASSE 1

CAUTION
Use of controls, adjustments, or performance of procedures other than those 
specified in this manual may result in hazardous radiation exposure.

International Energy Star-Program

As an ENERGY STAR Partner, Canon Inc. has determined that 
this product meets the ENERGY STAR Program for energy 
efficiency.

The International ENERGY STAR Office Equipment Program is an 
international program that promotes energy saving through the 
use of computers and other office equipment.

The program backs the development and dissemination of 
products with functions that effectively reduce energy 
consumption. It is an open system in which business proprietors 
can participate voluntarily.

The targeted products are office equipment, such as 
computers, displays, printers, facsimiles, and copiers. The 
standards and logos are uniform among participating nations.
xiv



WEEE Directive

Trademarks
Canon, the Canon logo, LASER SHOT, LBP, NetSpot, and PageComposer are 
trademarks of Canon Inc.

Adobe, Adobe Acrobat, and Adobe Reader are trademarks of Adobe Systems 
Incorporated.

IBM is a trademark of International Business Machines Corporation.

Microsoft, Windows, and Windows Vista are trademarks or registered trademarks of 
Microsoft Corporation in the U.S. and/or other countries.

Ethernet is a trademark of Xerox Corporation.

Other product and company names herein may be the trademarks of their 
respective owners.

European Union (and EEA) only.

This symbol indicates that this product is not to be disposed of 
with your household waste, according to the WEEE Directive 
(2002/96/EC) and your national law. This product should be 
handed over to a designated collection point, e.g., on an 
authorized one-for-one basis when you buy a new similar product 
or to an authorized collection site for recycling waste electrical 
and electronic equipment (EEE). Improper handling of this type of 
waste could have a possible negative impact on the environment 
and human health due to potentially hazardous substances that 
are generally associated with EEE. At the same time, your 
cooperation in the correct disposal of this product will contribute to 
the effective usage of natural resources. For more information 
about where you can drop off your waste equipment for recycling, 
please contact your local city office, waste authority, approved 
WEEE scheme or your household waste disposal service. For 
more information regarding return and recycling of WEEE 
products, please visit www.canon-europe.com/environment.

(EEA: Norway, Iceland and Liechtenstein)
xv



     
Copyright
Copyright 2009 by Canon Inc. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, including photocopying and recording, or by any 
information storage or retrieval system without the prior written permission of 
Canon Inc.

Disclaimers
The information in this manual is subject to change without notice.

CANON INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS 
MATERIAL, EITHER EXPRESS OR IMPLIED, EXCEPT AS PROVIDED HEREIN, 
INCLUDING WITHOUT LIMITATION, THEREOF, WARRANTIES AS TO 
MARKETABILITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE OF USE OR AGAINST INFRINGEMENT OF ANY PATENT. CANON 
INC. SHALL NOT BE LIABLE FOR ANY DIRECT, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES OF ANY NATURE, OR LOSSES OR EXPENSES 
RESULTING FROM THE USE OF THIS MATERIAL.
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Legal Limitations on the Usage of Your Product and the 
Use of Images

Using your product to scan, print or otherwise reproduce certain documents, and 
the use of such images as scanned, printed or otherwise reproduced by your 
product, may be prohibited by law and may result in criminal and/or civil liability. A 
non-exhaustive list of these documents is set forth below. This list is intended to be 
a guide only. If you are uncertain about the legality of using your product to scan, 
print or otherwise reproduce any particular document, and/or of the use of the 
images scanned, printed or otherwise reproduced, you should consult in advance 
with your legal advisor for guidance.

• Paper Money • Travelers Checks

• Money Orders • Food Stamps

• Certificates of Deposit • Passports

• Postage Stamps (canceled or 
uncanceled)

• Immigration Papers

• Identifying Badges or Insignias • Internal Revenue Stamps (canceled 
or uncanceled)

• Selective Service or Draft Papers • Bonds or Other Certificates of 
Indebtedness

• Checks or Drafts Issued by 
Governmental Agencies

• Stock Certificates

• Motor Vehicle Licenses and 
Certificates of Title

• Copyrighted Works/Works of Art 
without Permission of Copyright 
Owner
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  Important Safety Instructions
Please read this "Important Safety Instructions" thoroughly before operating the 
printer. Please be aware of these instructions, for they are intended to prevent 
injury to the user or other persons, as well as destruction of property. Also, since it 
may result in accident or injury, do not perform any operations not specified in the 
manual. Improper operation or use of this machine could result in personal injury 
and/or damage requiring extensive repair that may not be covered under your 
Limited Warranty.

 

Installation

WARNING
• Do not install the printer near alcohol, paint thinner, or other flammable substances. 

If flammable substances come into contact with electrical parts inside the printer, 
this may result in a fire or electrical shock.

• Do not place the following items on the printer. If these items come into contact with 
a high-voltage area inside the printer, this may result in a fire or electrical shock.
If these items are dropped or slipped inside the printer, immediately turn OFF the 
printer and computer aaaa and disconnect the USB cable from the printer bbbb if it is 
connected. Then, unplug the power plug from the AC power outlet cccc and contact 
your local authorized Canon dealer.
- Necklaces and other metal objects
xviii



- Cups, vases, flowerpots, and other containers filled with water or liquids

CAUTION
• Do not install the printer on unstable locations, such as unsteady platforms, inclined 

floors, or in locations subject to excessive vibrations, as this may cause the printer to 
fall or tip over, resulting in personal injury.

• Do not block the ventilation slots on the printer. They are required for proper 
ventilation of the working parts in the printer. Also, do not place the printer on a soft 
surface, such as a sofa or a rug. Blocking the slots can cause the printer to overheat, 
resulting in a fire.

• Do not install the printer in the following locations, as this may result in a fire or 
electrical shock:
- A location exposed to high humidity or excess dust
- A location exposed to smoke and steam, such as in cookeries or near or humidifiers
- A location exposed to rain or snow
- A location near water faucets or water
- A location exposed to direct sunlight
- A location subject to high temperatures
- A location near open flames

• When placing the printer, lower the printer onto the floor or other surface cautiously 
to avoid catching your hands, as this may result in personal injury.

• When connecting the interface cable, connect it properly following the instructions in 
this manual. If not connected properly, this may result in malfunction or electrical 
shock.

• When moving the printer, follow the instructions in this manual to hold it correctly. 
Failure to do so may cause you to drop the printer, resulting in personal injury. (See 
"Moving the Printer," on p. 7-24)

a

b

c

a
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Power Supply

WARNING
• Do not damage or modify the power cord. Also, do not place heavy objects on the 

power cord, or pull on or excessively bend it, as this could cause electrical damage 
and result in a fire or electrical shock.

• Keep the power cord away from heart sources. Failure to do this may cause the 
power cord insulation to melt, resulting in a fire or electrical shock.

• Do not plug or unplug the power plug with wet hands, as this may result in electrical 
shock.

• Do not plug the power cord to a multiplug power strip, as this may cause a fire or 
electrical shock.

• Do not bundle up or tie the power cord in a knot, as this may result in a fire or 
electrical shock.

• Insert the power plug completely into the AC power outlet, as failure to do so may 
result in a fire or electrical shock.

• Do not use power cords other than the one provided, as this may result in a fire or 
electrical shock.

• As a general rule, do not use extension cords or plug extension cords to a multiple 
power strip. However, if extension cords must be used and/or plugged to a multiple 
power strip, use them observing the following points, at the user's own risk. If you 
use extension cords improperly, this may result in a fire or electrical shock.
- Do not connect one extension cord to another.
- Make sure that the voltage of the power plug is the one indicated in the rating label 

(attached to the back of the printer) when you use the printer.
- Use an extension cord of greater electrical-current capacity than the value indicated 

in the rating label (attached to the back of the printer).
- If you use an extension cord, untie the cord binding and insert the power plug 

completely into the extension cord outlet to ensure a firm connection between the 
power cord and the extension cord.

- Periodically check that the extension cord is not overheating.

CAUTION
•  Do not use power supplies with voltages other than those specified herein, as this 

may result in a fire or electrical shock.

• Always grasp the plug when unplugging the power cord. Pulling on the power cord 
may expose or snap the core wire, or otherwise damage the power cord. If the power 
cord is damaged, this could cause electricity to leak, resulting in a fire or electrical 
shock.

• Leave sufficient space around the power plug so that it can be unplugged easily. If 
objects are placed around the power plug, you will be unable to unplug it in an 
emergency.
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Handling

WARNING
• Do not attempt to disassemble or modify the printer. There are high-temperature and 

high-voltage components inside the printer which may result in a fire or electrical 
shock.

• Electrical equipment can be hazardous if not used properly. To avoid injury, do not 
allow children access to the interior of any electrical products and do not let them 
touch any electrical contacts or gears that are exposed.

• If the printer produces strange noises, smoke, heat or unusual odors, immediately 
turn OFF the printer and computer and disconnect the USB cable, if connected. Then, 
unplug the power plug from the AC power outlet and contact your local authorized 
Canon dealer. Otherwise, this may result in a fire or electrical shock.

• Do not use flammable sprays near the printer. If gas from these sprays comes into 
contact with the electrical components inside the printer, this may result in a fire or 
electrical shock.

• Always turn OFF the printer and computer, and disconnect the interface cables along 
with the power plug when moving the printer. Otherwise, the power cord or interface 
cables may be damaged, resulting in a fire or electrical shock.

• Do not drop paper clips, staples, or other metal objects inside the printer. Also, do 
not spill water, liquids, or flammable substances (such as alcohol, benzene, and paint 
thinner) inside the printer. If these items come into contact with a high-voltage area 
inside the printer, this may result in a fire or electrical shock. If these items are 
dropped or slipped inside the printer, immediately turn OFF the printer and computer, 
and disconnect the USB cable if it is connected. Then, unplug the power plug from 
the AC power outlet and contact your local authorized Canon dealer.

• When plugging or unplugging the USB cable while the power plug is plugged in an 
AC power outlet, do not touch the metal part of the connector, as this may result in 
electrical shock.

CAUTION
• Do not place heavy objects on the printer, as they may tip over or fall resulting in 

personal injury.

• Be careful when handling the expansion board. Touching the edges or any sharp 
parts of the expansion board may result in personal injury.

• Turn OFF the power switch for safety if the printer will not be used for a long period of 
time, such as overnight. Also, turn OFF the power switch on the right of the printer 
and unplug the power plug for safety if the printer will not be used for an extended 
period of time such as during vacations or extended holidays.

• Keep your hands or clothing away from the roller in the output area. Even if the 
printer is not printing, sudden rotation of the roller may catch your hands or clothing, 
resulting in personal injury.
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• The face-up output slot and its surroundings become hot during or immediately after 
using the printer. Do not touch the face-up output slot and its surroundings, as doing 
so may result in burns.

• The paper may be hot immediately after being output. Be careful when removing the 
paper as well as when aligning the removed paper, especially after printing 
continuously. Otherwise, this may result in burns.

• The laser beam can be harmful to humans. Since radiation emitted inside the printer 
is completely confined within protective housings and external covers, the laser 
beam cannot escape from the printer during any phase of user operation. Read the 
following remarks and instructions for safety.
- Do not open covers other than those instructed in this manual.
- Do not remove the caution label attached to the cover of the laser scanner unit.

- If the laser beam escapes from the printer, exposure may cause serious damage to 
your eyes.
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Maintenance and Inspections

WARNING
• When cleaning the printer, turn OFF the printer and computer, remove the USB cable, 

and then unplug the power plug. Failure to observe these steps may result in a fire or 
electrical shock.

• Unplug the power plug from the AC power outlet regularly, and clean the area around 
the base of the power plug's metal pins and the AC power outlet with a dry cloth to 
ensure that all dust and grime is removed. If the power plug is plugged for a long 
period of time in a damp, dusty, or smoky location, dust can build up around the 
power plug and become damp. This may cause a short circuit and result in a fire.

• Clean the printer using a slightly dampened cloth with water or a mild detergent 
diluted with water. Do not use alcohol, benzene, paint thinner, or other flammable 
substances. If flammable substances come into contact with electrical parts inside 
the printer, this may result in a fire or electrical shock.

• There are some areas inside the printer which are subject to high voltages. When 
removing jammed paper or when inspecting the inside of the printer, do not allow 
necklaces, bracelets, or other metal objects to touch the inside of the printer, as this 
may result in burns or electrical shock.

• Do not throw a used toner cartridge into open flames, as this may cause the toner 
remaining inside the cartridge to ignite, resulting in burns or a fire.

CAUTION
• Do not attempt to service this printer yourself, except for procedures outlined in this 

manual.
There are no user-serviceable parts inside the printer. Adjust only those controls that 
are covered in the operating instructions. Improper adjustment could result in 
personal injury and/or damage requiring extensive repair that may not be covered 
under your Limited Warranty.

• The fixing unit and its surroundings inside the printer become hot during use. When 
removing jammed paper or when inspecting the inside of the printer, do not touch the 
fixing unit and its surroundings, as doing so may result in burns.

• When removing jammed paper or replacing the toner cartridge, take care not to allow 
the toner to come into contact with your hands or clothing, as this will dirty your 
hands or clothing. If your hands or clothing become stained with toner, wash them 
immediately with cold water. Washing them with warm water may fix the toner and 
make it not possible to remove the toner stains.

• When removing paper jammed inside the printer, remove the jammed paper gently to 
prevent the toner on the paper from dispersing and getting into your eyes or mouth. If 
the toner gets into your eyes or mouth, wash them immediately with cold water and 
immediately consult a physician.

• When loading paper or removing jammed paper, take care not to cut your hands with 
the edges of the paper.

• Remove the toner cartridge carefully to prevent the toner from scattering and getting 
into your eyes or mouth. If the toner gets into your eyes or mouth, wash them 
immediately with cold water and immediately consult a physician.
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• Do not attempt to disassemble the toner cartridge. The toner may scatter and get into 
your eyes or mouth. If the toner gets into your eyes or mouth, wash them immediately 
with cold water and immediately consult a physician.

• If toner leaks from the toner cartridge, be careful not to inhale the toner or allow it to 
come into contact with your skin directly. If the toner comes into contact with your 
skin, wash it out with soap. If you have an irritation on your skin, or if you inhaled the 
toner, immediately consult a physician.

• When removing a used toner cartridge from the toner cartridge slot, remove the 
cartridge carefully to prevent the toner from dispersing and getting into your eyes or 
mouth. If the toner enters your eyes or mouth, wash them immediately with cold 
water and immediately consult a physician.

 

Consumables

WARNING
• Do not throw a used toner cartridge into open flames, as this may cause toner 

remaining inside the cartridge to ignite and result in burns or a fire.

• Do not store toner cartridges or copy paper in places exposed to open flames, as this 
may cause the toner or paper to ignite and result in burns or a fire.

• Place the toner cartridge into a plastic bag to prevent its toner from scattering, and 
then dispose of the toner cartridge according to local regulations.

CAUTION
• Keep toner cartridges and other consumables out of the reach of small children. If 

these items or contents are ingested, consult a physician immediately.

• Do not attempt to disassemble the toner cartridge. The toner may scatter and get into 
your eyes or mouth. If the toner gets into your eyes or mouth, wash them immediately 
with cold water and immediately consult a physician.

• If toner leaks from the toner cartridge, be careful not to inhale the toner or allow it to 
come into contact with your skin directly. If the toner comes into contact with your 
skin, wash it out with soap. If you have an irritation on your skin, or if you inhaled the 
toner, immediately consult a physician.

Others

WARNING
The toner cartridge generates a low level magnetic field. If you use a cardiac 
pacemaker and feel abnormalities, please move away from the toner cartridge and 
consult your physician immediately.
xxiv
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Features and Benefits
This section describes the major features.

■ High-Performance Printing System "CAPT"
LBP3310 is equipped with the latest high-performance printing system, "CAPT" (Canon 
Advanced Printing Technology), that is compatible with Windows operating systems. As 
this system allows data to be batch-processed by a computer instead of a printer, it 
enables high-speed printing, making full use of the features of the computer. Also, a large 
amount of data can be processed without requiring more printer memory.

■ USB 2.0 Hi-Speed Installed as Standard
LBP3310 achieves high-speed transmission by supporting Hi-Speed I/F USB 2.0 that 
offers up to 480 Mbps transmission speeds.

■ High Speed Printing and Super High Quality Printing
Delivers a high printing speed of 26 pages per minute. Relieves the stress of waiting for a 
print job to finish. This printer is fitted with a 600-dpi laser printer engine. A stunningly high 
resolution of 2400 dpi equivalent x 600 dpi is made possible through new Super 
Smoothing Technology which is unique to Canon. Furthermore, because the grayscale 
makes use of a dithering pattern, photographs and graphics can be printed with 
beautifully subtle reproduction.

■ Duplex Unit Installed as Standard
LBP3310 is supplied with a duplex unit. Therefore, you can automatically perform 2-sided 
printing with paper (A4, Legal, and Letter size) loaded in the multi-purpose tray or paper 
cassette. By doing so, you can save paper and storage space for files.

■ Simple Maintenance and Printer Status Window
The toner cartridge made for this printer (Canon Genuine Cartridge) is designed as a 
single part containing both toner and the photosensitive drum, so that it can be easily 
replaced.

The Printer Status Window that is displayed during printing allows you to determine the 
printer status through the use of graphical cues, improving the overall usability of the 
printer. Additionally, if the printer is shared on a network, the print server can set the 
display settings of all client computers for the Printer Status Window.

■ Low Power Consumption and Quick Startup
By adopting "On-demand Fixing System", LBP3310 has achieved lower power 
consumption and quick startup. "On-demand Fixing System" is the Canon-developed 
technology which enables instantaneous heating of the fusing heater only prior to printing.
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■ Various Paper Handling Options
This printer is supplied with the 50-sheet multi-purpose tray and 250-sheet paper 
cassette, enabling feeding of up to 300 sheets of paper. Also, the optional 250-sheet 
paper feeder is available, enabling continuous automatic feeding of up to 550 sheets of 
paper in three different sizes.

Although LBP3310 is fundamentally designed to print A4 size or smaller, you can print A3 
and B4 size documents on A4 size paper by using the function to reduce the standard 
paper sizes. As you can also print irregular, custom size paper, this printer supports a 
wide array of uses.

■ Supporting Various Types of Media
Supports various types of media including plain paper, heavy paper, Index Card, 
envelopes, labels, and transparencies. 

■ Network-capable Printer
LBP3310 can be used as a printer directly connected to an Ethernet network by installing 
the optional network board. The network board also allows you to specify the printer 
settings and manage it from a computer on the network through a built-in web browser 
"Remote UI".

NOTE
For details on the optional network board, including the operating systems that support it 
and the procedure for setting it, see "Network Guide".
1-3Features and Benefits
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CD-ROM
The CD-ROM supplied with the printer includes the following software.

■ Printer Driver
The printer driver is software required for printing with this printer. Be sure to install the 
printer driver in the computer you are using.

NOTE
Be sure to read the README file by clicking [ ] on the installation window before 
installing.

■ NetSpot Device Installer
"NetSpot Device Installer" is software that allows you to easily initialize the settings of 
printers connected to the network. When the printer driver is installed from CD-ROM 
Setup, however, the initial settings for the network are performed automatically. Use 
"NetSpot Device Installer" as needed if you want to reset the IP address manually without 
using CD-ROM Setup.

NOTE
For more details on "NetSpot Device Installer", see "Chapter 2  Setting Up the Network 
Environment for Printing" in Network Guide.
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■ NB-C2 Firmware
This is the firmware for the optional network board, "NB-C2". 
The firmware versions of the network board compatible with this printer are as follows.

If the firmware version is not 1.30 or later, the printer may not operate properly. Make sure 
that the version is 1.30 or later after installing the network board and the printer driver. 
If the version is not 1.30 or later, update the firmware of the network board using the 
update file in the "NB-C2_Firmware" folder in the CD-ROM supplied with the printer. 
For details on the procedures for checking and updating the firmware version, see the 
README file in the "NB-C2_Firmware" folder.

NOTE
You can also download the firmware update file from the Canon website.

CD-ROM Setup
When the supplied CD-ROM is inserted into the CD-ROM drive, the following 
CD-ROM Setup appears automatically.

Operations such as software installation can be performed from the CD-ROM Setup.

NOTE
• If you are using Windows Vista and the [AutoPlay] dialog box appears, click [Run 

AUTORUN.EXE].
• If CD-ROM Setup does not appear, display it using the following procedures. (The 

CD-ROM drive name is indicated as "D:" in this manual. The CD-ROM drive name may 
differ depending on the computer you are using.)
- If you are using an operating system other than Windows Vista, select [Run] from the 

[Start] menu, enter "D:\English\MInst.exe", and then click [OK].
- If you are using Windows Vista, enter "D:\English\MInst.exe" in [Start Search] under the 

[Start] menu, and then press the [ENTER] key on your keyboard.
• If you are using Windows Vista and the [User Account Control] dialog box appears, click 

[Allow].

Printer Firmware Version of the Network Board

LBP3310 Ver. 1.30 or later
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■ Easy Installation
Clicking this button allows you to install the printer driver and the instruction manuals at a 
time.

■ Custom Installation
Clicking this button allows you to select whether to install the printer driver only or install 
the manuals only.

■ Additional Software Programs
Clicking this button allows you to start "NetSpot Device Installer".

NOTE
For more details on "NetSpot Device Installer", see "Chapter 2  Setting Up the Network 
Environment for Printing" in Network Guide.

■ Display Manuals
Clicking this button allows you to display the manuals (PDF manuals).
Clicking [ ] next to each guide displays the respective PDF manuals.

* The following PDF manuals are included in the "Manuals" folder in the supplied CD-ROM.

User's Guide: UsersGuide.pdf

Network Guide: NetworkGuide.pdf

Remote UI Guide: RemoteUIGuide.pdf

NOTE
To display the manuals in PDF format, Adobe Reader/Adobe Acrobat Reader is required. 
If Adobe Reader/Adobe Acrobat Reader is not installed on your system, please 
download it from the Adobe Systems Incorporated website.

■ Exit
Clicking this button closes the CD-ROM Setup.
1-6 CD-ROM
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Printer Unit

CAUTION
Do not block the ventilation slots on the printer. They are required for proper 
ventilation of the working parts in the printer. Blocking the slots can cause the 
printer to overheat, resulting in a fire.

Front View

aaaa Multi-purpose Tray (See p. 3-31)

bbbb Auxiliary Tray
Be sure to pull out this auxiliary tray when loading 
paper in the multi-purpose tray.

cccc Tray Extension
Open to prevent the paper from hanging out of the 
multi-purpose tray when loading long-size paper, 
such as A4.

dddd Paper Guides
Adjust the position of the paper guides to the width 
of the paper loaded in the multi-purpose tray.

eeee Paper Level Indicator
Shows the amount of paper remaining in the paper 
cassette.
If the paper cassette is full, the indicator is at the top. 
Because the indicator moves down as the amount of 
paper drops, this gives a rough estimate of the 
amount of paper remaining.

ffff Paper Cassette (See p. 3-17)

gggg Front Cover
Open when replacing the toner cartridge or 
removing jammed paper. (See p. 7-2)
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hhhh Face-down Output Tray
Outputs paper with the printed side facing down. 
(See p. 3-13)

iiii Open Button
Press this button to open the front cover.

jjjj Control Panel
The control panel has the indicators which show the 
printer status and the key which can cancel a job. 
(See p. 1-10)

kkkk Ventilation Slots
Allows ventilation of the interior of the printer to 
dissipate heat.

llll Power Switch (See p. 2-33)

mmmm Lift Handles (See p. 7-24)

Rear View

aaaa Pressure Release Levers
Press down these levers when removing jammed 
paper. (See p. 8-7)

bbbb Output Selection Cover
Open this cover when using the face-up output slot 
or removing paper jammed in the output area. 
(See p. 3-16)

cccc Power Socket (See p. 2-26)

dddd Rating Label
The current value indicated in this rating label shows 
the average power current consumption.

eeee Duplex Unit Cover
Open when specifying the size of the paper for 
2-sided printing or removing paper jammed in the 
duplex unit.

ffff Paper Size Switch Lever
Switch the lever according to the paper size for 
2-sided printing. (See p. 5-10)

gggg Ventilation Slots
Allows ventilation of the interior of the printer to 
dissipate heat.

hhhh Face-up Output Slot
Outputs paper with the printed side facing up. 
(See p. 3-14)

iiii Expansion Slot
The optional network board is installed in this slot. 
(See p. 9-15)

jjjj USB Connector (See p. 2-29)
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Inner View

aaaa Toner Cartridge Guide
When setting the toner cartridge, push it while 
aligning the projections on each side of the toner 
cartridge with this guide. 
(See p. 7-2)

bbbb Transport Guide
Lift the guide when removing paper jammed inside 
the front cover. (See p. 8-7)

a

b
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Control Panel
The control panel has the indicator lights which show the printer status and the 
button which can cancel a job.

NOTE
You can check detailed information about the printer status using the Printer Status 
Window from the computer you are using. For details on the Printer Status Window, see 
"Printer Status Window," on p. 5-34.

* Though not shown in the above illustration, the control panels are labeled with names in certain 
countries or regions.

■ Indicators

Number Name Status See

a
Load Paper 
Indicator (Blinking)

Printing cannot be performed 
because no paper is loaded, or 
paper of an inappropriate size is 
loaded.

p. 3-17, 
p. 3-31

b
Paper Jam 
Indicator (Blinking)

A paper jam is occurring, disabling 
printing.

p. 8-3

c
Alarm 
Indicator

(On)
A service error is occurring. p. 8-26

(Blinking)

An error is occurring, disabling 
printing.

p. 8-29

a
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■ Key

d
Ready 
Indicator

(On)
The printer is ready to print. -

(Blinking)

The printer is busy performing some 
kind of processing or operation, such 
as printing, warming up, or cleaning.

-

e
Cancel Job 
Indicator

(On)

The  (Cancel Job) key is being 
pressed.

p. 5-23

(Blinking)

A job cancel process is being 
performed.

p. 5-23

Number Name Function See

e Cancel Job Key
Pressing this key cancels the job in 
which an error is occurring and that in a 
printing process.

p. 5-23

Number Name Status See
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Optional Accessories
The following optional accessories are available in order to make full use of the 
printer functions. Purchase them in accordance to your needs. For the optional 
accessories, contact your local authorized Canon dealer.

 

Paper Feeder
In addition to the supplied multi-purpose tray and paper cassette, up to three paper 
sources can be used by installing the optional paper feeder.

The paper feeder can be loaded with up to approximately 250 sheets of plain paper 
(64 g/m2) of A4, B5, A5, Legal, Letter, Executive, and the following custom paper 
sizes.

• Width 148.0 to 215.9 mm; Length 210.0 to 355.6 mm

IMPORTANT
Be sure to use a paper feeder designed for this printer.

NOTE
For details on the procedure for installing the paper feeder, see "Paper Feeder," on p. 
9-2.

PAPER FEEDER PF-35P
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Network Board
By installing the optional network board (NB-C2), the printer can be connected 
directly to the network using a LAN cable. 
The network board allows you to specify the printer settings and manage them 
through a built-in web browser "Remote UI".

NOTE
• For details on "Remote UI", see "Remote UI Guide".
• For details on the procedure for installing the network board, see "Network Board," on p. 

9-15.

ERR LNK 100

Network board (NB-C2)
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CHAPTER

2
Installing the Printer
This chapter describes the procedure from taking this printer out of the box to installing the 
printer.

Installation Procedure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-2

Installation Site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-3
Installation Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-3

Installation Space . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-5

Confirming the Contents of the Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-8

Carrying the Printer to the Installation Site and Removing the Packing Materials on the Outside of the Printer  . . .2-10

Removing the Packing Materials Inside the Printer and Installing the Toner Cartridge  .2-14
Precautions on Installing the Toner Cartridge  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-14

Installing the Toner Cartridge . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-15

Removing the Packing Materials of the Paper Cassette and Loading Paper . . . . . . . . .2-23

Connecting the Power Cord . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-26

Connecting to a Computer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-28
Connecting the Printer to a Computer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-28

Using a USB Cable  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-29

Using a LAN Cable. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-31

Turning the Printer ON/OFF . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-33
Turning the Printer ON . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-33

Turning the Printer OFF  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-34
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Installation Procedure
Perform the relevant procedures listed below according to your installation 
preference. If you are not installing the optional accessories, skip the procedures 
indicated with (Optional).

1 Installing the Paper Feeder (See p. 9-2)
(Optional)

2 Installing the Printer (See p. 2-10)

3 Installing the Toner Cartridge (See p. 2-14)

4 Loading Paper (See p. 2-23)

5 Installing the Network Board (See p. 9-15)
(Optional)

6 Connecting the Power Cord (See p. 2-26)

7 Connecting the Printer to a Computer (See p. 2-28)

8 Installing the Printer Driver (See p. 4-1)
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In order to use this printer in a safe and trouble-free manner, install the printer in a 
place that fulfills "Temperature/Humidity Conditions", "Power Supply 
Requirements", and "Installation Requirements" described in "Installation 
Environment".

IMPORTANT
Before installing the printer, be sure to read "Important Safety Instructions" (See p. xviii).

Installation Environment
Select an installation site for this printer in view of the following environmental 
conditions.

Temperature/Humidity Conditions
Use the printer in a location where the temperature and humidity are within the 
following ranges.

• Ambient temperature: 10 to 32.5 °C (50 to 90.5 °F)

• Ambient humidity: 20 to 80 % RH (no condensation)

IMPORTANT
• Water droplets (condensation) may form inside the printer under the following 

circumstances. Leave the printer for two hours or more to adjust the surrounding 
temperature and humidity before using it.
- When the room where the printer is installed is heated rapidly
- When the printer is moved from a cool or dry location to a hot or humid location

• If water condenses inside the printer, the paper transport path may not function properly, 
and this may result in paper jams or poor print quality.

■ To customers using an ultrasonic humidifier
If you use an ultrasonic humidifier in conjunction with tap water or well water, impurities in 
the water will be dispersed through the air. These can be trapped inside the printer, 
causing degradation in print quality. If you are using such a humidifier, it is therefore 
recommended that you use purified water or other water that is free of impurities.
2-3Installation Site
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Power Supply Requirements
The maximum power consumption of this printer is 950 W or less for the 220 to 240 
V model (and 890 W or less for 110 to 127 V model). 
Make sure that the power supply is safe and its voltage is stable.
Use power supplies rated for voltages within the following ranges.

• 110 to 127 V (± 10 %) 50/60 Hz (± 2 Hz)

• 220 to 240 V (± 10 %) 50/60 Hz (± 2 Hz)

IMPORTANT
• One AC power outlet should be reserved exclusively for the printer. Any other sockets of 

this AC power outlet should not be used.
• Do not plug the power plug into the auxiliary outlet on a computer.
• Do not use the same AC power outlet for both the printer and for machinery which 

consumes a large amount of electricity or generates electrical noise (such as a copy 
machine, air conditioner, and shredder).

Installation Requirements
Install the printer in the following locations.

• A location where sufficient space can be ensured

• A well-ventilated location

• A flat, even surface

• A sturdy platform that can easily support the weight of the printer and optional 
accessories

WARNING
Do not install the printer near alcohol, paint thinner, or other flammable 
substances. If flammable substances come into contact with electrical parts 
inside the printer, this may result in a fire or electrical shock.

CAUTION
• Do not install the printer in the following locations, as this may result in a fire or 

electrical shock.
- A location exposed to high humidity or excess dust
- A location exposed to smoke and steam, such as in cookeries or near or 

humidifiers
- A location exposed to rain or snow
- A location near water faucets or water
- A location exposed to direct sunlight
- A location subject to high temperatures
- A location near open flames

• Do not install the printer on unstable locations, such as unsteady platforms, 
inclined floors, or in locations subject to excessive vibrations, as this may 
cause the printer to fall or tip over, resulting in personal injury.
Installation Site2-4
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IMPORTANT
Do not install the printer in the following locations, as this may result in damage to the 
printer.
- An environment where the temperature and/or humidity can change dramatically, or 

where condensation occurs
- A poorly ventilated room (Ozone is generated by the printer in use, however, the 

amount is too small to be harmful to the human body. However, if you are going to use 
the printer for a long time in a poorly ventilated room or to perform a large amount of 
printing, ventilate the room to keep the working environment comfortable.)

- A location near products that generate magnetism or electromagnetic waves
- In rooms such as laboratories where chemical reactions may occur
- A place where salt, corrosive gases such as ammonia, or toxic gases are found
- A platform that may warp from the weight of the printer and optional accessories, or the 

printer is liable to sink (such as a carpet or mat)

Installation Space

Required Peripheral Space

■ Standard configuration

(mm)

100

10
0

10
0

1072.9

500

59
9.

7 20
0

45
8

Front Surface

Output selection cover

Paper cassette
Front cover
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■ With the paper feeder installed

Foot Positions

■ Printer unit

NOTE
The front feet are 7.8 mm high and their top surface is 12 mm square.
The rear feet are 7.8 mm high, the top surface of the left foot is a rectangle of 21.7 mm x 
40 mm, and that of the right foot is 18.6 mm x 40 mm and is L-shaped.

(mm)

100

10
0

10
0

1072.9

500

59
9.

7

20
0

54
6.

8

Front Surface

Output selection cover

Paper cassette

Front cover

(mm)

62
.3

28
3.

2
54

.2

43.9 294.2 40.5
54

.3
27

7.
6

52
.7

43.9 294.2 40.5

Front Surface
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■ Paper Feeder Unit PF-35P

NOTE
The front feet are 7.8 mm high and their top surface is 12 mm square.
The rear feet are 7.8 mm high, the top surface of the left foot is a rectangle of 21.7 mm x 
40 mm, and that of the right foot is 31.7 mm x 40 mm and is L-shaped.

(mm)

26.7 294 40.3

26.7 305.8 28.5

62
.7

28
2.

4
54

.6

61
.9

27
6

61
.8

Front Surface
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Confirming the Contents of the Box
Make sure that all the following items are contained in the box before installing the 
printer. If any items are missing or damaged, please contact your local authorized 
Canon dealer. 

NOTE
• The life of the supplied toner cartridge is approx. 3,000 pages on the basis of "ISO/IEC 

19752"* when printing A4 size paper with the default print density setting.
* "ISO/IEC 19752" is the global standard related to "Method for the determination of toner cartridge yield for 

monochromatic electrophotographic printers and multi-function devices that may contain printer 
components" issued by ISO (International Organization for Standardization).

• The following two types of replacement toner cartridges with different lifetimes are 
available.
- The one with the same lifetime as that of the included toner cartridge
- The one with a longer lifetime than that of the included toner cartridge
For details on the replacement toner cartridges, see "Replacing the Toner Cartridge," on 
p. 7-2.

Power cord
(The form of the supplied power 
cord may differ from the one in 
the above illustration.)

CD-ROM "LBP3310 User Software"
• Printer Driver
• NetSpot Device Installer
• User's Guide
• Network Guide
• Remote UI Guide
• NB-C2 Firmware

Printer
The following parts are already 
installed.
• Paper cassette
• Toner cartridge

USB cable
(Only 220 - 240 V model for 
countries and regions of Asia)
2-8 Confirming the Contents of the Box
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• A USB cable is only supplied with 220 - 240 V model for countries and regions of Asia. In 
other countries and regions, prepare according to the specifications of your computer. 
Use a USB cable with the following symbol.
2-9Confirming the Contents of the Box



In
st

al
lin

g 
th

e 
P

rin
te

r

2

Carrying the Printer to the Installation Site and 
Removing the Packing Materials on the Outside of the 
Printer
IMPORTANT
• If you want to install the optional paper feeder, place it at the installation site before taking 

the printer out of the box.
For details on installing the paper feeder, see "Paper Feeder," on p. 9-2.

• The removed packing materials are required when transporting the printer for relocation 
or maintenance. Be sure not to misplace them.

NOTE
The packing materials may be changed in form or placement, or may be added or 
removed without notice.
2-10 Carrying the Printer to the Installation Site and Removing the Packing Materials on the Outside of the 
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1 Carry the printer unit to the installation site.

From the front side, securely hold the printer by the lift handles on the lower 
portion of the printer with both hands.

CAUTION
• This printer weighs approximately 12 kg. Please be careful not to hurt your 

back or other portions of your body when carrying the printer.
2-11Carrying the Printer to the Installation Site and Removing the Packing Materials on the Outside of the
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• Do not hold the printer by the front portion, rear portion, or any portions 
other than the lift handles. If you do so, you may drop the printer, resulting 
in personal injury.

• The rear portion (A) of the printer is relatively heavy. Be careful not to 
become off-balance when lifting the printer. If you do so, you may drop the 
printer, resulting in personal injury.

(A)
Carrying the Printer to the Installation Site and Removing the Packing Materials on the Outside of the 
Printer
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2 Put the printer down carefully at the installation site.

CAUTION
Put the printer down slowly and carefully. Be careful not to hurt your 
hands.

3 Remove the tape attached to the printer (2 locations).
2-13Carrying the Printer to the Installation Site and Removing the Packing Materials on the Outside of the
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Removing the Packing Materials Inside the Printer and 
Installing the Toner Cartridge
The toner cartridge protected with packing materials is already installed in the 
printer.

Be sure to take the toner cartridge out of the printer once, and then remove the 
packing materials using the following procedure.

Precautions on Installing the Toner Cartridge

CAUTION
Take care not to allow the toner to come into contact with your hands or 
clothing, as this will dirty your hands or clothing. If your hands or clothing 
become stained with toner, wash them immediately with cold water. Washing 
them with warm water may fix the toner and make it not possible to remove the 
toner stains.

IMPORTANT
Dispose of the packing materials according to local regulations.

NOTE
• For details on handling the toner cartridge, see "Precautions for Handling the Toner 

Cartridge," on p. 7-15.
• The packing materials may be changed in form or placement, or may be added or 

removed without notice.
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Installing the Toner Cartridge

1 Open the front cover.

While pressing the open button on the top of the front cover a, open it gently b.

2 Turn over the paper toward you.

b

a

2-15Removing the Packing Materials Inside the Printer and Installing the Toner Cartridge
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IMPORTANT
Do not remove the paper alone with the toner cartridge and packing materials 
installed in the printer.

3 Remove the packing material.
Removing the Packing Materials Inside the Printer and Installing the Toner Cartridge2-16
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4 Remove the toner cartridge from the printer.

IMPORTANT
Do not touch the high-voltage contact (A) or the electrical contacts (B) shown in the 
figure, as this may result in damage to the printer.

(A)

(B)
2-17Removing the Packing Materials Inside the Printer and Installing the Toner Cartridge
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5 Hold the toner cartridge as shown in the figure and shake it 
gently 5 or 6 times to evenly distribute the toner inside the 
cartridge.

IMPORTANT
• If toner is not distributed evenly, this may result in deterioration in print quality. Do 

not skip this step.
• Be sure to shake the toner cartridge gently. If you do not shake the cartridge gently, 

toner may spill out.

6 Remove the packing material shown in the figure.

Raise the tab of the packing material (A), then remove it.

(A)
Removing the Packing Materials Inside the Printer and Installing the Toner Cartridge2-18
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7 Place the toner cartridge on a flat surface.

8 Pull out the sealing tape.

While holding the toner cartridge steady a, hook your fingers into the tab and 
fold it back.
Pull out the sealing tape (approx. 45 cm long) straight in the direction of the 
arrow gently b.

CAUTION
If the sealing tape is pulled out forcefully or stopped at midpoint, toner 
may spill out. If the toner gets into your eyes or mouth, wash them 
immediately with cold water and immediately consult a physician.

IMPORTANT
• Do not pull the sealing tape diagonally, upwards, or downwards. If the tape is 

severed, this may become difficult to pull out completely.

b
a
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• Pull out the sealing tape completely from the toner cartridge. If any tape remains in 
the toner cartridge, this may result in poor print quality.

• When pulling out the sealing tape, be careful not to touch the toner cartridge 
memory (A) or not to hold the drum protective shutter (B) with your hands.

9 Remove the packing material with paper inside the front 
cover.

(A)

(B)
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10 Hold the toner cartridge properly with the arrowed side facing 
up as shown in the figure.

11 Install the toner cartridge.

Push the toner cartridge into the printer firmly until it touches the back of the 
printer while aligning (A) on both sides of the toner cartridge with the toner 
cartridge guides inside the printer.

(A)

Side View (Left) Side View (Right)
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12 Close the front cover.

Close the front cover gently and firmly.

IMPORTANT
• If you cannot close the front cover, make sure that the toner cartridge is installed 

properly. If you try to close the front cover forcefully, this may result in damage to 
the printer.

• Do not leave the front cover open for a long time after installing the toner cartridge. 
This may result in deterioration in print quality.
Removing the Packing Materials Inside the Printer and Installing the Toner Cartridge2-22
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IMPORTANT
• For details on handling the paper cassette, see "Precautions for Handling the 

Multi-purpose Tray or Paper Cassette," on p. 3-12.
• The removed packing materials are required when transporting the printer for relocation 

or maintenance. Be sure not to misplace them.

NOTE
The packing materials may be changed in form or placement, or may be added or 
removed without notice.

1 Pull out the paper cassette.
2-23Removing the Packing Materials of the Paper Cassette and Loading Paper



In
st

al
lin

g 
th

e 
P

rin
te

r

2

2 Remove the tape that is securing the packing material in the 
paper cassette (2 locations).

3 Remove the packing material in the paper cassette.

4 Load paper in the paper cassette.

For details on the procedure for loading paper in the paper cassette, see 
"Loading Paper in the Paper Cassette," on p. 3-17.

NOTE
If you want to load paper in the multi-purpose tray, load the paper after Step 5. 
For details on the procedure for loading paper in the multi-purpose tray, see 
"Loading Paper in the Multi-purpose Tray," on p. 3-31.
Removing the Packing Materials of the Paper Cassette and Loading Paper2-24
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5 Set the paper cassette in the printer.

Push the paper cassette into the printer firmly until the front side of the paper 
cassette is flush with the front surface of the printer.

CAUTION
When setting the paper cassette in the printer, be careful not to catch your 
fingers.

This printer's paper cassette cannot automatically detect the paper size. Therefore, you 
need to register the size of the loaded paper. 
Install the printer driver (See p. 4-1), then register the paper size. 
For details on the procedure for registering a paper size, see Step 6 and subsequent 
steps of "Loading Paper in the Paper Cassette," on p. 3-17.
2-25Removing the Packing Materials of the Paper Cassette and Loading Paper
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Connecting the Power Cord
When connecting the power cord, see "Important Safety Instructions," on p. xviii.

IMPORTANT
• Do not plug the power plug into the auxiliary outlet on a computer.
• One AC power outlet should be reserved exclusively for the printer.
• Do not connect this printer to an uninterruptible power source. This may cause printer 

malfunction or breakdown in the event of a power failure.

1 Make sure that the printer is OFF.

The printer is OFF when the " " side of the power switch is pressed.
2-26 Connecting the Power Cord
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2 Plug the supplied power cord into the power socket.

3 Plug the power plug into the AC power outlet.

NOTE
The form of the supplied power cord may differ from the one in the above 
illustration.
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Connecting to a Computer
Connecting the Printer to a Computer
This printer is equipped with a USB connector. By installing the optional network 
board (NB-C2), the printer can be connected directly to the network using a LAN 
cable. 
Connect the printer and computer using a connecting method appropriate for your 
network environment.

*Only if the optional network board is installed

Using a USB Cable (See p. 2-29) Using a LAN Cable* (See p. 2-31)

Using a Print Server

● If your computer is the print server
- Using a USB Cable (See p. 2-29)
- Using a LAN Cable* (See p. 2-31)

* Only if the optional network board is installed

● If your computer is a client computer
You do not need to connect this printer to the computer directly.
Proceed to the procedure for installing the printer driver (See p. 4-48).

USB Cable

LAN Cable

USB Cable LAN Cable

LAN Cable

Client

Client

Print Server

Print Server
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Using a USB Cable

Precautions on Connecting a USB Cable

WARNING
When plugging or unplugging the USB cable while the power plug is plugged in 
an AC power outlet, do not touch the metal part of the connector, as this may 
result in electrical shock.

IMPORTANT
• Do not plug or unplug the USB cable while the computer or printer is ON, as this may 

result in damage to the printer.
• This printer uses bi-directional communication. Operation of the printer when connected 

via unidirectional communication equipment has not been tested, and as a result, Canon 
cannot guarantee printer operation if the printer is connected using unidirectional print 
servers, USB hubs or switching devices.

NOTE
• The USB interfaces appropriate for this printer are as follows. For more details, contact 

your local authorized Canon dealer.
- USB 2.0 Hi-Speed/USB Full-Speed (USB1.1 equivalent)

• A USB cable is only supplied with 220 - 240 V model for countries and regions of Asia. In 
other countries and regions, prepare according to the specifications of your computer. 
Use a USB cable with the following symbol.
2-29Connecting to a Computer
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Connecting a USB Cable

1 Make sure that the printer and computer are OFF.

2 Connect the B-type (square) end of the USB cable to the USB 
connector on the printer.

3 Connect the A-type (flat) end of the USB cable to the USB port 
on the computer.

NOTE
If a Wizard or dialog box appears after connecting the USB cable through the Plug 
and Play automatic setup, install the printer driver for this printer using either one of 
the following procedures.
- Clicking [Cancel] and installing the printer driver from CD-ROM Setup
- Installing with Plug and Play
For more details, see "Installing the Printer Driver," on p. 4-5.
Connecting to a Computer2-30
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Using a LAN Cable

Precautions on Connecting a LAN Cable

■ Network Environment
The optional network board supports 10BASE-T/100BASE-TX connections.

NOTE
• For details on the procedure for installing the network board, see "Network Board," on p. 

9-15.
• This printer and the network board do not come with a LAN cable or a hub. Have cables 

or a hub ready as needed.
Use a Category 5 twisted pair cable for the LAN.

• If you want to connect the printer to a 100BASE-TX  Ethernet network, all the devices to 
be connected to the LAN (hub, LAN cable, and network board for computer) must 
support 100BASE-TX.
For more details, contact your local authorized Canon dealer.

Computer that supports 
100BASE-TX

Computer that supports 
10BASE-T

Ethernet Cable

Hub

LAN Connector
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Connecting a LAN Cable

1 Connect the LAN cable to the LAN connector of the network 
board.

2 Connect the other end of the LAN cable to the hub.

NOTE
If this printer is connected to a network, the following tasks are required.
- Specifying the network settings for the computer (See the instruction manual for 

the computer)
- Performing the installation of and the network settings for the printer to use it on a 

network (See Network Guide)
- Configure the print server. (See "Printing from a Network Computer by Sharing 

the Printer on a Network," on p. 4-36)
Connecting to a Computer2-32
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Turning the Printer ON

IMPORTANT
• Do not turn the printer ON immediately after turning it OFF. If you want to cycle the power 

of the printer, wait at least 10 seconds before turning it ON again.
• If the printer does not operate properly, or an error message appears in the Printer Status 

Window, see "Troubleshooting," on p. 8-1.
• Be sure to set the paper cassette in the printer before you turn the power ON for the first 

time following the printer installation.
• Although a sheet of blank paper is output when you turn the power ON for the first time 

following the printer installation, this is not an error.

1 Press the " " side of the power switch on the printer.

All the indicators on the printer blink, and the printer initiates a self-diagnostic test 
on the printer unit and optional accessories.
2-33Turning the Printer ON/OFF



In
st

al
lin

g 
th

e 
P

rin
te

r

2

● If the self-diagnostic test result is normal

The  (Ready) indicator (green) comes on, and the printer is ready to print.

● If the self-diagnostic test result is not normal

The  (Alarm) indicator (orange) comes on/blinking (See p. 8-25).

Turning the Printer OFF

1 Make sure that the printer is not in any of the following states 
before turning it OFF.
• While the printer is in the middle of printing
• While the printer is running a self-diagnostic test immediately after turning the 

power ON (All the indicators are blinking)

IMPORTANT
If you turn the printer OFF, all print data remaining in the printer memory will be 
erased.

On
Turning the Printer ON/OFF2-34
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2 Press the " " side of the power switch on the printer.

IMPORTANT
Even if the power of the printer is turned OFF, power is consumed only slightly 
while the power plug is inserted into the AC power outlet. 
To cut the power consumption completely, unplug the power plug from the AC 
power outlet.
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CHAPTER

3
Paper Loading and Output Tray
This chapter describes the types of paper that can be used with this printer, and how to load 
and output paper.
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Paper Requirements
IMPORTANT
• Print speed may drop depending on the settings for the paper size, paper type, and print 

copies.
- Envelope: Approximately 6 pages/min.

• When continuously printing the paper whose length is 264.4 mm or less, the safety 
function that prevents damages caused by heat may slow the print speed down in stages. 
(The print speed may be slowed down to approximately 6 pages/min.)

Usable Paper

Paper Size
The following shows the paper sizes that can be used with this printer.

: The paper is available for 1-sided printing and automatic 2-sided printing
: The paper is available for only 1-sided printing

 - : The paper cannot be used for printing

Paper Size
Paper Source

Multi-purpose Tray Cassette 1
Cassette 2
(Optional)

A4

B5

A5

Legal

Letter

Executive

16K

Custom Paper Size *1 *2 *2

Envelope
- -Envelope DL

110.0 mm x 220.0 mm

Envelope COM10
104.9 mm x 241.3 mm

- -

Envelope C5
162.0 mm x 229.0 mm

- -
3-2 Paper Requirements
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*1 Custom size paper that is 76.2 to 215.9 mm wide and 127.0 to 355.6 mm long can be loaded.

*2 Custom size paper that is 148.0 to 215.9 mm wide and 210.0 to 355.6 mm long can be loaded.

Paper Type
The following shows the paper types that can be used with this printer.

: The paper is available for 1-sided printing and automatic 2-sided printing
: The paper is available for only 1-sided printing

 - : The paper cannot be used for printing

*1 100 % recycled paper (60 - 89 g/m2) can be used as plain paper.

*2 If paper curls excessively when printed with [Plain Paper] selected, select [Plain Paper L].

*3 When printing Index Card or envelopes, the printer automatically applies the appropriate print mode to each type by 
specifying [Output Size] in the [Page Setup] sheet.

■ Plain Paper
This printer can print plain paper (60 - 89 g/m2) of the following sizes.

• Standard paper size: A4, B5, A5, Legal, Letter, Executive, 16K
• Custom paper size: Width 76.2 to 215.9 mm; Length 127.0 to 355.6 mm

* Paper of A4, Legal, or Letter size is available for automatic 2-sided printing.

* 100 % recycled paper (60 - 89 g/m2) can be used as plain paper.

Envelope Monarch
98.5 mm x 190.5 mm

- -

Index Card
76.2 mm x 127.0 mm

- -

Paper Type

Setting for 
[Paper Type] in 

the Printer 
Driver

Paper Source

Multi-purpose 
Tray

Cassette 1
Cassette 2
(Optional)

Plain 
Paper*1 60 - 89 g/m2

[Plain Paper L]*2

[Plain Paper]

Heavy 
Paper

90 - 120 g/m2 [Heavy Paper 1]

121 - 149 g/m2 [Heavy Paper 2] - -

150 - 163 g/m2 [Heavy Paper 3] - -

Transparency [Transparency] - -

Label [Label] - -

Index Card *3 - -

Envelope *3 - -

Paper Size
Paper Source

Multi-purpose Tray Cassette 1
Cassette 2
(Optional)
3-3Paper Requirements
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■ Heavy Paper
This printer can print heavy paper (90 - 163 g/m2) of the following sizes.

• Standard paper size: A4, B5, A5, Legal, Letter, Executive, 16K
• Custom paper size: Width 76.2 to 215.9 mm; Length 127.0 to 355.6 mm

* Paper of A4, Legal, or Letter size that weighs between 90 - 120 g/m2 is available for automatic 2-sided printing.

■ Transparency
This printer can print A4 and Letter size transparencies.

■ Label
This printer can print A4 and Letter size labels.

IMPORTANT
Do not use the labels in the following conditions. Using inappropriate labels may result in 
paper jams that are difficult to clear or may result in damage to the printer.
- Peeled labels or partly used labels
- Coated labels that are easily peeled off from the backing sheet
- Labels with uneven adhesive

■ Index Card
This printer can print Index Card.
Index Card can be loaded in the multi-purpose tray.

■ Envelope
The envelopes that can be used with this printer are as follows.
Envelopes can be loaded in the multi-purpose tray.

Envelope DL
(110.0 mm x 220.0 mm)

Envelope COM10
(104.9 mm x 241.3 mm)

Envelope C5
(162.0 mm x 229.0 mm)

Envelope Monarch
(98.5 mm x 190.5 mm)
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IMPORTANT
• Do not use the following types of envelopes. Using inappropriate envelopes may result in 

paper jams that are difficult to clear or may result in damage to the printer.
- Envelopes with fasteners or snaps
- Envelopes with address windows
- Envelopes with adhesive on the surface
- Wrinkled or creased envelopes
- Poorly manufactured envelopes in which the glued parts are uneven
- Irregularly-shaped envelopes

• Before loading the envelopes, flatten the stack of envelopes to release any remaining air, 
and press the fold lines tightly along the edges.

• Do not print on the reverse side (glued side) of envelopes.
• Printing speed drops when printing envelopes.

NOTE
If printing envelopes, they may become creased.
3-5Paper Requirements
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Printable Area

NOTE
Specify the following setting in the printer driver to extend the printable area to near the 
edges of the paper.

1. Click [Finishing Details] in the [Finishing] sheet.
2. Select the [Print with Upper Left of Sheet as Starting Point] check box.

However, the edges of the printout may be partly missing depending on the property of 
the document to be printed. For more details, see Online Help in the printer driver.

■ Plain Paper/Heavy Paper/Transparency/Label
You cannot print on any area within 5 mm of the edges of paper.

■ Envelope/Index Card
You cannot print on any area within 10 mm of the edges of paper.
You may have to change the printable area before printing, depending on the application 
you use.

(Sample: Envelope COM10)

5 mm

5 mm

5 mm5 mm

10 mm 10 mm

10 mm

10 mm

104.9 mm
(4.13 in.)

241.3 mm
(9.50 in.)
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Unusable Paper
To avoid problems such as paper jams and other malfunctions, the following types 
of paper should never be used:

IMPORTANT
• Paper that jams easily

- Paper that is too thick or too thin
- Irregularly-shaped paper
- Wet or moist paper
- Torn or damaged paper
- Rough, extremely smooth, or glossy paper
- Paper with binding holes or perforations
- Curled or creased paper
- Specially coated paper (coated paper for inkjet printers, etc.)
- Labels with backing sheet that is easily peeled off
- Paper that has already been printed by a copy machine or another laser printer

(The reverse side of the paper is also not usable. Using the multi-purpose tray, however, 
you can perform 2-sided printing manually on the other side of paper previously printed 
by this printer. You cannot print on the printed side again.)

- Paper with jagged edges (paper that has been poorly cut)
- Wrinkled paper
- Paper with the corners folded

• Paper that changes its quality at high temperatures
- Paper that contains ink that melts, burns, evaporates or emits harmful gases at or lower 

than the heating temperature (approx. 270°C or 518°F) of the fixing unit
- Heat-sensitive paper
- Treated color paper
- Specially coated paper (coated paper for inkjet printers, etc.)
- Paper with adhesive on the surface

• Paper that damages the printer
- Carbon paper
- Paper with staples, clips, ribbons or tapes
- Paper that has already been printed by a copy machine or another laser printer

(The reverse side of the paper is also not usable. Using the multi-purpose tray, however, 
you can perform 2-sided printing manually on the other side of paper previously printed 
by this printer. You cannot print on the printed side again.)

• Paper that is difficult for the toner to fix onto
- Paper with rough surfaces
- Specially coated paper (coated paper for inkjet printers, etc.)
- Paper containing thick fibers
3-7Paper Requirements
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Storing Paper
The quality of paper may deteriorate if it is stored improperly even when the paper 
meets the normal specifications. Inferior paper may cause misfeeds, paper jams, or 
deterioration in print quality.
Observe the following guidelines when storing and handling paper.

IMPORTANT
• Store paper away from moisture.
• Paper wrappers guard against moisture and dryness. Keep paper in the wrapper until it is 

ready to be used. Store all unused paper in a wrapper.
• Store paper on a flat surface.
• Do not store paper on the floor where water and moisture can accumulate.
• When you store paper, prevent it from curling or being folded.
• Do not store paper vertically or store too many stacks of paper in one pile.
• Do not store paper in places exposed to direct sunlight or places with low humidity.
• If the paper storage room and work area differ from each other significantly in 

temperature or humidity, keep packed paper stack in the work area for at least one day 
prior to printing so that it can adapt to the new environment. When paper is moved to a 
location where the temperature or humidity differs significantly, the paper may curl or 
become creased.

 

Storing Printed Paper
When handling or storing paper printed by this printer, be careful of the following 
points.

IMPORTANT
• Avoid storing printouts with PVC materials such as clear folders. Otherwise toner may 

melt and stick to the PVC material.
• Use insoluble adhesive when gluing printouts. Toner may melt when soluble adhesive is 

used. Before using the adhesive, test it with paper that is no longer required.
Make sure that the printed paper is completely dry before placing one over another. 
Toner may melt if the sheets are placed together when they are not completely dry.

• Store paper on a flat surface. Toner may peel if the paper is folded or creased.
• Avoid storing printouts at high temperatures. Otherwise toner may melt and blot.
• Put printouts in a binder when storing them for a long period of time (two years or longer). 

(Printouts may discolor when they are stored for a long period of time.)
3-8 Paper Requirements
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Paper Source Type
This printer has the following paper sources.

(A): Multi-purpose Tray
(B): Cassette 1
(C): Cassette 2 (Optional)

IMPORTANT
If you are printing from Cassette 2, make sure that Cassette 1 is set before printing. If you 
print from Cassette 2 when Cassette 1 is not set, this will cause paper jams.

(A)

(B)

(C)
3-9Paper Source
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Paper Capacity of Paper Source
- : The paper cannot be loaded

Paper Type

Paper Capacity

Multi-purpose 
Tray

Cassette 1
Cassette 2
(Optional)

Plain Paper (Ex. 64 g/m2)
Approx. 50 

sheets
Approx. 250 

sheets
Approx. 250 

sheets

Heavy Paper (Ex. 91 g/m2)
Approx. 40 

sheets
Approx. 200 

sheets
Approx. 200 

sheets

Heavy Paper (Ex. 128 g/m2)
Approx. 25 

sheets
- -

Transparency
Approx. 40 

sheets
- -

Label
Approx. 20 

sheets
- -

Index Card
Approx. 15 

sheets
- -

Envelope
Approx. 5 

sheets
- -
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Selecting a Paper Source
A paper source can be selected in the [Paper Source] sheet in the printer driver.

1 Display the [Paper Source] sheet aaaa, then select [Paper 
Source] bbbb.

For details on the procedure for displaying the [Paper Source] sheet in the printer 
driver, see the following.

• "Printing from an Application" (See p. 5-2)
• "Changing the Default Values for Printing Preferences" (See p. 5-8)

NOTE
If [Paper Selection] is set to a setting other than [Same Paper for All Pages], the 
setting for [Paper Source] is changed as follows. Specify the same setting as for 
[Paper Source].
- [First Page]
- [Second Page]
- [Cover Page]
- [Other Pages]
- [Last Page]

2 Click [OK].

a

b

3-11Paper Source
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Precautions for Handling the Multi-purpose Tray or Paper 
Cassette

Be careful of the following points when handling the multi-purpose tray or paper 
cassette.

IMPORTANT
• Be sure to turn the printer ON once when loading paper in the paper cassette for the first 

time after installing the paper feeder.
• Observe the following points during printing. If not, this may result in paper jams or 

damage to the printer.
- Do not pull out the paper cassette.
- Do not touch the paper in the multi-purpose tray or pull it out.

• Refill the paper cassette after all the loaded paper runs out. If the paper cassette is 
refilled when paper still remains in the cassette, this may result in misfeeds.

• Do not put anything other than the printing paper on the multi-purpose tray. Also, do not 
press on top of or apply excessive force to the multi-purpose tray. This may result in 
damage to the multi-purpose tray.

• Do not touch the black rubber pad (A) in the paper cassette. This may result in misfeeds.

• If you are printing from Cassette 2, make sure that Cassette 1 is set before printing. If you 
print from Cassette 2 when Cassette 1 is not set, this will cause paper jams.

NOTE
Remove the paper loaded in the multi-purpose tray before closing it. Keep the 
multi-purpose tray closed when it is not used.

(A)
3-12 Paper Source



Output Tray
P
ap

er
 L

oa
di

ng
 a

nd
 O

ut
pu

t T
ra

y

3

Output Tray Type
This printer has two output trays: "face-down output tray" and "face-up output slot".

Do not switch one output tray to another during printing. This may result in paper 
jams.

CAUTION
• Keep your hands or clothing away from the roller in the output area. Even if the 

printer is not printing, sudden rotation of the roller may catch your hands or 
clothing, resulting in personal injury.

• The paper may be hot immediately after being output. Be careful when removing 
the paper as well as when aligning the removed paper, especially after printing 
continuously. Otherwise, this may result in burns.

Face-down Output Tray
Printed paper is output to the face-down output tray on the top of the printer with the 
printed side facing down.

IMPORTANT
• Printed paper can be output only to the face-down output tray when performing automatic 

2-sided printing.
• During 2-sided printing, do not touch the paper until it is output to the face-down output 

tray completely. During 2-sided printing, the paper is first output partially after the front 
side is printed, and then it is fed again to be printed on the reverse side.
3-13Output Tray



P
ap

er
 L

oa
di

ng
 a

nd
 O

ut
pu

t T
ra

y

3

• The face-down output tray and its surroundings become hot during or immediately after 
using the printer. Do not touch the face-down output tray and its surroundings when 
removing the jammed paper or performing the related operation.

NOTE
The face-down output tray can hold up to approximately 125 sheets of plain paper (64 g/
m2). The paper capacity varies depending on the paper size or paper type. For more 
details, see "Paper Capacity of the Output Tray," on p. 3-15.

Face-up Output Slot
Printed paper is output to the face-up output slot on the rear side of the printer with 
the printed side facing up.
The face-up output slot is suitable to print transparencies, labels, Index Card, or 
envelopes which tend to curl, since the printed paper is output flattened.
3-14 Output Tray



P
ap

er
 L

oa
di

ng
 a

nd
 O

ut
pu

t T
ra

y

3

CAUTION
The face-up output slot and its surroundings become hot during or immediately 
after using the printer. Do not touch the face-up output slot and its 
surroundings, as doing so may result in burns.

IMPORTANT
• When outputting paper to the face-up output slot, you cannot perform automatic 2-sided 

printing.
• When paper is output to the face-up output slot, take out one piece at a time each time it 

is output.

Paper Capacity of the Output Tray
-: The paper cannot be output

* Actual paper capacity varies depending on the installation environment, paper type, or paper size.

Paper Type
Paper Capacity*

Face-down Output Tray Face-up Output Slot

Plain Paper (64 g/m2) Approx. 125 sheets -

Heavy Paper (91 g/m2) Approx. 50 sheets -

Heavy Paper (128 g/m2) Approx. 30 sheets 1 sheet

Transparency 1 sheet 1 sheet

Label Approx. 10 sheets 1 sheet

Index Card Approx. 10 sheets 1 sheet

Envelope Approx. 10 sheets 1 sheet
3-15Output Tray
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Selecting an Output Tray

Switching to the Face-up Output Slot
When switching to the face-up output slot, open the output selection cover as 
shown in the figure.

Switching to the Face-down Output Tray
When switching to the face-down output tray, close the output selection cover as 
shown in the figure.
3-16 Output Tray
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The following paper can be loaded in the paper cassette.

IMPORTANT
• For more details on usable paper, see "Usable Paper," on p. 3-2.
• For details on handling the paper cassette, see "Precautions for Handling the 

Multi-purpose Tray or Paper Cassette," on p. 3-12.

NOTE
Load paper in Cassette 2 (only if the optional paper feeder is installed) in the same 
manner as you would load paper in Cassette 1.

 

Loading Standard Size Paper

1 Pull out the paper cassette.

Paper Type Paper Size
Loading 

Procedure

Plain Paper 
(60 - 89 g/m2)
Heavy Paper 
(90 - 120 g/m2)

A4, B5, A5, Legal, Letter, Executive p. 3-17

Custom Paper Size
(Width 148.0 to 215.9 mm; Length 210.0 to 355.6 mm) 
16K

p. 3-23
3-17Loading Paper in the Paper Cassette
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CAUTION
Be sure to take the paper cassette out of the printer before loading paper. 
If paper is loaded while the paper cassette is partially pulled out, the paper 
cassette may drop or the printer may fall down, resulting in personal 
injury.

2 When changing the size of the paper to be loaded, change the 
positions of the paper guides.

The paper sizes indicated on the paper guides are abbreviated as follows.

● Slide the side paper guides to the size mark for the paper to be 
loaded.

The side paper guides move together. Align the position of (A) with the size mark 
of the paper to be loaded.

NOTE
If you are using B5 size paper (182 mm x 257 mm), set the paper guide to "JIS B5".

Paper Size Paper Guide

Legal LGL

Letter LTR

Executive EXEC

How to slide the side paper guides
a Hold the lock release lever.
b Slide the paper guides to the size mark for the paper to be loaded.

a

b

(A)

Top View

Top View
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● Slide the rear paper guide to the size mark for the paper to be 
loaded.

Align the position of (A) with the size mark of the paper to be loaded.

IMPORTANT
Do not use the "8.5 x 13" position.

3 Load the paper stack so that the rear edge is aligned with the 
paper guide.

CAUTION
When loading paper, take care not to cut your hands with the edges of the 
paper.

How to slide the rear paper guide
a Hold the lock release lever.
b Slide the paper guide to the size mark for the paper to be loaded.

(A)

a

b

Top View

Top View
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IMPORTANT
• Be sure to load paper in portrait orientation.

• Be sure to check if the paper guides are at the position of the size of the paper to 
be loaded. If the paper guide is set at a wrong position, this may result in misfeeds.

• If you use paper that has been poorly cut, multiple sheets of paper may be fed at 
once. In this case, align the edges of the paper stack properly on a hard, flat 
surface.

NOTE
To print paper with letterheads or logos, see "Paper Loading Orientation" (p. 3-49) 
and load the paper in the proper orientation.

4 Hold down the paper as shown in the figure, then set it under 
the hooks (A) on the paper guides.

Check the following points.

• Whether the paper stack does not exceed the load limit marks (B)
• Whether there is sufficient space between the hooks of the paper guides and 

the paper stack

(A)(B)

(A)
3-20 Loading Paper in the Paper Cassette
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IMPORTANT
The following shows the paper capacity of the paper cassette.
- Plain paper (Ex. 64 g/m2): Approx. 250 sheets
- Heavy paper (Ex. 91 g/m2): Approx. 200 sheets
Be sure that the paper stack does not exceed the load limit marks. If the paper 
stack exceeds the load limit marks, this may result in misfeeds.

5 Set the paper cassette in the printer.

Push the paper cassette into the printer firmly until the front side of the paper 
cassette is flush with the front surface of the printer.

CAUTION
When setting the paper cassette in the printer, be careful not to catch your 
fingers.

This printer's paper cassette cannot automatically detect the paper size. 
Therefore, you need to register the size of the loaded paper.

6 Display the Printer Status Window.

For details on methods for displaying the Printer Status Window, see "Displaying 
the Printer Status Window," on p. 5-35.

Register the size of the loaded paper using the following procedure.
3-21Loading Paper in the Paper Cassette
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7 From the [Options] menu, select [Device Settings] ➞ 
[Cassette Settings].

8 Select the size of the paper loaded in the paper cassette aaaa, 
then click [OK] bbbb.

When the paper size is changed to A4, Letter, or Legal, the following screen 
appears.

If you want to perform 2-sided printing: Set the paper size switch lever on the rear 
side of the printer to the appropriate position, then click [OK].

If you do not want to perform 2-sided printing: Simply click [OK].

NOTE
For details on the procedure for setting the paper size switch lever, see "Automatic 
2-sided Printing," on p. 5-10.

Loading paper is now completed.
For details on the procedure for printing, see "Printing from an Application," on p. 5-2.

a

b
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Loading Paper of Custom Size (Non-Standard Size) and 
16K

You can load paper of the following custom paper sizes.

• Width 148.0 to 215.9 mm; Length 210.0 to 355.6 mm

1 Pull out the paper cassette.

CAUTION
Be sure to take the paper cassette out of the printer before loading paper. 
If paper is loaded while the paper cassette is partially pulled out, the paper 
cassette may drop or the printer may fall down, resulting in personal 
injury.

2 Load the paper so that the edges of the stacked paper are 
aligned with the front side of the paper cassette.
3-23Loading Paper in the Paper Cassette
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CAUTION
When loading paper, take care not to cut your hands with the edges of the 
paper.

IMPORTANT
• Be sure to load paper in portrait orientation.

• If you use paper that has been poorly cut, multiple sheets of paper may be fed at 
once. In this case, align the edges of the paper stack properly on a hard, flat 
surface.

NOTE
To print paper with letterheads or logos, see "Paper Loading Orientation" (p. 3-49) 
and load the paper in the proper orientation.
3-24 Loading Paper in the Paper Cassette
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3 Slide the paper guides.

● Slide the side paper guides to be aligned with the loaded paper.

The side paper guides move together.

IMPORTANT
Be sure to align the paper guides with the width of the paper. If the paper guides 
are too loose or too tight, this may result in misfeeds or paper jams.

How to slide the side paper guides
a Hold the lock release lever.
b Slide the paper guides to be aligned with the loaded paper.

Top View

b

a
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● Slide the rear paper guide to be aligned with the loaded paper.

4 Hold down the paper as shown in the figure, then set it under 
the hooks (A) on the paper guides.

Check the following points.

• Whether the paper stack does not exceed the load limit marks (B) 
• Whether there is sufficient space between the hooks of the paper guides and 

the paper stack

How to slide the rear paper guide
a Hold the lock release lever.
b Slide the paper guide to be aligned with the loaded paper.

Top View

b

a

(A)(B)

(A)
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IMPORTANT
The following shows the paper capacity of the paper cassette.
- Plain paper (Ex. 64 g/m2): Approx. 250 sheets
- Heavy paper (Ex. 91 g/m2): Approx. 200 sheets
Be sure that the paper stack does not exceed the load limit marks. If the paper 
stack exceeds the load limit marks, this may result in misfeeds.

5 Set the paper cassette in the printer.

Push the paper cassette into the printer firmly until the front side of the paper 
cassette is flush with the front surface of the printer.

CAUTION
When setting the paper cassette in the printer, be careful not to catch your 
fingers.

This printer's paper cassette cannot automatically detect the paper size. 
Therefore, you need to register the size of the loaded paper.

6 Display the Printer Status Window.

For details on methods for displaying the Printer Status Window, see "Displaying 
the Printer Status Window," on p. 5-35.

When loading custom size paper, register the size of the loaded paper using the 
following procedure.
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7 From the [Options] menu, select [Device Settings] ➞ 
[Cassette Settings].

8 Select [Custom] aaaa, then click [OK] bbbb.

If printing custom size paper, you need to register the custom paper size in the 
printer driver previously.

9 Display the [Printers and Faxes] folder or the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other Hardware]
➞ [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printer].

Register the size of the loaded custom size paper using the following procedure.

a

b

Windows 2000

Windows XP Professional Windows Server 2003

Windows XP Home Edition

Windows Vista
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10 Right-click the icon for this printer, then select [Printing 
Preferences] from the pop-up menu.

11 Display the [Page Setup] sheet aaaa, then click [Custom Paper 
Size] bbbb.

a

b
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12 Specify the following options as needed.

[Paper List]: Displays [Name] and [Size] of standard paper 
sizes and added custom paper sizes.

[Name of Custom Paper Size]: Enter the name of the custom paper size to be 
added. Up to 31 characters can be entered.

[Unit]: Select the unit ([Millimeter] or [Inch]) to be used 
when setting the custom paper size.

[Paper Size]: Specify the height and width of the custom paper 
size ([Height]  [Width]). Specify the custom 
paper size in portrait orientation ([Height]  
[Width]) within user-definable sizes.

13 Click [Register].

NOTE
The number of custom paper sizes that can be added depends on the system 
environment.

14 Confirm the settings, then click [OK].

Loading paper is now completed.
For details on the procedure for printing, see "Printing from an Application," on p. 5-2.
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The following paper can be loaded in the multi-purpose tray.

IMPORTANT
• For more details on usable paper, see "Usable Paper," on p. 3-2.
• For details on handling the multi-purpose tray, see "Precautions for Handling the 

Multi-purpose Tray or Paper Cassette," on p. 3-12.

Paper Type Paper Size
Loading 

Procedure

Plain Paper 
(60 - 89 g/m2)
Heavy Paper 
(90 - 163 g/m2)

A4, B5, A5, Legal, Letter, Executive, 16K p. 3-32

Custom Paper Size
(Width 76.2 to 215.9 mm; Length 127.0 to 355.6 mm)

p. 3-42

Transparency A4, Letter p. 3-32

Label A4, Letter p. 3-32

Index Card Index Card p. 3-37

Envelope
Envelope DL, Envelope COM10, Envelope C5, 
Envelope Monarch

p. 3-37
3-31Loading Paper in the Multi-purpose Tray



P
ap

er
 L

oa
di

ng
 a

nd
 O

ut
pu

t T
ra

y

3

Loading Standard Size Paper (Other Than Index Card and 
Envelopes)

1 Open the multi-purpose tray.

Holding the opening at the center of the printer, open the multi-purpose tray.

2 Pull out the auxiliary tray.

IMPORTANT
Be sure to pull out the auxiliary tray when loading paper in the multi-purpose tray.
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3 When loading long-size paper such as A4 etc, open the tray 
extension.

4 Spread the paper guides a little wider than the actual paper 
width.
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5 Before loading transparencies or labels, fan them in small 
batches and align the edges.

CAUTION
When loading paper, take care not to cut your hands with the edges of the 
paper.

IMPORTANT
• Be sure to fan the transparencies or labels thoroughly before loading them. If they 

are not fanned enough, multiple sheets of paper may be fed at once, causing paper 
jams.

• When fanning or aligning the transparencies, try to hold the edges to avoid 
touching the printing surface.

• Take care not to mark or stain the printing surface of the transparencies with 
fingerprints, dust, or oil. This may result in poor print quality.

6 Gently load the paper stack until it touches the back of the 
tray.

Be sure that the paper stack is loaded under the load limit guides (A).

Thoroughly fan in small batches Tap the edges on a flat 
surface a few times

(A)
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CAUTION
When loading paper, take care not to cut your hands with the edges of the 
paper.

IMPORTANT
• Be sure to load paper in portrait orientation.

• The following shows the paper capacity of the multi-purpose tray.
- Plain paper (Ex. 64 g/m2): Approx. 50 sheets
- Heavy paper (Ex. 91 g/m2): Approx. 40 sheets
- Heavy paper (Ex. 128 g/m2): Approx. 25 sheets
- Transparency: Approx. 40 sheets
- Label: Approx. 20 sheets
Make sure that the paper stack does not exceed the load limit guides.

• Load the paper so that it is straight.
• If the rear edge of the paper stack is not properly aligned, this may result in 

misfeeds or paper jams.
• If the paper is curled or folded at corners, flatten it before loading it in the printer.
• If you use paper that has been poorly cut, multiple sheets of paper may be fed at 

once. In this case, fan the paper thoroughly, and then align the edges of the stack 
properly on a hard, flat surface.

NOTE
To print paper with letterheads or logos, see "Paper Loading Orientation" (p. 3-49) 
and load the paper in the proper orientation.
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7 Align the paper guides with the width of the paper.

IMPORTANT
Be sure to align the paper guides with the width of the paper. If the paper guides 
are too loose or too tight, this may result in misfeeds or paper jams.

Loading paper is now completed.
For details on the procedure for printing, see "Printing from an Application," on p. 5-2.
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Loading Index Card or Envelopes
Index Card and the following envelopes can be loaded.

• Envelope: Envelope DL, Envelope COM10, Envelope C5, Envelope Monarch

1 Open the multi-purpose tray.

Holding the opening at the center of the printer, open the multi-purpose tray.

2 Pull out the auxiliary tray.

IMPORTANT
Be sure to pull out the auxiliary tray when loading paper in the multi-purpose tray.
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3 Spread the paper guides a little wider than the actual paper 
width.

4 When loading envelopes, align them as follows.

● Place the stack of envelopes on a flat surface, flatten them to release 
any remaining air, and be sure that the edges are pressed tightly.

CAUTION
When loading paper, take care not to cut your hands with the edges of the 
paper.
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● Loosen any stiff corners of the envelopes and flatten curls as shown 
in the figure.

● Align the edges of the envelopes on a flat surface.

5 Gently load the paper stack until it touches the back of the 
tray.

Be sure that the paper stack is loaded under the load limit guides (A).

(A)
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CAUTION
When loading paper, take care not to cut your hands with the edges of the 
paper.

IMPORTANT
• Load Index Card or envelopes with the printing side facing up as follows.

( : Feeding direction)
- Envelope

Load the envelopes so that the flap is toward the left of the printer when viewed 
from the front.

- Index Card
Load Index Card in portrait orientation.

• The following shows the paper capacity of the multi-purpose tray.
- Index Card: Approx. 15 sheets
- Envelope: Approx. 5 sheets
Make sure that the paper stack does not exceed the load limit guides.

• You cannot print on the reverse side (glued side) of envelopes.
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6 Align the paper guides with the width of the paper.

IMPORTANT
Be sure to align the paper guides with the width of the paper. If the paper guides 
are too loose or too tight, this may result in misfeeds or paper jams.

Loading paper is now completed.
For details on the procedure for printing, see "Printing from an Application," on p. 5-2.
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Loading Custom Size Paper (Non-Standard Paper)
You can load paper of the following custom paper sizes.

• Width 76.2 to 215.9 mm; Length 127.0 to 355.6 mm

1 Open the multi-purpose tray.

Holding the opening at the center of the printer, open the multi-purpose tray.

2 Pull out the auxiliary tray.

IMPORTANT
Be sure to pull out the auxiliary tray when loading paper in the multi-purpose tray.
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3 When loading long-size paper, open the tray extension.

4 Spread the paper guides a little wider than the actual paper 
width.
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5 Gently load the paper stack until it touches the back of the 
tray.

Be sure that the paper stack is loaded under the load limit guides (A).

CAUTION
When loading paper, take care not to cut your hands with the edges of the 
paper.

IMPORTANT
• Be sure to load paper in portrait orientation.

• The following shows the paper capacity of the multi-purpose tray.
- Plain paper (Ex. 64 g/m2): Approx. 50 sheets
- Heavy paper (Ex. 91 g/m2): Approx. 40 sheets
- Heavy paper (Ex. 128 g/m2): Approx. 25 sheets
Make sure that the paper stack does not exceed the load limit guides.

• Load the paper so that it is straight.
• If the rear edge of the paper stack is not properly aligned, this may result in 

misfeeds or paper jams.
• If the paper is curled or folded at corners, flatten it before loading it in the printer.
• If you use paper that has been poorly cut, multiple sheets of paper may be fed at 

once. In this case, fan the paper thoroughly, and then align the edges of the stack 
properly on a hard, flat surface.

(A)
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NOTE
To print paper with letterheads or logos, see "Paper Loading Orientation" (p. 3-49) 
and load the paper in the proper orientation.

6 Align the paper guides with the width of the paper.

IMPORTANT
Be sure to align the paper guides with the width of the paper. If the paper guides 
are too loose or too tight, this may result in misfeeds or paper jams.

If printing custom size paper, you need to register the custom paper size in the 
printer driver previously.

Register the size of the loaded custom size paper using the following procedure.
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7 Display the [Printers and Faxes] folder or the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other Hardware]
➞ [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printer].

8 Right-click the icon for this printer, then select [Printing 
Preferences] from the pop-up menu.

Windows 2000

Windows XP Professional Windows Server 2003

Windows XP Home Edition

Windows Vista
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9 Display the [Page Setup] sheet aaaa, then click [Custom Paper 
Size] bbbb.

10 Specify the following options as needed.

[Paper List]: Displays [Name] and [Size] of standard paper sizes and added 
custom paper sizes.

[Name of Custom 
Paper Size]:

Enter the name of the custom paper size to be added. Up to 31 
characters can be entered.

[Unit]: Select the unit ([Millimeter] or [Inch]) to be used when setting the 
custom paper size.

[Paper Size]: Specify the height and width of the custom paper size ([Height]  
[Width]). Specify the custom paper size in portrait orientation 
([Height]  [Width]) within user-definable sizes.

a

b
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11 Click [Register].

NOTE
The number of custom paper sizes that can be added depends on the system 
environment.

12 Confirm the settings, then click [OK].

Loading paper is now completed.
For details on the procedure for printing, see "Printing from an Application," on p. 5-2.
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To print paper with letterheads or logos, load the paper in the proper orientation as 
follows.  in the table indicates the feeding directions.

Portrait Layout Landscape Layout
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NOTE

For details on loading orientation of envelopes, see "Loading Index Card or Envelopes," 
on p. 3-37.

Portrait Layout Landscape Layout
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System Requirements
The following system environment is required to use the printer driver.

■ Operating system software
• Windows 2000 Server or Professional
• Windows XP Professional or Home Edition
• Windows XP Professional x64 Edition
• Windows Server 2003
• Windows Server 2003 x64 Editions
• Windows Vista (32-bit or 64-bit version)
• Windows Server 2008 (32-bit or 64-bit version)
• Windows 7 (32-bit or 64-bit version)

✝ For details on the procedures, instructions, and so on for Windows 7 and Server 2008, refer to those for
Windows Vista.

✝ For details on the latest status of the supported operating systems and Service Pack, see the Canon website
(http://www.canon.com/).

- System Requirements (minimum required)

(PC/AT Compatibles)
* Because the amount of available memory varies depending on the computer's system configuration as well 

as the applications you are using, the above environment does not necessarily guarantee printing.

- System Requirements (recommended)

■ Interface
• When connecting with USB

USB 2.0 Hi-Speed/USB Full-Speed (USB1.1 equivalent)
• When connecting to a network

- Connector: 10BASE-T or 100BASE-TX
- Protocol: TCP/IP

Windows 2000/XP/
Server 2003

Windows Vista

CPU 300 MHz or more 800 MHz or more

Memory (RAM)* 128 MB or more 512 MB or more

Hard Disk
Free hard disk space displayed on the installation 
screen of the printer driver

Windows 2000/XP/
Server 2003

Windows Vista

CPU 1.2 GHz or more 1.8 GHz or more

Memory (RAM) 256 MB or more 1 GB or more
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NOTE
This printer uses bi-directional communication. Operation of the printer when connected 
via unidirectional communication equipment has not been tested, and as a result, Canon 
cannot guarantee printer operation if the printer is connected using unidirectional print 
servers, USB hubs or switching devices.
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Checking Your Printing Environment
The procedure for installing the printer driver varies depending on the system 
environment. See the following according to your system environment.

*Only if the optional network board is installed

If the printer and computer are 
connected by a USB cable (See p. 4-5)

If the printer and computer are 
connected by a LAN cable*

(See Network Guide)

Using a Print Server

● If your computer is the print server
- If the printer and print server are connected by a USB cable (See p. 4-5)
- If the printer and print server are connected by a LAN cable* (See Network Guide)

* Only if the optional network board is installed

● If your computer is a client computer (See p. 4-48)

USB Cable

LAN Cable

USB Cable LAN Cable

LAN Cable

Client

Client

Print Server

Print Server
4-4 Checking Your Printing Environment
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Install the printer driver on a computer. The printer driver is software required for 
printing from an application. This section describes the procedure for installing the 
printer driver on a computer connected to the printer by a USB cable.

There are the following methods for installing the printer driver.

* If you want to install the manuals only, see "Installing the Manuals," on p. 5-29.

IMPORTANT
When there is insufficient free hard disk space, a message will appear during the 
installation. Stop the installation and increase the free space of the disk, and then install 
the printer driver again.

NOTE
• If the print server is running 64-bit Windows Vista, and if you want to update the 

additional driver (alternate driver), perform the following procedure.

1. Uninstall the printer driver used in the print server. (See p. 4-69)
2. Install the new printer driver on the print server. (See p. 4-5)
3. See "Print Server Settings" (p. 4-37) and install the additional driver again.

• A USB cable is only supplied with 220 - 240 V model for countries and regions of Asia. In 
other countries and regions, prepare according to the specifications of your computer. 
Use a USB cable with the following symbol.

Installation method Contents Reference page

Installing from 
CD-ROM

Installs the printer driver from the 
CD-ROM supplied with the printer 
(CD-ROM Setup). Also, you can 
install the printer driver and the 
instruction manuals at a time.*

p. 4-6

Installing with Plug and 
Play

Searches for the printer 
automatically, selects the file 
required for the installation from the 
CD-ROM supplied with the printer, 
and then installs the printer driver.

Windows Vista: p. 4-12

Windows XP/Server 2003: p. 
4-19

Windows 2000: p. 4-24
4-5Installing the Printer Driver



S
et

tin
g 

U
p 

th
e 

P
rin

tin
g 

E
nv

iro
nm

en
t

4

Installing from CD-ROM

NOTE
The screenshots used in this section are from Windows XP Professional.

1 Make sure that the printer and computer are OFF.

2 Connect the B-type (square) end of the USB cable to the USB 
connector on the printer.

3 Connect the A-type (flat) end of the USB cable to the USB port 
on the computer.

4 Turn the computer on and start up Windows.
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5 Log on as a user with administrator rights.

IMPORTANT
• If a Wizard or dialog box appears through the Plug and Play automatic setup, click 

[Cancel], turn the printer OFF, and then install the printer driver using this 
procedure.

• If you are not sure about the permissions, ask your computer administrator.

6 Insert the supplied "LBP3310 User Software" CD-ROM into 
the CD-ROM drive.

If the CD-ROM is already in the drive, eject the disk and re-insert it into the drive.

IMPORTANT
• If you are using Windows Vista and the [AutoPlay] dialog box appears, click [Run 

AUTORUN.EXE].
• If CD-ROM Setup does not appear, display it using the following procedures. (The 

CD-ROM drive name is indicated as "D:" in this manual. The CD-ROM drive name 
may differ depending on the computer you are using.)
- If you are using an operating system other than Windows Vista, select [Run] from 

the [Start] menu, enter "D:\English\MInst.exe", and then click [OK].
- If you are using Windows Vista, enter "D:\English\MInst.exe" in [Start Search] 

under the [Start] menu, and then press the [ENTER] key on your keyboard.

NOTE
If you are using Windows Vista and the [User Account Control] dialog box appears, 
click [Allow].

7 Click [Easy Installation] or [Custom Installation].
• If you want to install the printer driver and the manuals: [Easy Installation]
• If you want to install only the printer driver: [Custom Installation]
4-7Installing the Printer Driver
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8 Click [Install].

If you selected [Custom Installation] in Step 7, clear the [Online Manuals] check 
box a, and then click [Install] b.

9 Confirm the contents, then click [Yes].

a

b
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10 Click [Next].

11 Select [Install with USB Connection] aaaa, then click [Next] bbbb.

Depending on the system environment, a message that prompts you to restart the 
computer may appear. In this case, restart the computer and install the printer 
driver again.

If you are using Windows Vista, the following screen appears. Click [Yes].

Select [No] only if you do not use a LAN cable to connect the printer to a 
computer on which the printer driver is being installed.

a

b
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12 Click [Yes].

NOTE
• If you are using Windows 2000 and the [Digital Signature Not Found] dialog box 

appears, click [Yes].
• If you are using Windows XP/Server 2003 and the [Hardware Installation] dialog 

box appears, click [Continue Anyway].
• If you are using Windows Vista and the [Windows Security] dialog box appears, 

click [Install this driver software anyway].

13 When the following screen is displayed, turn the printer ON.

Press the " " side of the power switch to turn the printer ON.

Installation of the printer driver starts automatically.

If [Easy Installation] was selected in Step 7, the manuals are also installed at a 
time.
4-10 Installing the Printer Driver
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NOTE
• Depending on the system environment, the installation may take a long time.
• If the printer is not recognized automatically even after the USB cable is connected, 

see "Installation Problems," on p. 8-37.
• If you are using Windows XP/Server 2003 and the [Hardware Installation] dialog 

box appears, click [Continue Anyway].
• If you are using Windows Vista and the [Windows Security] dialog box appears, 

click [Install this driver software anyway].

14 Confirm the installation results, then click [Next].

NOTE
If the printer driver is not installed properly, see "Installation Problems," on p. 8-37.

15 Select the [Restart Computer Now (Recommended)] check 
box aaaa, then click [Restart] bbbb.

Windows restarts.

The installation of the printer driver is completed.
You can take the CD-ROM out of the CD-ROM drive after the installation is completed.

a

b
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Installing with Plug and Play
The procedure for installing the printer driver using Plug and Play varies depending 
on your operating system. See the following according to your operating system.

• For Windows Vista (See p. 4-12)

• For Windows XP/Server 2003 (See p. 4-19)

• For Windows 2000 (See p. 4-24)

IMPORTANT
If you are using Windows 7, you may not be able to install the printer driver properly due 
to the Windows restriction even after detecting the printer with Plug and Play.

Click [What can I do if my device did not install properly?], and then see 
Windows Help or reinstall the printer driver in "Installing from CD-ROM" (See 
p. 4-6).

For Windows Vista

IMPORTANT
The printer driver is automatically installed on a computer on which the printer driver for 
this printer has been installed before, if you perform the following procedure.

1. Connect the printer and computer with a USB cable.
2. Turn the printer ON.
If you want to update the printer driver (or want to install it manually), see "Installing from 
CD-ROM" (p. 4-6) and install the printer driver.
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1 Make sure that the printer and computer are OFF.

2 Connect the B-type (square) end of the USB cable to the USB 
connector on the printer.

3 Connect the A-type (flat) end of the USB cable to the USB port 
on the computer.
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4 Press the " " side of the power switch to turn the printer ON.

5 Turn the computer on and start up Windows Vista.

6 Log on as a user with administrator rights.

IMPORTANT
If you are not sure about the permissions, ask your computer administrator.

7 Click [Locate and install driver software (recommended)].

IMPORTANT
The printer driver is automatically installed on a computer on which the printer 
driver for this printer has been installed before, without the above screen being 
displayed. 
If you want to update the printer driver (or want to install it manually), see "Installing 
from CD-ROM" (p. 4-6) and install the printer driver.

NOTE
If the [User Account Control] dialog box appears, click [Continue].
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8 If the following screen appears, click [Don't search online].

9 Click [I don't have the disc. Show me other options.].
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10 Click [Browse my computer for driver software (advanced)].

11 Insert the supplied "LBP3310 User Software" CD-ROM into 
the CD-ROM drive, and then click [Browse].

If CD-ROM Setup appears, click [Exit].

12 Select the folder in which the printer driver is included.

NOTE
If you are not sure whether you are using 32-bit Windows Vista or 64-bit Windows 
Vista, see "Checking the Processor Version of Windows Vista," on p. 10-8.
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● If you are using 32-bit Windows Vista

Select the folder in the supplied CD-ROM: [English] - [32bit] - [Win2K_Vista] a, 
then click [OK] b.

● If you are using 64-bit Windows Vista

Select the folder in the supplied CD-ROM: [English] - [x64] - [Driver] a, then 
click [OK] b.

a

b

a

b
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13 Click [Next].

Copying files is started.

NOTE
If the [Windows Security] dialog box appears, click [Install this driver software 
anyway].

14 Click [Close].

The installation of the printer driver is completed.
You can take the CD-ROM out of the CD-ROM drive after the installation is completed.
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For Windows XP/Server 2003

NOTE
The screenshots used in this section are from Windows XP Professional.

1 Make sure that the printer and computer are OFF.

2 Connect the B-type (square) end of the USB cable to the USB 
connector on the printer.

3 Connect the A-type (flat) end of the USB cable to the USB port 
on the computer.
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4 Press the " " side of the power switch to turn the printer ON.

5 Turn the computer on and start up Windows XP/Server 2003.

6 Log on as a user with administrator rights.

IMPORTANT
If you are not sure about the permissions, ask your computer administrator.

7 Insert the supplied "LBP3310 User Software" CD-ROM into 
the CD-ROM drive.

If CD-ROM Setup appears, click [Exit].

● If the following screen is displayed

Select [Install from a list or specific location (Advanced)] a, then click [Next] b.

a

b
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● If the following screen is displayed

1. Select [No, not this time] a, then click [Next] b.

2. Select [Install from a list or specific location (Advanced)] a, then click [Next] b.

a

b

a

b
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8 Perform the following procedure.
1. Select [Search for the best driver in these locations.].

2. Clear the [Search removable media (floppy, CD-ROM...)] check box.

3. Select the [Include this location in the search] check box.

4. Click [Browse].

9 Select the folder in which the printer driver is included.

● If you are using 32-bit Windows XP or Server 2003

Select the folder in the supplied CD-ROM: [English] - [32bit] - [Win2K_Vista] a, 
then click [OK] b.

a

b
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● If you are using 64-bit Windows XP or Server 2003

Select the folder in the supplied CD-ROM: [English] - [x64] - [Driver] a, then 
click [OK] b.

10 Click [Next].

The installation process is displayed.

NOTE
If the [Hardware Installation] dialog box appears, click [Continue Anyway].

a

b
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11 Click [Finish].

The installation of the printer driver is completed.
You can take the CD-ROM out of the CD-ROM drive after the installation is completed.

For Windows 2000

1 Make sure that the printer and computer are OFF.

2 Connect the B-type (square) end of the USB cable to the USB 
connector on the printer.
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3 Connect the A-type (flat) end of the USB cable to the USB port 
on the computer.

4 Press the " " side of the power switch to turn the printer ON.

5 Turn the computer on and start up Windows 2000.

6 Log on as a user with administrator rights.

IMPORTANT
If you are not sure about the permissions, ask your computer administrator.
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7 Click [Next].

8 Select [Search for a suitable driver for my device 
(recommended)] aaaa, then click [Next] bbbb.

NOTE
[Unknown] may be displayed as the name of the device.

9 Perform the following procedure.
1. Clear the [Floppy disk drives] check box and the [CD-ROM drives] check box.

2. Select the [Specify a location] check box.

a

b

4-26 Installing the Printer Driver



S
et

tin
g 

U
p 

th
e 

P
rin

tin
g 

E
nv

iro
nm

en
t

4

3. Click [Next].

10 Insert the supplied "LBP3310 User Software" CD-ROM into 
the CD-ROM drive, and then click [Browse].

If CD-ROM Setup appears, click [Exit].

11 Open the folder in the supplied CD-ROM: [English] - [32bit] - 
[Win2K_Vista].

12 Select [CNAB7STK.INF] aaaa, then click [Open] bbbb.

a

b
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13 Click [OK].

14 Click [Next].

Copying files is started.

NOTE
If the [Digital Signature Not Found] dialog box appears, click [Yes].

15 Click [Finish].
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The installation of the printer driver is completed.
You can take the CD-ROM out of the CD-ROM drive after the installation is completed.
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After Completing Installation
When the installation of the printer driver is completed, an icon and folder for this 
printer will be created.

For Windows Vista
• The icon for the printer is displayed in the [Printers] folder.

• [Canon Printer Uninstaller] is added to [All Programs] under the [Start] menu.

• If the manuals are installed, [LBP3310 Online Manuals] is created on the desktop, and 
[LBP3310 Online Manuals] under [Canon LBP3310] is added to [All Programs] under the 
[Start] menu.
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For Windows XP/Server 2003
• The icon for this printer is displayed in the [Printers and Faxes] folder.

• [Canon Printer Uninstaller] is added to [All Programs] under the [Start] menu.

• If the manuals are installed, [LBP3310 Online Manuals] is created on the desktop, and 
[LBP3310 Online Manuals] under [Canon LBP3310] is added to [All Programs] under the 
[Start] menu.
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For Windows 2000
• The icon for the printer is displayed in the [Printers] folder.

• [Canon Printer Uninstaller] is added to [Programs] under the [Start] menu.

• If the manuals are installed, [LBP3310 Online Manuals] is created on the desktop, and 
[LBP3310 Online Manuals] under [Canon LBP3310] is added to [Programs] under the 
[Start] menu.
4-32 After Completing Installation
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After installing the printer driver, be sure to perform Configuration Page Print to 
check the operations using the following procedure.

Configuration Page Print shows the status of the optional accessories and various 
settings.

NOTE
• Configuration Page Print is designed to be printed on A4 size paper. Load A4 size paper.
• The screenshots used in this section are from Windows XP Professional.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other Hardware]
➞ [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printer].

2 Right-click the icon for this printer, then select [Printing 
Preferences] from the pop-up menu.

Windows 2000

Windows XP Professional Windows Server 2003

Windows XP Home Edition

Windows Vista
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3 Display the [Page Setup] sheet aaaa, then click [ ] (Display 
Printer Status Window) bbbb.

NOTE
For details on the Printer Status Window, see "Printer Status Window," on p. 5-34.

4 From the [Options] menu, select [Utility] ➞ [Configuration 
Page Print].

5 Click [OK].

a

b
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Configuration Page Print is printed.

IMPORTANT
This is a sample of Configuration Page Print. The contents may differ from the 
Configuration Page Print printed by your printer.

NOTE
If Configuration Page Print is not printed properly, see "Chapter 8 Troubleshooting".
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Printing from a Network Computer by Sharing the 
Printer on a Network
When you share this printer on a network, you can use it as a network printer, 
which enables printing from other computers that are not directly connected to this 
printer. 
If this printer is going to be used by multiple computers on a network, perform the 
following configuration. In this manual, the computer directly connected to the 
printer is called "print server", and the other computers which use the printer via the 
network are called "clients".

*1 The term "Local Installation" indicates installing the printer driver using the supplied CD-ROM.

*2 The term "Download Installation" indicates downloading the printer driver from the print server to client computers 
and installing it without using the supplied CD-ROM.

*3 If your print server is Windows 2000/XP/Server 2003/Vista (32-bit), you cannot download and install the printer driver 
on 64-bit Windows XP/Server 2003/Vista.

*4 If a 64-bit operating system is running on the print server, the download installation for the following client computers 
on which a 32-bit operating system is running is not supported due to the Windows restriction.
- Windows 2000
- Windows XP (on which no service pack or SP1 is installed)
- Windows Server 2003 (on which no service pack is installed)
If you download and install the printer driver on any of the above 32-bit operating systems, you may fail to install the 
driver and may not be able to open the printing preferences dialog box.

Local 
Installation*1

Download 
Installation*2

For Printing

Download 
Installation

Client Client

Network Environment

Print ServerLBP3310

*3*4
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When using a print server, perform any one of the following tasks.

Print Server Settings

NOTE
The screenshots used in this section are from Windows XP Professional.

Preparing the Printer Sharing Settings

1 Perform the following procedure.

From the [Start] menu, select [Settings] ➞ [Network and Dial-up Connections].

From the [Start] menu, select [Control Panel], and then click [Network and Internet
Connections] ➞ [Network Connections].

From the [Start] menu, select [Control Panel] ➞ [Network Connections] ➞ [Local Area
Connection], click [Properties], and then proceed to Step 3.

From the [Start] menu, select [Control Panel], and then click [View network status and
tasks] ➞ [Manage network connections].

For the print server

1. Install the printer driver.
- If the printer and print server are connected by a USB cable (See p. 4-5)
- If the printer and print server are connected by a LAN cable (See Network Guide)

2. Configure the print server. (See p. 4-37)

For client computers

Install the printer driver. (See p. 4-48)

Windows 2000

Windows XP

Windows Server 2003

Windows Vista
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2 Right-click the [Local Area Connection] icon, then select 
[Properties] from the pop-up menu.

NOTE
If you are using Windows Vista and the [User Account Control] dialog box appears, 
click [Continue].

3 Make sure that [File and Printers Sharing for Microsoft 
Networks] is selected aaaa, then click [OK] bbbb.

a

b
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Printer Sharing Settings
Printer sharing settings vary depending on your operating system. See the 
following setting procedure according to your operating system.

• For Windows 2000/XP/Server 2003/Vista (32-bit) (See p. 4-39)

• For Windows XP/Server 2003/Vista (64-bit) (See p. 4-43)

NOTE
If you are not sure whether you are using 32-bit Windows Vista or 64-bit Windows Vista, 
see "Checking the Processor Version of Windows Vista," on p. 10-8.

■ For Windows 2000/XP/Server 2003/Vista (32-bit)

NOTE
For Windows XP, the printer cannot be shared on a network at the default settings (the 
settings immediately after the installation).
Printer sharing settings require running [Network Setup Wizard] to enable the sharing 
settings. 
For more details, see Windows Help.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other Hardware]
➞ [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printer].

Windows 2000

Windows XP Professional Windows Server 2003

Windows XP Home Edition

Windows Vista
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2 Right-click the icon for this printer, then select [Sharing] from 
the pop-up menu.

NOTE
If you are using Windows Vista and [Change sharing options] appears, click 
[Change sharing options].

If the [User Account Control] dialog box appears, click [Continue].
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3 Perform the following procedure.

Select [Shared as]. Change the share name as needed.

  

Select [Share this printer]. Change the share name as needed.

Select the [Share this printer] check box. Change the share name as needed.

NOTE
• You can also specify the sharing settings during the local installation.
• Do not enter blank or special characters for the share name.

Windows 2000

Windows XP Professional Windows Server 2003

Windows Vista
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4 Click [OK].

The printer icon changes to the shared printer icon.

IMPORTANT
To clear the printer sharing settings, use the following procedures.
- For an operating system other than Windows Vista: Select [Do not share this 

printer] ([Not shared] for Windows 2000) in the [Sharing] sheet.
- For Windows Vista: Clear the [Share this printer] check box in the [Sharing] sheet. 

(If [Change sharing options] appears, click [Change sharing options] to display 
the [User Account Control] dialog box, and then click [Continue].)
4-42 Printing from a Network Computer by Sharing the Printer on a Network



  

S
et

tin
g 

U
p 

th
e 

P
rin

tin
g 

E
nv

iro
nm

en
t

 

4

         
■ For Windows XP/Server 2003/Vista (64-bit)

NOTE
For Windows XP, the printer cannot be shared on a network at the default settings (the 
settings immediately after the installation).
Printer sharing settings require running [Network Setup Wizard] to enable the sharing 
settings. 
For more details, see Windows Help.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printer].

2 Right-click the icon for this printer, then select [Sharing] from 
the pop-up menu.

Windows XP Professional Windows Server 2003

Windows Vista
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NOTE
If you are using Windows Vista and [Change sharing options] appears, click 
[Change sharing options].

If the [User Account Control] dialog box appears, click [Continue].

3 Perform the following procedure.

  

Select [Share this printer]. Change the share name as needed.

Select the [Share this printer] check box. Change the share name as needed.

Windows XP Professional Windows Server 2003

Windows Vista
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NOTE
• You can also specify the sharing settings during the local installation.
• Do not enter blank or special characters for the share name.

4 Perform the following procedure.

● If any clients are using Windows 2000/XP/Server 2003/Vista (32-bit)

Click [Additional Drivers].

NOTE
If you want to update the additional driver (alternate driver), perform the following 
procedure.

1. Uninstall the printer driver used in the print server. (See p. 4-69)
2. Install the new printer driver on the print server. (See p. 4-5)
3. Install the additional driver again.

● If no client is using Windows 2000/XP/Server 2003/Vista (32-bit)

Proceed to Step 10.
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5 Select the check box for [Windows 2000, Windows XP and 
Windows Server 2003] in the [Version] column or for [x86] in 
the [Processor] column aaaa, and then click [OK] bbbb.

6 Insert the supplied "LBP3310 User Software" CD-ROM into 
the CD-ROM drive, and then click [Browse].

If CD-ROM Setup appears, click [Exit].

7 Open the folder in the supplied CD-ROM: [English] - [32bit] - 
[Win2K_Vista].

a

b
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8 Select [CNAB7STK.INF] aaaa, then click [Open] bbbb.

9 Click [OK].

Copying files is started.
You can take the CD-ROM out of the CD-ROM drive after copying files is 
completed.

NOTE
If the [Windows Security] dialog box appears, click [Install this driver software 
anyway].

a

b
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10 Click [Close] or [OK].

The printer icon changes to the shared printer icon.

IMPORTANT
To clear the printer sharing settings, clear the [Share this printer] check box in the 
[Sharing] sheet. (If [Change sharing options] appears, click [Change sharing 
options] to display the [User Account Control] dialog box, and then click 
[Continue].)

Installation on Clients
There are two ways to install the printer driver on client computers: local installation 
and download installation.

■ Local Installation (See p. 4-49)
You install the printer driver using the supplied CD-ROM.

■ Download Installation
You install the printer driver without using the supplied CD-ROM, but by downloading the 
printer driver from the print server. There are the following two ways to download and 
install the printer driver.

• Installing from the [Printers and Faxes] Folder or the [Printers] Folder (See p. 4-55)
• Installing from [Windows Explorer] (See p. 4-67)
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NOTE
• If your print server is Windows 2000/XP/Server 2003/Vista (32-bit), you cannot download 

and install the printer driver on 64-bit Windows XP/Server 2003/Vista.
• If a 64-bit operating system is running on the print server, the download installation for 

the following client computers on which a 32-bit operating system is running is not 
supported due to the Windows restriction.
- Windows 2000
- Windows XP (on which no service pack or SP1 is installed)
- Windows Server 2003 (on which no service pack is installed)
If you download and install the printer driver on any of the above 32-bit operating 
systems, you may fail to install the driver and may not be able to open the printing 
preferences dialog box.

• The screenshots used in this section are from Windows XP Professional.

Installing the Printer Driver from CD-ROM Setup

1 Turn the computer on and start up Windows.

2 Log on as a user with administrator rights.

IMPORTANT
If you are not sure about the permissions, ask your computer administrator.

3 Insert the supplied "LBP3310 User Software" CD-ROM into 
the CD-ROM drive.

If the CD-ROM is already in the drive, eject the disk and re-insert it into the drive.

IMPORTANT
• If you are using Windows Vista and the [AutoPlay] dialog box appears, click [Run 

AUTORUN.EXE].
• If CD-ROM Setup does not appear, display it using the following procedures. (The 

CD-ROM drive name is indicated as "D:" in this manual. The CD-ROM drive name 
may differ depending on the computer you are using.)
- If you are using an operating system other than Windows Vista, select [Run] from 

the [Start] menu, enter "D:\English\MInst.exe", and then click [OK].
- If you are using Windows Vista, enter "D:\English\MInst.exe" in [Start Search] 

under the [Start] menu, and then press the [ENTER] key on your keyboard.

NOTE
If you are using Windows Vista and the [User Account Control] dialog box appears, 
click [Allow].
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4 Click [Easy Installation] or [Custom Installation].
• If you want to install the printer driver and the manuals: [Easy Installation]
• If you want to install only the printer driver: [Custom Installation]

5 Click [Install].

If you selected [Custom Installation] in Step 4, clear the [Online Manuals] check 
box a, and then click [Install] b.

a

b
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6 Confirm the contents, then click [Yes].

7 Click [Next].

8 Select [Manually Set Port to Install] aaaa, then click [Next] bbbb.

a

b
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9 Click [Add Port].

10 Select [Network] aaaa, then click [OK] bbbb.

11 Select the icon for the shared printer in the print server aaaa, 
then click [OK] bbbb.

a

b

a

b
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12 Select whether or not to use this printer as the default printer 
aaaa, then click [Next] bbbb.

13 Click [Start].

If you are using Windows Vista, the following screen appears. Click [Yes].

Select [No] only if you do not use a LAN cable to connect the printer to a 
computer on which the printer driver is being installed.

a

b
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14 Click [Yes].

Installation of the printer driver starts.

If you are using Windows Vista, the [Printers] dialog box appears. Click [Install 
driver].

If [Easy Installation] was selected in Step 4, the manuals are also installed at a 
time.

NOTE
Depending on the system environment, the installation may take a long time.

15 Confirm the installation results, then click [Next].

NOTE
If the printer driver is not installed properly, see "Installation Problems," on p. 8-37.
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16 Select the [Restart Computer Now (Recommended)] check 
box aaaa, then click [Restart] bbbb.

Windows restarts.

The installation of the printer driver is completed.
You can take the CD-ROM out of the CD-ROM drive after the installation is completed.

Installing from the [Printers and Faxes] Folder or the [Printers] 
Folder
The procedure for installing the printer driver from the [Printers and Faxes] folder or 
the [Printers] folder varies depending on your operating system. See the following 
according to your operating system.

• For Windows Vista (See p. 4-55)

• For Windows XP/Server 2003 (See p. 4-60)

• For Windows 2000 (See p. 4-64)

■ For Windows Vista

1 Turn the computer on and start up Windows Vista.

2 Log on to Windows Vista.

NOTE
A user without administrator rights can also install the printer driver. 
If you log on as a user without administrator rights, however, you need the 
password for a user with administrator rights during the installation.

a

b
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3 Display the [Printers] folder.

From the [Start] menu, select [Control Panel], and then click [Printer].

4 Click [Add a printer].

5 Click [Add a network, wireless or Bluetooth printer].

Searching for the printer on the network starts automatically.
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6 Click [The printer that I want isn't listed].

7 Select [Select a shared printer by name] aaaa, then click [Next] bbbb.

a

b
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8 Select the printer on the print server aaaa, then click [Select] bbbb.

NOTE
When specifying the path to the network using "\" directly, specify it as "\\the print 
sever name (the computer name of the print server)\the printer name".

9 Click [Install driver].

NOTE
If the [User Account Control] dialog box appears, click [Continue].

a

b
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10 Click [Next].

NOTE
If another printer driver has already been installed in the computer, [Set as the 
default printer] appears. If you want to specify the printer as the default printer, 
select the [Set as the default printer] check box.

11 If you want to print a test page, click [Print a test page].

A confirmation dialog box appears. Click [Close] to close the dialog box.
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12 Click [Finish].

The installation of the printer driver is completed.

■ For Windows XP/Server 2003

1 Turn the computer on and start up Windows XP/Server 2003.

2 Log on to Windows XP/Server 2003.

NOTE
A user without administrator rights can also install the printer driver.

3 Display the [Printers and Faxes] folder.

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other Hardware]
➞ [Printers and Faxes].

Windows XP Professional Windows Server 2003

Windows XP Home Edition
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4 Display [Add Printer Wizard].

Click [Add a printer].

Double-click [Add Printer].

5 Click [Next].

Windows XP

Windows Server 2003
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6 Select [A network printer, or a printer attached to another 
computer] aaaa, then click [Next] bbbb.

7 Select [Connect to this printer (or to browse for a printer, 
select this option and click Next)] aaaa, then click [Next] bbbb.

a

b

a

b
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8 Select the printer on the print server aaaa, then click [Next] bbbb.

NOTE
• If the [Connect to Printer] dialog box appears, follow the directions in the message.
• When specifying the path to the network using "\" directly, specify it as "\\the print 

sever name (the computer name of the print server)\the printer name".

9 If the following screen appears, select whether or not to use 
this printer as the default printer a, and then click [Next] b.

a

b

a

b
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10 Click [Finish].

The installation of the printer driver is completed.

■ For Windows 2000

1 Turn the computer on and start up Windows 2000.

2 Log on to Windows 2000.

NOTE
A user without administrator rights can also install the printer driver.

3 Display the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

4 Double-click [Add Printer].
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5 Click [Next].

6 Select [Network printer] aaaa, then click [Next] bbbb.

7 Select [Type the printer name, or click Next to browse for a 
printer] aaaa, then click [Next] bbbb.

a

b

a

b
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8 Select the printer on the print server aaaa, then click [Next] bbbb.

NOTE
When specifying the path to the network using "\" directly, specify it as "\\the print 
sever name (the computer name of the print server)\the printer name".

9 Select whether or not to use this printer as the default printer 
aaaa, then click [Next] bbbb.

a

b

a

b
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10 Click [Finish].

The installation of the printer driver is completed.

Installing from [Windows Explorer]

1 Turn the computer on and start up Windows.

2 Log on to Windows.

NOTE
A user without administrator rights can also install the printer driver. 
If you log on to Windows Vista as a user without administrator rights, however, you 
need the password for a user with administrator rights during the installation.

3 Display [Windows Explorer].

From the [Start] menu, select [Programs] ➞ [Accessories] ➞ [Windows Explorer].

    

From the [Start] menu, select [All Programs] ➞ [Accessories] ➞ [Windows Explorer].

Windows 2000

Windows XP Windows Server 2003 Windows Vista
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4 Select the print server from [My Network Places] (from 
[Network] for Windows Vista), then double-click the icon for 
this printer.

Alternatively, you can drag and drop the icon for the printer into the [Printers and 
Faxes] folder or [Printers] folder.

5 Follow the instructions on the screen.

The installation of the printer driver is completed.
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The process of removing the printer driver to restore the computer to the same 
state as before the printer driver was installed is referred to as uninstallation. The 
printer driver can be uninstalled using the following procedure.

IMPORTANT
• A user without administrator rights cannot uninstall the printer driver. Be sure to log on as 

a user with administrator rights before the uninstallation.
If you are not sure about the permissions, ask your computer administrator.

• If you are using Windows 7, be sure to disconnect the USB cable before uninstalling the 
printer driver.

• If you are using Windows 2000/XP/Server 2003/Vista (32-bit), uninstalling the printer 
driver also uninstalls the installed manuals. 
If you are using 64-bit Windows XP/Server 2003/Vista, the installed manuals are not 
uninstalled by uninstalling the printer driver. For details on uninstalling the manuals, see 
"Uninstalling the Manuals," on p. 5-32.
* If you are not sure whether you are using 32-bit Windows Vista or 64-bit Windows Vista, see "Checking the 

Processor Version of Windows Vista," on p. 10-8.

1 Close all of the files and programs listed below.
• Help files
• Printer Status Window
• Control Panel
• Other applications

2 Perform the following procedure.

From the [Start] menu, select [Programs] ➞ [Canon Printer Uninstaller] ➞ [Canon
LBP3310 Uninstaller].

    

From the [Start] menu, select [All Programs] ➞ [Canon Printer Uninstaller] ➞ [Canon
LBP3310 Uninstaller].

Windows 2000

Windows XP Windows Server 2003 Windows Vista
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NOTE
If you are using Windows Vista and the [User Account Control] dialog box appears, 
click [Allow].

3 Perform the following procedure.

● If this printer is on the list in the [Delete Printer] dialog box

Select the name of this printer a, then click [Delete] b.

● If this printer is not on the list in the [Delete Printer] dialog box

Click [Delete].

4 Click [Yes].

a

b
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If the printer is used as a shared printer, the following screen appears. Confirm 
the contents of the message, and then click [Yes] if you want to uninstall the 
printer driver.

Uninstallation starts. Please wait a moment.

5 Click [Exit].

6 Display the [Printers and Faxes] folder or the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other Hardware]
➞ [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printer].

Windows 2000

Windows XP Professional Windows Server 2003

Windows XP Home Edition

Windows Vista
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7 Make sure that the icon for this printer is not displayed in the 
[Printers and Faxes] folder or [Printers] folder.

IMPORTANT
If the icon for this printer is displayed, be sure to delete it. Unless you delete the 
icon, you cannot install the printer driver again. 
To delete the icon for this printer, right-click it, and then select [Delete] from the 
pop-up menu.

8 Restart Windows.

IMPORTANT
After the printer driver of this printer is uninstalled, the [Program Compatibility 
Assistant] dialog box may appear on the screen.

Even if the [Program Compatibility Assistant] dialog box appears, the uninstallation 
of the printer driver is completed properly. Click [This program installed correctly].

NOTE
If you could not uninstall the printer driver, see "If Uninstallation Fails," on p. 8-42.
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CHAPTER

5
Basic Usage of the Printer
This chapter describes basic usage of the printer.
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Printing from an Application
After installing the printer driver, you can now print jobs on the printer.

This section describes the procedure for printing from an application, taking Adobe 
Reader 7.0 as an example.

NOTE
• For details on the procedures for installing the printer driver, see "Installing the Printer 

Driver," on p. 4-5.
• The printing procedure may differ depending on the application you are using.

1 Load paper in the paper cassette or multi-purpose tray.

NOTE
For details on the procedure for loading paper, see "Chapter 3 Paper Loading and 
Output Tray".

2 Open the PDF file to be printed using Adobe Reader.

3 Select [Print] from the [File] menu in the application.
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4 Select the name of this printer for [Name] or [Printer Name] aaaa, 
and then specify the printing preferences bbbb.

NOTE
The printer name displayed in this dialog box can be changed in the [Printers and 
Faxes] folder (the [Printers] folder for Windows 2000/Vista).

5 Click [Properties].

a

b
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6 Display the [Page Setup] sheet aaaa, then from [Page Size], 
select the page size of the document created by an 
application bbbb.

7 Select the size of the loaded paper in [Output Size] as needed.

Leave the setting at [Match Page Size] if the page size specified for [Page Size] 
and the size of the paper loaded in the paper source are the same, because 
there is no need to change the setting in this case.

IMPORTANT
The print will be automatically reduced or enlarged to fit on the page when the 
settings for [Page Size] and [Output Size] are different.

a

b
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8 Make sure that the settings for [Output Size] and [Register 
Paper Sizes]* match when printing from the paper cassette.
* The setting located in the [Cassette Settings] dialog box in the Printer Status Window

NOTE
Display the [Cassette Settings] dialog box using the following procedure.

1. Click [ ] (Display Printer Status Window) in locations such as in the [Page 
Setup] sheet.

2. From the [Options] menu, select [Device Settings] ➞ [Cassette Settings].

9 Display the [Paper Source] sheet aaaa, then select [Paper 
Source] bbbb.

NOTE
If [Paper Selection] is set to a setting other than [Same Paper for All Pages], the 
setting for [Paper Source] is changed as follows. Specify the same setting as for 
[Paper Source].
- [First Page]
- [Second Page]
- [Cover Page]
- [Other Pages]
- [Last Page]

a

b
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10 Select the type of the loaded paper in [Paper Type].

NOTE
Specify the setting according to the paper type as follows.

*1 If paper curls excessively when printed with [Plain Paper] selected, select [Plain Paper L].

*2 When printing Index Card or envelopes, the printer automatically applies the appropriate print mode
to each type by specifying [Output Size] in the [Page Setup] sheet.

Paper Type Setting for [Paper Type] in the Printer Driver

Plain 
Paper

60 - 89 g/m2
[Plain Paper L]*1

[Plain Paper]

Heavy 
Paper

90 - 120 g/m2 [Heavy Paper 1]

121 - 149 g/m2 [Heavy Paper 2]

150 - 163 g/m2 [Heavy Paper 3]

Transparency [Transparency]

Label [Label]

Index Card *2

Envelope *2
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11 Specify the other printing preferences in the [Page Setup], 
[Finishing], [Paper Source], and [Quality] sheets as needed.

NOTE
For more details on the settings, see Help. For details on methods for displaying 
Help, see "How to Use Help," on p. 5-24.

12 Confirm the settings, then click [OK].

The [Print] dialog box reappears.

NOTE
• It is recommended that you confirm the contents of the [Page Setup] sheet and the 

[Paper Source] sheet each time you print.
• The settings that are specified here apply only to jobs to be printed from the same 

application. Exiting the application resets the changed settings to the default 
settings.
For details on the procedure for changing the default values for printing 
preferences, see "Changing the Default Values for Printing Preferences," on p. 5-8.

13 Click [OK].

The printer starts printing.

NOTE
• If you have any problems with printing, see "Chapter 8 Troubleshooting".
• "Chapter 6 Using the Various Printing Functions" describes how to use the various 

functions of the printer and printer driver. By specifying the settings for the printer 
and printer driver for each job, you can make the best use of the printer and its 
functions.
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Changing the Default Values for Printing Preferences
The printing preferences that are specified in "Printing from an Application" (See p. 
5-2) apply only to jobs to be printed from the same application. Exiting the 
application resets the changed settings to the default settings.

You can change the default values for printing preferences which apply to all jobs 
using the following procedure.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other Hardware]
➞ [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printer].

2 Right-click the icon for this printer, then select [Printing 
Preferences] from the pop-up menu.

Windows 2000

Windows XP Professional Windows Server 2003

Windows XP Home Edition

Windows Vista
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3 Specify the default value for printing preferences in the [Page 
Setup], [Finishing], [Paper Source], and [Quality] sheets.

NOTE
For more details on the settings, see Help. For details on methods for displaying 
Help, see "How to Use Help," on p. 5-24.

4 Confirm the settings, then click [OK].

The [Printers and Faxes] folder or the [Printers] folder reappears.

The default values for printing preferences are now changed.

NOTE
"Chapter 6 Using the Various Printing Functions" describes how to use the various 
functions of the printer and printer driver. By specifying the settings for the printer 
and printer driver for each job, you can make the best use of the printer and its 
functions.
5-9Changing the Default Values for Printing Preferences
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2-sided Printing
This printer is equipped with a function that can perform automatic 2-sided printing.

Plain paper and heavy paper (90 - 120 g/m2) of A4, Legal, and Letter sizes can be 
used for automatic 2-sided printing.

By using the multi-purpose tray, you can perform manual 2-sided printing (printing 
the other side of previously printed paper) on paper unavailable for automatic 
2-sided printing.

IMPORTANT
• You cannot perform automatic 2-sided printing on heavy paper (121 - 163 g/m2), 

transparencies, labels, Index Card, and envelopes.
• During automatic 2-sided printing, do not touch the paper until it is output to the 

face-down output tray completely. The paper is first output partially after the front side is 
printed, and then it is fed again to be printed on the reverse side.

• Be sure to close the output selection cover before performing automatic 2-sided printing.

NOTE
In cases such as where the last page for the 2-sided printing is 1-sided printing, 
specifying the following setting allows you to print faster than normal 2-sided printing.

1. Click [Finishing Details] in the [Finishing] sheet.
2. Click [Advanced Settings] in the [Finishing Details] dialog box.
3. Select the [Print Last Page in 1-sided Mode when 2-sided Printing is Set] check 

box.
However, when performing 2-sided printing on punched paper or previously printed 
paper, the orientation or printing surface of the last page may differ from other 
pages. In this case, clear the check box.

Automatic 2-sided Printing

1 Load paper in the multi-purpose tray or paper cassette.

NOTE
On automatic 2-sided printing, the reverse side of the paper is printed first, 
therefore the paper should be loaded in the opposite orientation to that for 1-sided 
printing. If printing on such paper with letterheads, in which faces and directional 
orientations are specified,  see "Paper Loading Orientation" (p. 3-49) and load the 
paper in the proper orientation.
5-10 2-sided Printing
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2 Open the duplex unit cover.

Holding the opening at the center of the duplex unit cover, open it gently.

3 Set the blue paper size switch lever (A) to the appropriate 
position according to the paper size for automatic 2-sided 
printing.

For A4 size, draw the paper size switch lever toward you.
For Letter or Legal size, push the paper size switch lever into the printer.

IMPORTANT
When performing automatic 2-sided printing, be sure to confirm the paper size 
switch lever is set to the appropriate position. If the lever is not set to the 
appropriate position, this may result in misfeeds or paper jams.

LTR
LGLA4

A4
LTR
LGL

(A)

(A)
5-112-sided Printing
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4 Close the duplex unit cover.

Holding the opening at the center of the duplex unit cover, close it gently and 
firmly.

5 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

6 Select the name of this printer, then click [Properties] or 
[Preferences].
5-12 2-sided Printing
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7 Display the [Page Setup] sheet aaaa, then from [Page Size], 
select the page size of the document created by an 
application bbbb.

8 Select the size of the loaded paper in [Output Size] as needed.

Leave the setting at [Match Page Size] if the page size and the size of the paper 
loaded in the paper source are the same, because there is no need to change 
the setting in this case.

IMPORTANT
The print will be automatically reduced or enlarged to fit on the page when the 
settings for [Page Size] and [Output Size] are different.

a

b

5-132-sided Printing



B
as

ic
 U

sa
ge

 o
f t

he
 P

rin
te

r

5

9 Display the [Finishing] sheet aaaa, then select [2-sided Printing] 
in [Print Style] bbbb.

10 Display the [Paper Source] sheet aaaa, then select [Paper 
Source] bbbb.

NOTE
If [Paper Selection] is set to a setting other than [Same Paper for All Pages], the 
setting for [Paper Source] is changed as follows. Specify the same setting as for 
[Paper Source].
- [First Page]
- [Second Page]
- [Other Pages]
- [Last Page]

a

b

a

b

5-14 2-sided Printing
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11 Select the type of the loaded paper in [Paper Type].

NOTE
Specify the setting according to the paper type as follows.

* If paper curls excessively when printed with [Plain Paper] selected, select [Plain Paper L].

12 Confirm the settings, then click [OK].

The [Print] dialog box reappears.

Paper Type Setting for [Paper Type] in the Printer Driver

Plain Paper (60 - 89 g/m2)
[Plain Paper L]*

[Plain Paper]

Heavy Paper (90 - 120 g/m2) [Heavy Paper 1]
5-152-sided Printing
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13 Click [OK] or [Print].

The printer starts printing.

 

Manual 2-sided Printing
Since this printer can print the other side of previously printed paper, you can print 
both sides of the paper unavailable for automatic 2-sided printing.

1 In the multi-purpose tray, load paper whose other side is 
previously printed.

NOTE
For details on the procedure for loading paper, see "Paper Loading Orientation," on 
p. 3-49.

2 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

3 Select the name of this printer, then click [Properties] or 
[Preferences].
5-16 2-sided Printing



B
as

ic
 U

sa
ge

 o
f t

he
 P

rin
te

r

5

4 Display the [Page Setup] sheet aaaa, then from [Page Size], 
select the page size of the document created by an 
application bbbb.

5 Select the size of the loaded paper in [Output Size] as needed.

Leave the setting at [Match Page Size] if the page size and the size of the paper 
loaded in the multi-purpose tray are the same, because there is no need to 
change the setting in this case.

IMPORTANT
The print will be automatically reduced or enlarged to fit on the page when the 
settings for [Page Size] and [Output Size] are different.

a

b

5-172-sided Printing
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6 Display the [Paper Source] sheet aaaa, then select 
[Multi-purpose Tray] in [Paper Source] bbbb.

7 Select the type of the loaded paper in [Paper Type].

a

b

5-18 2-sided Printing
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NOTE
Specify the setting according to the paper type as follows.

*1 If paper curls excessively when printed with [Plain Paper] selected, select [Plain Paper L].

*2 If printing Index Card, the printer automatically applies the appropriate print mode to Index Card by
specifying [Output Size] in the [Page Setup] sheet.

8 Confirm the settings, then click [OK].

The [Print] dialog box reappears.

9 Click [OK] or [Print].

The printer starts printing.

Paper Type Setting for [Paper Type] in the Printer Driver

Plain 
Paper

60 - 89 g/m2
[Plain Paper L]*1

[Plain Paper]

Heavy 
Paper

90 - 120 g/m2 [Heavy Paper 1]

121 - 149 g/m2 [Heavy Paper 2]

150 - 163 g/m2 [Heavy Paper 3]

Index Card *2
5-192-sided Printing



B
as

ic
 U

sa
ge

 o
f t

he
 P

rin
te

r

5

Canceling a Print Job
This printer allows you to cancel a print job using any one of the following methods.

• Using the print queue (See p. 5-20)

• Using the Printer Status Window (See p. 5-22)

• Using the  (Cancel Job) key (See p. 5-23)

NOTE
If the optional network board is installed, you can also cancel a print job from the Remote 
UI (the software that allows you to manage the printer using a web browser). 
For details on the procedure for canceling a print job using the Remote UI, see "Chapter 
3 Various Functions of the Remote UI," in Remote UI Guide.

Canceling a Print Job Using the Print Queue

1 Display the Printer Status Window.

For details on methods for displaying the Printer Status Window, see "Displaying 
the Printer Status Window," on p. 5-35.

2 Click [ ] (Print Queue).
5-20 Canceling a Print Job
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The print queue is displayed.

NOTE
• You can also display the print queue using the following procedure.

1. Display the [Printers and Faxes] folder or the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other
Hardware] ➞ [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printer].

2. Double-click the icon for this printer.
• For details on the print queue, see Windows Help.

3 Right-click the job that you want to cancel, then select 
[Cancel] from the pop-up menu.

NOTE
• Another user's job is not displayed. 

However, all the jobs are displayed on the print server if the printer is shared on a 
network.

• This printer allows you to operate jobs in the print queue until they are completed.

Windows 2000

Windows XP Professional Windows Server 2003

Windows XP Home Edition

Windows Vista
5-21Canceling a Print Job
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4 Clicking [Yes] cancels the print job.

Canceling a Print Job Using the Printer Status Window

1 Display the Printer Status Window.

For details on methods for displaying the Printer Status Window, see "Displaying 
the Printer Status Window," on p. 5-35.

2 Clicking [ ] (Cancel Job) cancels the print job.

NOTE
While another user's job is being printed, you cannot cancel the job. 
However, you can cancel the print job from the print server if the printer is shared 
on a network.
5-22 Canceling a Print Job
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Canceling a Print Job Using the Cancel Job Key
When you cannot print because an error is occurring with another user's job (when 
you cannot delete another user's job in the Printer Status Window on your 
computer), use the  (Cancel Job) key to cancel the job.

1 Pressing the  (Cancel Job) key cancels the job.

The  (Cancel Job) indicator (orange) is on while you are pressing the key, and 
the job cancel process starts after you release the key. The  (Cancel Job) 
indicator (orange) blinks while a job is in the cancellation process.

IMPORTANT
• You cannot cancel the following pages or jobs.

- Pages of which data has been received already
- Jobs of which print copy is one sheet of paper

• If the job when the key is pressed and the job when the key is released are 
different, both the jobs cannot be canceled.

• Depending on the settings for the [Settings of the Cancel Job Key] dialog box in the 
Printer Status Window, you may not be able to cancel a job. For more details, see 
"[Device Settings] Menu," on p. 5-37.
5-23Canceling a Print Job
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How to Use Help
For details on using the printer driver or the Printer Status Window, see the 
instructions in Help by displaying it using the following procedure.

1 Click [Help].

When displaying Help from the Printer Status Window, select [Help Topics] from 
the [Help] menu.
5-24 How to Use Help
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2 Display the option you would like information on.
• Displaying the option you would like information on with Contents (See p. 5-25)
• Displaying the option you would like information on with Index (See p. 5-26)
• Retrieving a word or phrase included in Help and displaying the option you 

would like information on (See p. 5-27)

● Displaying the option you would like information on with Contents

Click [Contents] a, then click the title of the option you would like information on 
b.

a

b

5-25How to Use Help



B
as

ic
 U

sa
ge

 o
f t

he
 P

rin
te

r

5

● Displaying the option you would like information on with Index

1. Click [Index] a, then enter a keyword for the option you would like information on b.

2. Double-click the title of the option you would like information on.

a
b

5-26 How to Use Help
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● Retrieving a word or phrase included in Help and displaying the 
option you would like information on

1. Click [Search] a, then enter a word or phrase related to the option you would like 
information on b.

2. Click [List Topics].

a

b

5-27How to Use Help
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3. Double-click the title of the desired topic in the displayed list.
5-28 How to Use Help
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This section describes the procedures for installing the manuals included in the 
CD-ROM supplied with the printer on the computer you are using or uninstalling 
them.

Installing the Manuals
Install the manuals included in the CD-ROM supplied with the printer on your 
computer using the following procedure.

1 Insert the supplied "LBP3310 User Software" CD-ROM into 
the CD-ROM drive.

If the CD-ROM is already in the drive, eject the disk and re-insert it into the drive.

IMPORTANT
• If you are using Windows Vista and the [AutoPlay] dialog box appears, click [Run 

AUTORUN.EXE].
• If CD-ROM Setup does not appear, display it using the following procedures. (The 

CD-ROM drive name is indicated as "D:" in this manual. The CD-ROM drive name 
may differ depending on the computer you are using.)
- If you are using an operating system other than Windows Vista, select [Run] from 

the [Start] menu, enter "D:\English\MInst.exe", and then click [OK].
- If you are using Windows Vista, enter "D:\English\MInst.exe" in [Start Search] 

under the [Start] menu, and then press the [ENTER] key on your keyboard.

NOTE
If you are using Windows Vista and the [User Account Control] dialog box appears, 
click [Allow].
5-29Manuals
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2 Click [Custom Installation].

3 Clear the [Printer Driver] check box aaaa, then click [Install] bbbb.

4 Confirm the contents, then click [Yes].

Installation of the instruction manuals starts.

a

b

5-30 Manuals
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5 When the installation completion screen appears, click [Next].

6 Click [Exit].

The installation of the manuals is completed.
5-31Manuals
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You can take the CD-ROM out of the CD-ROM drive after the installation is 
completed.

Uninstalling the Manuals
The procedure for uninstalling the manuals varies depending on your operating 
system. See the following according to your operating system.

• For Windows 2000/XP/Server 2003/Vista (32-bit) (See p. 5-33)

• For Windows XP/Server 2003/Vista (64-bit) (See p. 5-33)

IMPORTANT
If the manuals were installed with administrator rights, a user without administrator rights 
cannot uninstall the manuals. Be sure to log on as a user with administrator rights before 
the uninstallation. 
If you are not sure about the permissions, ask your computer administrator.

NOTE
If you are not sure whether you are using 32-bit Windows Vista or 64-bit Windows Vista, 
see "Checking the Processor Version of Windows Vista," on p. 10-8.

Procedures for displaying the manuals

To see the installed manuals, perform either of the following procedures.

- Double-click [LBP3310 Online Manuals] created on the desktop.

- Select [Canon LBP3310] - [LBP3310 Online Manuals] added to [All 
Programs] ([Programs] for Windows 2000) under the [Start] menu.
5-32 Manuals
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For Windows 2000/XP/Server 2003/Vista (32-bit)
Uninstalling the printer driver can also uninstall the manuals. For details on 
uninstalling the printer driver, see "Uninstalling the Printer Driver," on p. 4-69.

If you want to uninstall only the manuals without uninstalling the printer driver, 
delete the following files and folders.

• "\Program Files\Canon\LBP3310"

- "Manuals" folder

• Right-click [Canon LBP3310] in [All Programs] ([Programs] for Windows 2000) 
under the [Start] menu, then select [Delete] from the pop-up menu.

• Desktop

- [LBP3310 Online Manuals] (Shortcut for [Index.pdf])

NOTE
If you are using Windows Vista and the [Destination Folder Access Denied] dialog box 
appears, click [Continue]. (If the [User Account Control] dialog box appears, click 
[Continue].)

For Windows XP/Server 2003/Vista (64-bit)
The manuals are not uninstalled by uninstalling the printer driver. If you want to 
uninstall the manuals, delete the following files and folders.

• "\Program Files (x86)\Canon\LBP3310"

- "Manuals" folder

• Desktop

- [LBP3310 Online Manuals] (Shortcut for [Index.pdf])

If you want to uninstall only the manuals without uninstalling the printer driver, 
perform the following operation also.

• Right-click [Canon LBP3310] in [All Programs] under the [Start] menu, then select 
[Delete] from the pop-up menu.

NOTE
If the [Destination Folder Access Denied] dialog box appears, click [Continue]. (If the 
[User Account Control] dialog box appears, click [Continue].)
5-33Manuals
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Printer Status Window
The Printer Status Window shows the printer status (such as the operation status 
and job information) with messages, animations, and icons.

You can perform the following operations using the Printer Status Window. If you 
find any problems with the printer, check the Printer Status Window.

• You can check the contents and remedies for the problem when an error has 
occurred in the printer or while printing is not performed. (See p. 8-25)

• You can cancel a job. (See p. 5-22)

• You can check information (such as the user name and document name) about 
the current print job.

Functions on the Printer Status Window
For more details on operations of the Printer Status Window, see Help. For details 
on methods for displaying Help, see "How to Use Help," on p. 5-24.

■ Menu Bar
[Job] Menu You can cancel a job or resume a job which is paused during printing 

for some reason.

[Options] Menu Allows you to change the preferences for the Printer Status Window 
as well as clean the fixing roller of the printer.

[Help] Menu Allows you to search for the desired items using keywords and 
displays [About] (the version information) of the Printer Status 
Window.

[Refresh] Button

[Message Area] (Auxiliary)

[Resolve Error] Button

[Progress Bar]

[Cancel Job] Button

Menu Bar

[Icon]

[Print Queue] Button

[Message Area]

[Animation Area]

[Job Information Area]

[Status Bar]
5-34 Printer Status Window
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■ Other Functions

Displaying the Printer Status Window
There are the following two ways to display the Printer Status Window.

• Click [ ] (Display Printer Status Window) in locations such as in the [Page 
Setup] sheet in the printer driver.

[Icon] Displays the printer status.

[Message Area] Displays the current printer status with a short message.

[Message Area] (Auxiliary) Displays additional information if an error or other such event 
occurs.

[Animation Area] Displays the printer status using an animated graphic. The 
background color changes from blue (normal) to orange when user 
action is required, or to red when a warning is issued.

[Print Queue] Button Displays the print queue, a function of Windows. For details on the 
print queue, see Windows Help.

[Refresh] Button Obtains the printer status and refreshes the Printer Status Window 
display.

[Resolve Error] Button You can resume a job when it is paused during printing for some 
reason.

[Job Information Area] Displays information about the job.

[Progress Bar] Indicates the progress of the current job by showing the number of 
printed pages and the bar growth.

[Cancel Job] Button Cancels the current job. While another user's job is being printed, 
the [Cancel Job] button is displayed in gray.

[Status Bar] Displays the device to which the printer is connected.
5-35Printer Status Window
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• Click the icon for the Printer Status Window displayed in the Windows taskbar, 
then click the printer name.

If you start printing or an error occurs when the Printer Status Window is not 
displayed, it starts in the form of an icon automatically. Clicking this icon can display 
the Printer Status Window.

* Depending on the setting for [Display Settings] in the [Preferences (Users)] dialog box or the [Preferences 
(Administrators)] dialog box in the Printer Status Window, it starts as follows.

- If [Only when Errors Occur] is specified: The Printer Status Window starts in the form of an icon only when an 
error occurs.

- If [Not Display Automatically] is specified: The Printer Status Window does not start automatically.

[Preferences (Users)] Dialog Box
Select [Preferences (Users)] from the [Options] menu to display the [Preferences 
(Users)] dialog box. Specify the display settings for the Printer Status Window in the 
[Preferences (Users)] dialog box.

For more details, see Help. For details on methods for displaying Help, see "How to 
Use Help," on p. 5-24.

[Preferences (Administrators)] Dialog Box
Select [Preferences (Administrators)] from the [Options] menu to display the 
[Preferences (Administrators)] dialog box. The [Preferences (Administrators)] dialog 
box allows you to specify the settings such as the following settings.

• Selecting whether the print server sets the display settings of all client computers 
for the Printer Status Window, if the printer is shared on a network

• Selecting the timing of monitoring the printer status

For more details, see Help. For details on methods for displaying Help, see "How to 
Use Help," on p. 5-24.

IMPORTANT
You cannot display the [Preferences (Administrators)] dialog box without administrator 
rights for the printer (For more details, ask your computer administrator.).
5-36 Printer Status Window
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[Utility] Menu
The [Utility] menu in the [Options] menu allows you to clean the fixing roller of the 
printer and performs Configuration Page Print.

■ [Cleaning]
If the front or back of the printed paper has smudge marks, the fixing roller needs to be 
cleaned. Print quality deterioration can be prevented by cleaning the fixing roller.
For more details, see "Cleaning the Fixing Roller," on p. 7-18.

■ [Configuration Page Print]
Prints the availability of the optional accessories for the printer, settings for [Device 
Settings] in the [Options] menu, and current printer status such as the total number of 
print pages.
For more details, see "Confirming the Printer Features," on p. 8-56.

■ [Network Status Print] (Only if the network board is installed)
Prints the version of the optional network board as well as the TCP/IP settings.
For more details, see "Chapter 4 Troubleshooting" in Network Guide.

[Device Settings] Menu
The [Device Settings] menu in the [Options] menu allows you to specify the settings 
related to the printer, such as specifying the size of the paper loaded in the paper 
cassette as well as specifying the network settings.

■ [Cassette Settings]
Specifies the size of the paper loaded in the paper cassette.
For details, see Step 6 and subsequent steps of "Loading Paper in the Paper Cassette," 
on p. 3-17.

■ [Settings of the Cancel Job Key]
The job that can be canceled using the  (Cancel Job) key on the printer is specified. 
The settings in this dialog box applies to the jobs of all users.

IMPORTANT
The [Settings of the Cancel Job Key] dialog box allows you to specify the setting for the 

 (Cancel Job) key. 
You can cancel jobs from the Printer Status Window or the Remote UI (only if the network 
board is installed) regardless of the setting for the [Settings of the Cancel Job Key] dialog 
box. 
For details on the Remote UI, see "Remote UI Guide".

■ [Network Settings] (Only if the network board is installed)
Specify the network settings for the printer.
For more details, see Help. For details on methods for displaying Help, see "How to Use 
Help," on p. 5-24.
5-37Printer Status Window
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[Remote UI] (Only If the Network Board Is Installed)
Select [Remote UI] from the [Options] menu to start the Remote UI. The Remote UI 
is software that allows you to manage the printer using a web browser. For details 
on the Remote UI, see "Remote UI Guide". 

IMPORTANT
You cannot select [Remote UI] if the printer and computer cannot communicate via a 
network.

[Refresh]
Selecting [Refresh] from the [Options] menu obtains the latest printer status and 
refreshes the Printer Status Window display.

You can obtain the same result by clicking [ ] (Refresh) in the Printer Status 
Window.

[Resolve Error]
You can resume a job which is paused during printing for some reason by selecting 
[Resolve Error] from the [Job] menu. However, the job resumed by selecting 
[Resolve Error] may cause unexpected print results.

[Resolve Error] is disabled in any of the following cases.

• When the job is paused due to a printer error such as a paper jam and paper-out 
condition

• When another user's job is paused
([Resolve Error] is enabled on the print server if the printer is shared on a 
network.)

You can obtain the same result by clicking [ ] (Resolve Error) in the Printer 
Status Window.

IMPORTANT
If the message <Insufficient Disk Space> is displayed in the Printer Status Window, 
delete unnecessary files, and then select [Resolve Error].
5-38 Printer Status Window
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[Cancel Job]
Selecting [Cancel Job] from the [Job] menu cancels the current job.

While another user's job is being printed, you cannot use [Cancel Job].

([Cancel Job] is enabled on the print server if the printer is shared on a network.)

You can obtain the same result by clicking [ ] (Cancel Job) in the Printer Status 
Window.

[Print Queue]
Selecting [Print Queue] from the [Job] menu displays the print queue, a function of 
Windows. In the print queue, you can perform operations such as a job checking 
and job canceling. For details on the print queue, see Windows Help.

You can obtain the same result by clicking [ ] (Print Queue) in the Printer Status 
Window.
5-39Printer Status Window
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Using the Various Printing Functions
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This printer allows you to print in a variety of ways as follows.

■ Printing Multiple Pages on One Sheet (See p. 6-19)
Multiple pages can be printed on one sheet of paper.

■ Printing with Scaling (See p. 6-22)
Specify this option when A4 size data is reduced in size and printed on B5 size paper, or 
B5 size data is enlarged and printed on A4 size paper. You can specify an arbitrary 
scaling.
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■ Poster Printing (See p. 6-25)
You can magnify and divide a single page image to print it out on multiple sheets of paper. 
You can make one large poster by joining these printouts together.

■ Watermark Printing (See p. 6-27)
You can superimpose watermarks (such as [COPY] and [DRAFT]) over the documents 
created by an application.

■ Printing Borders and Printing Date (See p. 6-31)
You can print with borders, printing date, and/or page numbers, etc.

13 June 2007

USER 011
6-4 Utilizing a Variety of Options for Printing
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■ 2-sided Printing (See p. 5-10)
You can print a 2-page document on both sides of one sheet of paper.

■ Booklet Printing (See p. 6-33)
You can make a booklet by folding printouts in half.
For example, when making a booklet of 8 pages, 2 sheets are used in total because 2 
pages are printed on each side of paper.
A booklet can also be made by specifying the number of sheets to be folded in half and 
binding the printouts if you want to perform booklet printing of a large amount of pages.

■ Printing with a Gutter (See p. 6-35)
You can specify a gutter for paper to be printed.
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■ Selecting the Paper Output Method (See p. 6-37)
You can select the paper output method before printing.

• If you do not specify the paper output method
Printouts of a complete job are grouped.
For example, if you are printing three copies of a three-page document, printouts of a 
complete job are grouped, arranged in this page order: 1, 1, 1, 2, 2, 2, 3, 3, 3.

• If you collate the printouts
Printouts of a complete job are collated.
For example, if you are printing three copies of a three-page document, printouts of a 
complete job are collated, arranged in this page order: 1, 2, 3, 1, 2, 3, 1, 2, 3.

■ Print with Upper Left of Sheet as Starting Point (See p. 6-39)
Since printing is usually performed with the upper-left 5 mm margin (10 mm for envelopes 
and Index Card) as the starting point, a certain portion (lower right) may be missing when 
printing data with no margin. In this case, you can extend the printable area to near the 
edges of the paper by printing with the upper-left 0 mm margin as the starting point.
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■ Printing with the Data Rotated 180 Degrees (See p. 6-41)
You can print with the image rotated 180 degrees. This option is useful for printing 
envelopes and Index Card that can be fed only in specific orientations.

■ Selecting Paper for Each Page (See p. 6-43)
You can select paper for each page, such as for printing the front cover on a different type 
of paper.

■ Smoothing Out Rough-Textured Images (See p. 6-45)
Specify this option when printing with this kind of low-resolution image data being 
smoothed out.

■ Printing with Toner Density Adjusted (See p. 6-47)
You can print with toner density adjusted.
6-7Utilizing a Variety of Options for Printing
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■ Printing with Brightness and Contrast Adjusted (See p. 6-49)
You can print with the brightness and contrast adjusted.

■ Printing a Grayscale Sample (See p. 6-51)
You can print an adjusted grayscale sample.
6-8 Utilizing a Variety of Options for Printing
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■ Editing Jobs with PageComposer (See p. 6-59)
You can combine two jobs into one as well as change the job settings for the combined 
job. You can edit jobs of different applications. You can also preview the job.

1 1 1 2

1 2
2 2

Job A Job B Job
6-9Utilizing a Variety of Options for Printing
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Various Sheets in the Printer Driver
You can switch among the sheets in the printer driver by clicking the tabs across the 
top of the dialog box.
This section describes the sheets to be displayed.

NOTE
The [General], [Sharing], [Ports], [Advanced], [Color Management], and [Security] sheets 
in the printer driver are displayed by Windows. For details on these sheets, see Windows 
Help.

- [Page Setup] Sheet (See p. 6-11)
- [Finishing] Sheet (See p. 6-12)
- [Paper Source] Sheet (See p. 6-13)
- [Quality] Sheet (See p. 6-14)

Displaying from an application

- [Page Setup] Sheet (See p. 6-11)
- [Finishing] Sheet (See p. 6-12)
- [Paper Source] Sheet (See p. 6-13)
- [Quality] Sheet (See p. 6-14)

Displaying from the printer icon
(If selecting [Printing Preferences])

- [Device Settings] Sheet (See p. 6-15)
- [Profile] Sheet (See p. 6-16)

Displaying from the printer icon
(If selecting [Properties])
6-10 Various Sheets in the Printer Driver
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[Page Setup] Sheet

NOTE
For more details on the settings, see Help. For details on methods for displaying Help, 
see "How to Use Help," on p. 5-24.

     indicates the reference page 
for the setting procedure.

p. 6-19 p. 6-25

p. 6-23

p. 6-17

p. 6-27

p. 6-29

p. 6-31

p.
6-11Various Sheets in the Printer Driver
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[Finishing] Sheet

NOTE
For more details on the settings, see Help. For details on methods for displaying Help, 
see "How to Use Help," on p. 5-24.

p. 6-33p. 6-35 p. 5-10

p. 6-33

p. 6-35

p. 6-17

p. 6-37

p. 6-39

p. 6-41

     indicates the reference page 
for the setting procedure.
p.
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[Paper Source] Sheet

NOTE
For more details on the settings, see Help. For details on methods for displaying Help, 
see "How to Use Help," on p. 5-24.

p. 6-43

p. 6-17

     indicates the reference page 
for the setting procedure.
p.
6-13Various Sheets in the Printer Driver
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[Quality] Sheet

NOTE
For more details on the settings, see Help. For details on methods for displaying Help, 
see "How to Use Help," on p. 5-24.

p. 6-51

p. 6-45

p. 6-47

p. 6-49

p. 6-49

     indicates the reference page 
for the setting procedure.
p.
6-14 Various Sheets in the Printer Driver
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[Device Settings] Sheet

NOTE
For more details on the settings, see Help. For details on methods for displaying Help, 
see "How to Use Help," on p. 5-24.
6-15Various Sheets in the Printer Driver
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[Profile] Sheet

NOTE
For more details on the settings, see Help. For details on methods for displaying Help, 
see "How to Use Help," on p. 5-24.
6-16 Various Sheets in the Printer Driver
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The current settings are displayed on Preview in the [Page Setup] sheet, the 
[Finishing] sheet, and the [Paper Source] sheet. Additionally, you can specify the 
settings for the printer driver by clicking Preview.

Depending on which icon on the upper left on Preview (  or ) is selected, the 
specifiable options vary.

■ When  is selected
You can specify the following settings according to the clicked position on Preview.

• [Binding Location]: Left-click an edge of the document image.
• [Page Layout]: Repeatedly left-click within the document image or right-click on Preview.
The use of the icon on the lower right on Preview is as follows.

Icon Use

By clicking the icon, you can switch the mode between [1-sided Printing] 
and [2-sided Printing].
6-17Preview
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■ When  is selected
You can specify the following settings according to the clicked position on Preview.

• [Paper Source]: Left-click a paper source image (the multi-purpose tray or paper 
cassette).

• [Finishing]: Right-click on Preview.

Also, if you have selected any one of the following in [Paper Selection], you can specify 
the paper source for each page.

• [Different for First, Others, and Last]
• [Different for First, Second, Others, and Last]
• [Different for Cover and Others]
If you want to switch the paper source automatically according to the size or type of paper 
to be printed, left-click [Auto] on the lower right on Preview.
6-18 Preview
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Multiple pages can be printed on one sheet of paper.

IMPORTANT
Make sure that [Spooling at Host] in the [Device Settings] sheet is set to [Auto] before 
printing. (See "Confirming the Setting for [Spooling at Host]," on p. 10-9)

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].
6-19Printing Multiple Pages on One Sheet
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3 Display the [Page Setup] sheet aaaa, then select the number of 
the pages to be printed on one sheet from [Page Layout] bbbb.

The number of pages that can be selected is 1, 2, 4, 6, 8, 9, or 16 (Pages per 
Sheet).

4 If you selected 2, 4, 6, 8, 9, or 16 (Pages per Sheet) in Step 3, 
[Page Order] appears. Specify how the pages are aligned.

a

b

6-20 Printing Multiple Pages on One Sheet



U
si

ng
 th

e 
V

ar
io

us
 P

rin
tin

g 
F

un
ct

io
ns

6

NOTE
The options under [Page Order] differ depending on the paper orientation or the 
number of pages to be printed on one sheet.

5 Confirm the settings, then click [OK].

The [Print] dialog box reappears.

6 Click [OK] or [Print].

The printer starts printing.
6-21Printing Multiple Pages on One Sheet
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Printing with Scaling
You can print with automatic scaling or arbitrary scaling.
The scale factor from 25 to 200 % can be specified.

Printing with Automatic Scaling

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].

3 Display the [Page Setup] sheet aaaa, then select [Page Size] bbbb.

a

b

6-22 Printing with Scaling
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4 Select the paper size in [Output Size].

The scaling factor will be set automatically according to the sizes selected in 
[Page Size] and [Output Size].

5 Confirm the settings, then click [OK].

The [Print] dialog box reappears.

6 Click [OK] or [Print].

The printer starts printing.

 

Printing with Arbitrary Scaling

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].

3 Display the [Page Setup] sheet, then select the page size in 
[Page Size].

4 Select the paper size in [Output Size].
6-23Printing with Scaling
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5 Select the [Manual Scaling] check box, then specify the value 
in the spin box.

6 Confirm the settings, then click [OK].

The [Print] dialog box reappears.

7 Click [OK] or [Print].

The printer starts printing.
6-24 Printing with Scaling
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You can magnify and divide a single page image to print it out on multiple sheets of 
paper. You can make one large poster by joining these printouts together.

IMPORTANT
Make sure that [Spooling at Host] in the [Device Settings] sheet is set to [Auto] before 
printing. (See "Confirming the Setting for [Spooling at Host]," on p. 10-9)

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].
6-25Poster Printing
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3 Display the [Page Setup] sheet aaaa, then select [Poster [N x N]] 
(N = 2, 3, 4) from [Page Layout] bbbb.

A layout image of the printed paper appears on Preview.

4 Confirm the settings, then click [OK].

The [Print] dialog box reappears.

5 Click [OK] or [Print].

The printer starts printing.

a

b

6-26 Poster Printing



Watermark Printing
6

U
si

ng
 th

e 
V

ar
io

us
 P

rin
tin

g 
F

un
ct

io
ns
You can superimpose watermarks (such as [COPY] and [DRAFT]) over the 
documents created by an application.
Additionally, you can add new watermarks as well as edit the added watermarks.

IMPORTANT
Make sure that [Spooling at Host] in the [Device Settings] sheet is set to [Auto] before 
printing or editing. (See "Confirming the Setting for [Spooling at Host]," on p. 10-9)

Watermark Printing

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].
6-27Watermark Printing
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3 Perform the following procedure.
a Display the [Page Setup] sheet.

b Select the [Watermark] check box.

c Select the character string to print as a watermark from the list on the right side of 
[Watermark] .

4 Confirm the settings, then click [OK].

The [Print] dialog box reappears.

5 Click [OK] or [Print].

The printer starts printing.

a

b
c
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Editing Watermarks

1 Perform the following procedure.
a Display the [Page Setup] sheet.

b Select the [Watermark] check box.

c Click [Edit Watermark].

2 Specify the options as needed.

a

b
c
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NOTE
• For more details on the settings, see Help. For details on methods for displaying 

Help, see "How to Use Help," on p. 5-24.
• When adding a new watermark, click [Add].
• You cannot change the settings for the default watermarks.

3 Confirm the settings, then click [OK].

The [Page Setup] sheet reappears.
6-30 Watermark Printing
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You can print with borders, printing date, and/or page numbers.

IMPORTANT
Make sure that [Spooling at Host] in the [Device Settings] sheet is set to [Auto] before 
printing. (See "Confirming the Setting for [Spooling at Host]," on p. 10-9)

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].

3 Display the [Page Setup] sheet aaaa, then click [Page Options] bbbb.

a

b
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4 Specify the options as needed.

NOTE
For more details on the settings, see Help. For details on methods for displaying 
Help, see "How to Use Help," on p. 5-24.

5 Confirm the settings, then click [OK].

The [Page Setup] sheet reappears.

6 Click [OK].

The [Print] dialog box reappears.

7 Click [OK] or [Print].

The printer starts printing.
6-32 Printing Borders and Printing Date



Booklet Printing
6

U
si

ng
 th

e 
V

ar
io

us
 P

rin
tin

g 
F

un
ct

io
ns
Booklet printing allows you to make a booklet by folding printouts in half.

For example, when making a booklet of 8 pages, 2 sheets are used in total because 
2 pages are printed on each side of paper.

Also, if you want to make a booklet of large amount of pages, you can make it by 
specifying the number of sheets to be folded in half and binding them.

IMPORTANT
• When performing booklet printing, be sure to confirm the paper size switch lever on the 

rear side of the printer is set to the appropriate position. If the lever is not set to the 
appropriate position, this may result in misfeeds or paper jams.
For details on the procedure for setting the paper size switch lever, see "Automatic 
2-sided Printing," on p. 5-10.

• Make sure that [Spooling at Host] in the [Device Settings] sheet is set to [Auto] before 
printing. (See "Confirming the Setting for [Spooling at Host]," on p. 10-9)

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].
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3 Perform the following procedure.
a Display the [Finishing] sheet.

b Select [Booklet Printing] for [Print Style].

c Click [Booklet].

4 Specify the options as needed.

NOTE
For more details on the settings, see Help. For details on methods for displaying 
Help, see "How to Use Help," on p. 5-24.

5 Confirm the settings, then click [OK].

The [Finishing] sheet reappears.

6 Click [OK].

The [Print] dialog box reappears.

7 Click [OK] or [Print].

The printer starts printing.

a

b c
6-34 Booklet Printing



Printing with a Gutter
6

U
si

ng
 th

e 
V

ar
io

us
 P

rin
tin

g 
F

un
ct

io
ns
You can specify a gutter for paper to be printed. Valid gutter values range from 0 to 
30 mm.

When a gutter is specified, the position of the page image is adjusted to make room 
for the gutter. At this point, you can select whether to reduce the image size to fit 
the remaining space.

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].

3 Perform the following procedure.
a Display the [Finishing] sheet.

b Select the edge on which the gutter is to be located in [Binding Location].

c Click [Gutter].

a

c

b
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4 Specify the options as needed.

NOTE
For more details on the settings, see Help. For details on methods for displaying 
Help, see "How to Use Help," on p. 5-24.

5 Confirm the settings, then click [OK].

The [Finishing] sheet reappears.

6 Click [OK].

The [Print] dialog box reappears.

7 Click [OK] or [Print].

The printer starts printing.
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Select a paper output method from the following options before printing.

• [Off]
Printouts of a complete job are grouped.
For example, if you are printing three copies of a three-page document, printouts 
of a complete job are grouped, arranged in this page order: 1, 1, 1, 2, 2, 2, 3, 3, 3.

• [Collate]
Printouts of a complete job are collated.
For example, if you are printing three copies of a three-page document, printouts 
of a complete job are collated, arranged in this page order: 1, 2, 3, 1, 2, 3, 1, 2, 3.

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].
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3 Display the [Finishing] sheet aaaa, then select the output method 
in [Finishing] bbbb.

4 Confirm the settings, then click [OK].

The [Print] dialog box reappears.

5 Click [OK] or [Print].

The printer starts printing.

a

b
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Since printing is usually performed with the upper-left 5 mm margin (10 mm for 
envelopes and Index Card) as the starting point, a certain portion (lower right) may 
be missing when printing data with no margin. In this case, you can extend the 
printable area to near the edges of the paper by printing with the upper-left 0 mm 
margin as the starting point.

IMPORTANT
• The edges of the printout may be partly missing depending on the property of the 

document to be printed.
• The function of [Print with Upper Left of Sheet as Starting Point] may be disabled 

depending on the application you are using.

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].
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3 Display the [Finishing] sheet aaaa, then click [Finishing Details] 
bbbb.

4 Select the [Print with Upper Left of Sheet as Starting Point] 
check box aaaa, then click [OK] bbbb.

The [Finishing] sheet reappears.

5 Click [OK].

The [Print] dialog box reappears.

6 Click [OK] or [Print].

The printer starts printing.

a

b

a

b
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You can print with the image rotated 180 degrees.

This option is useful for printing envelopes and Index Card that can be fed only in 
specific orientations.

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].

3 Display the [Finishing] sheet aaaa, then click [Finishing Details] 
bbbb.

a

b
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4 Select the [Rotate Print Data 180 Degrees] check box aaaa, then 
click [OK] bbbb.

The [Finishing] sheet reappears.

5 Click [OK].

The [Print] dialog box reappears.

6 Click [OK] or [Print].

The printer starts printing.

a

b
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You can select paper for each page, such as for printing the front cover on a 
different type of paper.

IMPORTANT
Make sure that [Spooling at Host] in the [Device Settings] sheet is set to [Auto] before 
printing. (See "Confirming the Setting for [Spooling at Host]," on p. 10-9)

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].

3 Display the [Paper Source] sheet aaaa, then select the pages for 
which paper is specified in [Paper Selection] bbbb.

a

b
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IMPORTANT
[Different for Cover and Others] can be selected only if [Print Style] in the 
[Finishing] sheet is set to [Booklet Printing].

4 Specify the paper source.

5 Confirm the settings, then click [OK].

The [Print] dialog box reappears.

6 Click [OK] or [Print].

The printer starts printing.
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If image data such as photographic images are enlarged in size in an application 
and printed, the printed images may look rough or jagged. You can smooth out this 
kind of low-resolution image data.

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].

3 Display the [Quality] sheet aaaa, then click [Details] bbbb.

a

b
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4 Select the [Enable Image Correction] check box aaaa, then click 
[OK] bbbb.

The [Quality] sheet reappears.

5 Click [OK].

The [Print] dialog box reappears.

6 Click [OK] or [Print].

The printer starts printing.

a

b
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You can print with toner density adjusted.

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].

3 Display the [Quality] sheet aaaa, then click [Details] bbbb.

a

b
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4 Adjust the toner density by dragging the [Toner Density] 
slider horizontally.

Move the slider to the right to make it darker and to the left to make it lighter.

5 Confirm the settings, then click [OK].

The [Quality] sheet reappears.

6 Click [OK].

The [Print] dialog box reappears.

7 Click [OK] or [Print].

The printer starts printing.
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You can print with the brightness and contrast adjusted.

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].

3 Perform the following procedure.
a Display the [Quality] sheet.

b Select the [Manual Grayscale Settings] check box.

c Click [Grayscale Settings].

a

b
c
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4 Display the [Grayscale Adjustment] sheet aaaa, then adjust the 
brightness and contrast for the print data bbbb.

Move the [Brightness] slider to the right to make it lighter and to the left to make it 
darker.
Move the [Contrast] slider to the right to make it higher and to the left to make it 
lower.

5 Confirm the settings, then click [OK].

The [Quality] sheet reappears.

6 Click [OK].

The [Print] dialog box reappears.

7 Click [OK] or [Print].

The printer starts printing.

You can print a sample with the brightness and contrast adjusted. For more details, see 
"Printing a Grayscale Sample," on p. 6-51.

a b
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You can print an adjusted grayscale sample. [Preview] is printed in the center of the 
paper, and this is surrounded by images where [Brightness] and [Contrast] are 
changed by 1 unit in each of the corresponding directions.

IMPORTANT
Make sure that [Spooling at Host] in the [Device Settings] sheet is set to [Auto] before 
printing. (See "Confirming the Setting for [Spooling at Host]," on p. 10-9)

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].
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3 Display the [Quality] sheet aaaa, then select the [Manual 
Grayscale Settings] check box and the [Print Grayscale 
Sample] check box bbbb.

IMPORTANT
When printing a grayscale sample, be sure to set [Page Layout] in the [Page Setup] 
sheet to [1 Page per Sheet].

4 Click [OK].

The [Print] dialog box reappears.

5 Click [OK] or [Print].

The grayscale sample is printed.

IMPORTANT
When you are finished with printing grayscale samples, clear the [Print Grayscale 
Sample] check box.

a

b
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Some printer driver settings that support various jobs are provided as the default 
"Profiles". You can perform printing with the most appropriate settings for your 
purpose by simply selecting the "Profile".

In addition to the default "Profiles", you can also add custom "Profiles".

NOTE
• Up to 50 "Profiles" for each user account can be added.
• If the printer name has been changed, any added "Profiles" cannot be used. To use the 

added "Profiles", change the printer name to its previous one.

Selecting a "Profile"

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].
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3 Select the desired "Profile" from the [Profile] list.

4 Click [OK].

The [Print] dialog box reappears.

5 Click [OK] or [Print].

The printer starts printing.
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Adding a "Profile"

1 In the [Page Setup], [Finishing], [Paper Source], and [Quality] 
sheets, specify the printer settings that you want to add.

2 Click [ ] (Add Profile).

3 Enter the name of the "Profile" in [Name].

[Icon] allows you to select the icon for the "Profile".
Enter any comments in [Comment] as needed.

NOTE
You can enter up to 31 characters for [Name] and up to 255 characters for 
[Comment].
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4 Confirm the printer settings in each sheet as needed.
1. Click [View Settings].

2. When [OK] is clicked, the [Add Profile] dialog box reappears.

5 Click [OK].

The Properties dialog box reappears.
Make sure that the name of the added "Profile" is in [Profile].

Editing a "Profile"
You can change information about an added "Profile" or export a "Profile" as a file.

1 Click [ ] (Edit Profile).
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2 Edit information about the "Profiles".

NOTE
For more details on the settings, see Help. For details on methods for displaying 
Help, see "How to Use Help," on p. 5-24.

3 Click [OK].

The Properties dialog box reappears.

Deleting a "Profile"
You can delete an added "Profile".

1 Click [ ] (Edit Profile).
6-57Using "Profiles"



U
si

ng
 th

e 
V

ar
io

us
 P

rin
tin

g 
F

un
ct

io
ns

6

2 From [Profile List], select the custom "Profile" that you want 
to delete aaaa and click [Delete] bbbb.

IMPORTANT
You can delete only custom "Profiles". You cannot delete the default "Profiles". 
Also, you cannot delete the "Profile" currently selected in each sheet.

3 Click [OK].

The Properties dialog box reappears.

a

b
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You can combine two jobs into one as well as change the job settings for the 
combined job. You can edit jobs of different applications.
You can also preview the job.

IMPORTANT
Make sure that [Spooling at Host] in the [Device Settings] sheet is set to [Auto] before 
printing. (See "Confirming the Setting for [Spooling at Host]," on p. 10-9)

1 Select [Print] from the [File] menu in the application.

The [Print] dialog box is displayed.

NOTE
Printing procedures vary depending on the application you are using. For details on 
the printing procedures, see the instruction manual supplied with the application.

2 Select the name of this printer, then click [Properties] or 
[Preferences].

3 Select [Edit and Preview] from [Output Method].
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4 Click [OK].

5 Specify the printing preferences in each sheet, then click 
[OK].

The [Print] dialog box reappears.

6 Click [OK] or [Print].

The list of jobs are displayed in the [Canon PageComposer] dialog box.
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7 Repeat Step 1 to 6 to edit the desired jobs.

8 Edit the jobs on the list in the [Canon PageComposer] dialog 
box.

NOTE
• For more details on the setting procedures for the [Canon PageComposer] dialog 

box, see Help for Canon PageComposer.
• If the [Edit and Preview] mode is selected and [ ] (Lock) is set as the default 

values for printing preferences, the [Canon PageComposer] dialog box appears 
each time you print.
For details on the procedure for changing the default values for printing 
preferences, see "Changing the Default Values for Printing Preferences," on p. 5-8.
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7
Routine Maintenance
This chapter describes the printer maintenance procedures, such as cartridge replacement 
and printer cleaning.
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Replacing the Toner Cartridge
This section describes how to replace or handle the toner cartridge, as well as 
precautions on storing it. 
Contact the store where you purchased the printer to obtain replacement toner 
cartridges.

IMPORTANT
A warning message does not appear on your computer even if the toner cartridge is 
reaching its lifetime. The case where white streaks appear on printed paper in 
longitudinal direction, or printed paper comes out faint or uneven can be used to estimate 
when the toner cartridge will need to be replaced. When you are replacing the toner 
cartridge, be sure to use a toner cartridge exclusively designed for this printer.

NOTE
• The lifetime of the toner cartridges (Canon Genuine Cartridges) designed for this printer 

is approximately 3,000 pages or 7,000 pages. The page counts are on the basis of "ISO/
IEC 19752"* when printing A4 size paper with the default print density setting. The level 
of toner consumption varies depending on the type of documents printed. If your average 
document contains a lot of diagrams, charts, or graphs, the life of the toner cartridge will 
be shorter as they consume more toner.
* "ISO/IEC 19752" is the global standard related to "Method for the determination of toner cartridge yield for 

monochromatic electrophotographic printers and multi-function devices that may contain printer 
components" issued by ISO (International Organization for Standardization).

• This section describes the procedure, taking the toner cartridge with its lifetime of 
approximately 3,000 pages (Canon Genuine Cartridges) as an example.
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Precautions on Replacing the Toner Cartridge

WARNING
Do not throw a used toner cartridge into open flames, as this may cause the 
toner remaining inside the cartridge to ignite, resulting in burns or a fire.

CAUTION
Take care not to allow the toner to come into contact with your hands or 
clothing, as this will dirty your hands or clothing. If your hands or clothing 
become stained with toner, wash them immediately with cold water. Washing 
them with warm water may fix the toner and make it not possible to remove the 
toner stains.

IMPORTANT
• Dispose of the packing materials according to local regulations.
• Be sure to use only the toner cartridges exclusively designed for this printer.

NOTE
• For details on handling the toner cartridge, see "Precautions for Handling the Toner 

Cartridge," on p. 7-15.
• The packing materials may be changed in form or placement, or may be added or 

removed without notice.

Before Replacing the Toner Cartridge
Toner cartridges are consumable products. If toner is not sufficient, the following 
symptoms occur.

• White streaks appear on the printed paper in longitudinal direction.

• The printed paper comes out faint or uneven.

If this type of symptom occurs, perform the following procedure before replacing the 
toner cartridge. You may be able to print for a while until the toner is used up 
completely.
7-3Replacing the Toner Cartridge
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1 If you are using the multi-purpose tray, close it.

2 Open the front cover.

While pressing the open button on the top of the front cover a, open it gently b.

b

a
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3 Remove the toner cartridge from the printer.

IMPORTANT
Do not touch the high-voltage contact (A) or the electrical contacts (B) shown in the 
figure, as this may result in damage to the printer.

(A)

(B)
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4 Hold the toner cartridge as shown in the figure and shake it 
gently 5 or 6 times to evenly distribute the toner inside the 
cartridge.

Be careful not to spill the toner.

IMPORTANT
• If toner is not distributed evenly, this may result in deterioration in print quality.
• Be sure to shake the toner cartridge gently. If you do not shake the cartridge gently, 

toner may spill out.

5 Hold the toner cartridge properly with the arrowed side facing 
up as shown in the figure.
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6 Install the toner cartridge.

Push the toner cartridge into the printer firmly until it touches the back of the 
printer while aligning (A) on both sides of the toner cartridge with the toner 
cartridge guides inside the printer.

7 Close the front cover.

Close the front cover gently and firmly.

(A)

Side View (Left) Side View (Right)
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IMPORTANT
• If you cannot close the front cover, make sure that the toner cartridge is installed 

properly. If you try to close the front cover forcefully, this may result in damage to 
the printer.

• Do not leave the front cover open for a long time after installing the toner cartridge. 
This may result in deterioration in print quality.

If the print is too thin even after performing the procedure above, replace the toner 
cartridge with a new one.

Replacing the Toner Cartridge

1 If you are using the multi-purpose tray, close it.
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2 Open the front cover.

While pressing the open button on the top of the front cover a, open it gently b.

3 Remove the toner cartridge from the printer.

b

a
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IMPORTANT
Do not touch the high-voltage contact (A) or the electrical contacts (B) shown in the 
figure, as this may result in damage to the printer.

4 Take the new toner cartridge out of the box.

5 Take the toner cartridge out of the protective bag.

There is a notch near the arrow on the protective bag, so you can tear it open. 
However, if you cannot tear it open, use scissors to open the protective bag so as 
not to damage the toner cartridge.

IMPORTANT
Keep the protective bag for the toner cartridge. You will need it when you take out 
the toner cartridge for printer maintenance or other purposes.

(A)

(B)
7-10 Replacing the Toner Cartridge



R
ou

tin
e 

M
ai

nt
en

an
ce

7

6 Hold the toner cartridge as shown in the figure and shake it 
gently 5 or 6 times to evenly distribute the toner inside the 
cartridge.

IMPORTANT
• If toner is not distributed evenly, this may result in deterioration in print quality. Do 

not skip this step.
• Be sure to shake the toner cartridge gently. If you do not shake the cartridge gently, 

toner may spill out.

7 Place the toner cartridge on a flat surface.
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8 Pull out the sealing tape.

While holding the toner cartridge steady a, hook your fingers into the tab and 
fold it back.
Pull out the sealing tape (approx. 45 cm long) straight in the direction of the 
arrow gently b.

CAUTION
If the sealing tape is pulled out forcefully or stopped at midpoint, toner 
may spill out. If the toner gets into your eyes or mouth, wash them 
immediately with cold water and immediately consult a physician.

IMPORTANT
• Do not pull the sealing tape diagonally, upwards, or downwards. If the tape is 

severed, this may become difficult to pull out completely.

• Pull out the sealing tape completely from the toner cartridge. If any tape remains in 
the toner cartridge, this may result in poor print quality.

b
a
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• When pulling out the sealing tape, be careful not to touch the toner cartridge 
memory (A) or not to hold the drum protective shutter (B) with your hands.

9 Hold the toner cartridge properly with the arrowed side facing 
up as shown in the figure.

(A)

(B)
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10 Install the toner cartridge.

Push the toner cartridge into the printer firmly until it touches the back of the 
printer while aligning (A) on both sides of the toner cartridge with the toner 
cartridge guides inside the printer.

11 Close the front cover.

Close the front cover gently and firmly.

(A)

Side View (Left) Side View (Right)
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IMPORTANT
• If you cannot close the front cover, make sure that the toner cartridge is installed 

properly. If you try to close the front cover forcefully, this may result in damage to 
the printer.

• Do not leave the front cover open for a long time after installing the toner cartridge. 
This may result in deterioration in print quality.

 

Precautions for Handling the Toner Cartridge
The toner cartridge consists of light-sensitive components and intricate mechanical 
components. Handling the toner cartridge without due care may lead to damage to 
the toner cartridge or deterioration in print quality. Be careful of the following points 
when removing or installing the toner cartridge.

WARNING
Do not throw a used toner cartridge into open flames, as this may cause the 
toner remaining inside the cartridge to ignite, resulting in burns or a fire.

CAUTION
Take care not to allow the toner to come into contact with your hands or 
clothing, as this will dirty your hands or clothing. If your hands or clothing 
become stained with toner, wash them immediately with cold water. Washing 
them with warm water may fix the toner and make it not possible to remove the 
toner stains.

IMPORTANT
• When you take the toner cartridge out of the printer for servicing the printer, immediately 

place the toner cartridge into the original protective bag or wrap it with a thick cloth.
• Do not expose the toner cartridge to direct sunlight or strong light.
• Do not jolt the toner cartridge memory (A) or bring it near a magnetic field. This may 

result in damage to the cartridge. Also, print quality may deteriorate if you touch or 
damage the photosensitive drum inside the toner cartridge. Do not touch or open the 
drum protective shutter (B).

(A)

(B)
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• Be careful not to hold or touch areas that are not specified in this procedure, such as the 
electrical contacts (C). This may result in damage to the cartridge.

• Handle the toner cartridge properly with the arrowed side facing up as shown in the 
figure. Do not place it vertically or upside-down.

• Do not attempt to disassemble or modify the toner cartridge.
• Condensation may form in and on the toner cartridge if it is brought into an environment 

that exposes it to sudden changes in temperature and/or humidity. If you move the toner 
cartridge to a location that is warmer or has higher humidity, leave the cartridge in the 
new location for 2 hours or longer without opening the protective bag to allow it to adjust 
to the new temperature.

• Be sure to use a new toner cartridge before the expiration date indicated on the package.
• Keep the toner cartridge away from products that generate magnetism, such as monitors 

or computers.
• A toner cartridge is a magnetic product. Keep the toner cartridge away from products that 

may be damaged by magnetism, such as a floppy disk or disk drive. This may lead to 
damage to data.

(C)
7-16 Replacing the Toner Cartridge



R
ou

tin
e 

M
ai

nt
en

an
ce

7

 

Storing the Toner Cartridge
Be careful of the following points when storing a new toner cartridge or handling a 
toner cartridge that has been taken out of the printer for maintenance or moving the 
printer.

IMPORTANT
• Do not take a new toner cartridge out of the protective bag until it is ready to be used.
• When you take the toner cartridge out of the printer for printer maintenance or other 

reasons, immediately place the toner cartridge into the original protective bag or wrap it 
with a thick cloth.

• Do not place it vertically or upside-down. Store the toner cartridge in the same 
orientation as when installed in the printer.

• Do not store the toner cartridge in a place exposed to direct sunlight.
• Do not store the cartridge in a hot or humid place, or a place where the temperature and 

humidity can change significantly.
Storage temperature range: 0 to 35 °C (32 to 95 °F)
Storage humidity range: 35 to 85 % RH (no condensation)

• Do not store the toner cartridge in a place where corrosive gases, such as ammonia, are 
generated, or where a considerable amount of salt is contained in the air, or where there 
is a lot of dust.

• Keep the toner cartridge out of the reach of small children.
• Keep the toner cartridge away from products that may be damaged by magnetism, such 

as a floppy disk or disk drive.

■ Condensation
Even within the storable humidity range, water droplets may develop both inside and 
outside of the toner cartridge due to the difference in temperature. The development of 
water droplets is called condensation. Condensation will adversely affect the quality of the 
toner cartridge.
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Cleaning the Fixing Roller
If the front or back of the printed paper has smudge marks, clean the fixing roller 
using the following procedure. Print quality deterioration can be prevented by 
cleaning the fixing roller.

IMPORTANT
The cleaning page cannot be printed on any paper other than A4. Be sure to use A4 size 
paper.

1 Load A4-size paper in the multi-purpose tray or paper 
cassette.

2 Display the Printer Status Window.

For details on methods for displaying the Printer Status Window, see "Displaying 
the Printer Status Window," on p. 5-35.

3 From the [Options] menu, select [Utility] ➞ [Cleaning].
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4 Click [OK].

The cleaning page is printed.

5 If any paper is loaded in the multi-purpose tray, remove it.

6 Load the cleaning page in the multi-purpose tray with the 
printed side facing up.
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The paper is fed into the printer slowly, and the printer starts cleaning the fixing 
roller.

NOTE
• Cleaning takes approximately 80 seconds.
• The cleaning process cannot be canceled. Please wait until it is completed.
7-20 Cleaning the Fixing Roller
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the optimal printing quality. When cleaning the printer, be careful of the following 
points in order to prevent electrical shocks or printer malfunctions.

WARNING
• When cleaning the printer, turn OFF the main power switch, and then unplug the 

power plug. Failure to observe these steps may result in a fire or electrical 
shock.

• Do not use alcohol, benzene, paint thinner, or other flammable substances. If 
flammable substances come into contact with electrical parts inside the printer, 
this may result in a fire or electrical shock.

IMPORTANT
• Do not use a cleaning agent other than water or a mild detergent diluted with water, as 

this may deform or crack the plastic materials in the printer.
• When using a mild detergent, be sure to dilute it with water.
• Grease or oil does not have to be applied to this printer. Do not apply grease or oil.
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1 Turn the printer OFF, then disconnect the cables from the 
printer.

Turn the printer OFF a.
If a USB cable is connected, turn the computer off b, and then disconnect the 
USB cable from the printer c.
Disconnect the power plug from the AC power outlet d.

2 Firmly wring a soft cloth dampened with water or a mild 
detergent diluted with water, and wipe off the dirt.

If you use a mild detergent for cleaning, be sure to wipe away the detergent with 
a soft cloth dampened with water.

b

c

d

a
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3 After wiping off the dirt, wipe the printer with a dry cloth.

4 When the printer is completely dry, plug the power plug into 
the AC power outlet.

5 Connect the USB cable to the printer as needed.
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Moving the Printer
When changing the location of the printer or moving the printer for maintenance, be 
sure to perform the following procedure.

CAUTION
Do not carry the printer with the paper cassette attached. If you do so, the paper 
cassette may drop, resulting in personal injury.

IMPORTANT
Make sure that the front cover and multi-purpose tray are closed before carrying the 
printer.

NOTE
For details on the installation site, see "Installation Site," on p. 2-3.

1 Turn the printer OFF, then disconnect the cables from the 
printer.

Turn the printer OFF a.
If a USB cable is connected, turn the computer off b, and then disconnect the 
USB cable from the printer c.
Disconnect the power plug from the AC power outlet d.

b

c

d

a
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WARNING
Be sure to turn the printer and computer OFF, unplug the power plug, and 
then disconnect all the interface cables from the printer before moving the 
printer. Otherwise, the power cord or interface cables may be damaged, 
resulting in a fire or electrical shock.

2 Remove the power cord from the printer.

3 If a LAN cable is connected, disconnect it from the network 
board.

4 Pull out the paper cassette.
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5 Move the printer from the installation site.

From the front side, securely hold the printer by the lift handles on the lower 
portion of the printer with both hands.

CAUTION
• This printer weighs approximately 11 kg without the paper cassette 

installed. Please be careful not to hurt your back or other portions of your 
body when carrying the printer.
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• Do not hold the printer by the front portion, rear portion, or any portions 
other than the lift handles. If you do so, you may drop the printer, resulting 
in personal injury.

• The rear portion (A) of the printer is relatively heavy. Be careful not to 
become off-balance when lifting the printer. If you do so, you may drop the 
printer, resulting in personal injury.

(A)
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• Do not carry the printer with the paper feeder installed. If you do so, the 
paper feeder may drop resulting in personal injury.

NOTE
If the optional paper feeder has been installed in the printer, place the paper feeder 
at the new installation site before carrying the printer to the site. For details on the 
procedure for installing the paper feeder, see "Paper Feeder," on p. 9-2.

6 Put the printer down carefully at the new installation site.

CAUTION
Put the printer down slowly and carefully. Be careful not to hurt your 
hands.

7 Set the paper cassette in the printer.

Push the paper cassette into the printer firmly until the front side of the paper 
cassette is flush with the front surface of the printer.
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CAUTION
When setting the paper cassette in the printer, be careful not to catch your 
fingers.

8 Connect the LAN cable to the network board as needed.

9 Connect the power cord to the printer.

10 Plug the power plug into the AC power outlet.

11 Connect the USB cable to the printer as needed.

● Transporting the Printer
When transporting the printer for such situations as relocating, remove the 
toner cartridge from the printer and securely pack the printer and the parts in 
the original box along with the original packing materials in order to prevent 
them from being damaged while being transported.

If the original box and packing materials are not available, find an appropriate 
box along with packing materials and pack the printer and the parts 
appropriately.
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Handling the Printer
This printer consists of various electronic and precision optical parts. Read the 
following section so that you can handle the printer properly.

IMPORTANT
• For details on handling the printer, also read "Important Safety Instructions" (See p. xviii).
• Do not place any objects other than printing paper on the printer, trays, or covers. This 

may result in damage to the printer.

• Do not leave any covers open longer than required. Exposing the printer to direct sunlight 
or strong light may result in deterioration in print quality.

• Avoid shaking the printer. This may result in poor print quality or damage to the printer.

• Do not open the covers on the printer during printing. This may result in damage to the 
printer.
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• Handle each cover gently when opening or closing it. Failure to do so may result in 
damage to the printer.

• If you want to put a cover on the printer to prevent dust from entering the printer, turn the 
power OFF and allow the printer to cool down sufficiently before covering the printer.

• If you do not plan to use the printer for a long period of time, unplug the power plug from 
the AC power outlet.

• Do not use or store the printer in a room where chemicals are used.
• The face-down output tray and its surroundings become hot during or immediately after 

using the printer. Do not touch the face-down output tray and its surroundings when 
removing the jammed paper or performing the related operation.
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Troubleshooting
This chapter describes the remedies for problems such as a paper jam or poor print quality.

Troubleshooting Flowchart . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-2

Paper Jams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-3
Precautions on Clearing Paper Jams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-3

Paper Jam Area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-6

Procedure for Clearing Paper Jams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-7

The Alarm Indicator Is On/Blinking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-25
The Alarm Indicator Is On (a Service Error Appears)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-26

The Alarm Indicator Is Blinking  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-29

Print Quality Problems  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-30

Paper Problems  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-36

Installation Problems  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-37
Problems with Local Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-38

Installation Problems When the Printer Is Shared on a Network  . . . . . . . . . . . . . . . . . . . . . . . .8-39

Printing a Test Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-41

If Uninstallation Fails. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-42

Uninstalling the USB Class Driver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-45

When Data Is Not Sent to the Printer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-48
If the Printer and Computer Are Connected by a USB Cable . . . . . . . . . . . . . . . . . . . . . . . . . .8-48

When the Printer Is Shared on a Network  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-51

Miscellaneous Problems. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-54

Confirming the Printer Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8-56
8-1



Tr
ou

bl
es

ho
ot

in
g

8

Troubleshooting Flowchart
If any problems occur while you are using the printer, follow the flow chart shown 
below to check the problem.

Printing is 
impossible.

Print quality 
deteriorates.

An error message 
appears on the 

Printer Status Window.

The printer driver 
fails to print.

Yes

Yes

Yes

No

No

No

No

No

No

No

No

No

No

No

No

Yes Toner density is set to light.
(See "Printing with Toner Density 
Adjusted," on p. 6-47)

Toner runs low.
(See "Replacing the Toner Cartridge," 
on p. 7-2)

The printer is not connected to your 
computer.
(See "Connecting to a Computer," on p. 2-28)

Follow the messages displayed on 
the Printer Status Window to 
remedy an error.

(See "Printer Status Window," on p. 
5-34)

The power cord is not connected.
The printer is OFF.
(See "Turning the Printer ON/OFF," on p. 2-33)

The     (Load Paper) Indicator is 
blinking.
(See "Loading Paper in the Paper Cassette," on 
p. 3-17)
(See "Loading Paper in the Multi-purpose Tray," 
on p. 3-31)

The printer is installed in an 
adverse environment.
(See "Installation Site," on p. 2-3)

Other Problems
(See "Print Quality Problems," on p. 
8-30)

Paper Problems
(See "Paper Problems," on p. 8-
36)

The printer driver is not installed 
properly.
(See "Installation Problems," on p. 8-37)

Data is not sent to the printer.
(See "When Data Is Not Sent to the Printer," on 
p. 8-48)

The printer driver is not installed 
properly.
(See "Installation Problems," on p. 8-37)

The      (Alarm) indicator is on/blinking.
(See "The Alarm Indicator Is On/Blinking," on p. 
8-25)
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If a paper jam occurs during printing, the  (Paper Jam) indicator (orange) blinks, 
and the following messages appear in the Printer Status Window.

Precautions on Clearing Paper Jams

WARNING
There are some areas inside the printer which are subject to high voltages. 
When removing jammed paper or when inspecting the inside of the printer, do 
not allow necklaces, bracelets, or other metal objects to touch the inside of the 
printer, as this may result in burns or electrical shock.
8-3Paper Jams
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CAUTION
• The fixing unit and its surroundings inside the printer are hot during use. Make 

sure the fixing unit is completely cool before removing the jammed paper. 
Touching the fixing unit while it is still hot may result in burns.

• The face-up output slot and its surroundings become hot during or immediately 
after using the printer. Do not touch the face-up output slot and its 
surroundings, as doing so may result in burns.

• The paper may be hot immediately after being output. Be careful when removing 
the paper as well as when aligning the removed paper, especially after printing 
continuously. Otherwise, this may result in burns.

• When removing jammed paper, take care not to allow the toner to come into 
contact with your hands or clothing, as this will dirty your hands or clothing. If 
your hands or clothing become stained with toner, wash them immediately with 
cold water. Washing them with warm water may fix the toner and make it not 
possible to remove the toner stains.

• When removing paper jammed inside the printer, remove the jammed paper 
gently to prevent the toner on the paper from dispersing and getting into your 
eyes or mouth. If the toner gets into your eyes or mouth, wash them 
immediately with cold water and immediately consult a physician.

• When removing jammed paper, take care not to cut your hands with the edges 
of the paper.

• Keep your hands or clothing away from the roller in the output area after 
removing jammed paper completely. Even if the printer is not printing, sudden 
rotation of the roller may catch your hands or clothing, resulting in personal 
injury.

IMPORTANT
• Remove jammed paper while the power of the printer is ON. If the power is turned OFF, 

the data being printed will be deleted.
• Applying excess force may result in tearing paper or damaging the parts in the printer. 

When removing jammed paper, pull out the paper in the most appropriate direction, 
judging from the position of the paper.

• If paper is torn, be sure to find and remove any remaining pieces of paper.
8-4 Paper Jams
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• Do not touch the high-voltage contact (A) or the electrical contacts (B) shown in the 
figure, as this may result in damage to the printer.

• Do not touch the transfer roller (C), as this may result in deterioration in print quality.

• The face-down output tray and its surroundings become hot during or immediately after 
using the printer. Do not touch the face-down output tray and its surroundings when 
removing the jammed paper or performing the related operation.

(A)

(B)

(C)
8-5Paper Jams



Tr
ou

bl
es

ho
ot

in
g

8

 

Paper Jam Area
The messages displayed in the Printer Status Window indicate where the paper is 
jammed, and there are the following kinds.

* In "Precautions on Clearing Paper Jams" (See p. 8-3), this mark is attached to the left of each step, indicating the 
paper jam area where the operation described in the step is required.

Paper Jam Area
Paper Jam 
Area Mark*

Message

Multi-purpose tray <Multi-purpose Tray>

Inside the front cover <Inside the front cover>

Output area <Inside the output area>

Duplex print transport area <Duplex Unit>

Cassette 1, Cassette 2 <Cassettes>

A
B

C

D

E
Paper Feeder Unit 

(Optional)

Cassette 1

Cassette 2

Paper flow for 1-sided printing

Paper flow for 2-sided printing

Face-down Output Tray Face-up Output Slot

Multi-purpose Tray

Duplex Print 
Transport Area

A

B

C

D

E
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Procedure for Clearing Paper Jams
Follow the instructions below to remove the jammed paper.

IMPORTANT
The error message may remain if jammed paper is removed without opening the front 
cover. In this case, open and close the front cover once.

NOTE
The illustrations of the printer on the left of each step indicate paper jam areas where the 
operation described in the step is required.

1 Remove any paper jammed in the multi-purpose tray.

IMPORTANT
If the jammed paper cannot be removed easily, do not try to remove it forcefully but 
proceed to Step 2.

A B C D E
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2 If you are using the multi-purpose tray, close it.

3 Open the output selection cover.

A B C D E

A B C D E
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4 Press down the green pressure release levers on both sides 
of the fixing unit.

Even if you can see the paper here, do not remove it but proceed to Step 5.

5 Pull out the paper cassette.

A B C D E

A B C D E
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If the paper feeder is installed, pull out the paper cassette of the paper feeder 
also.

Even if you can see the paper here, do not remove it but proceed to Step 6.

6 Open the front cover.

While pressing the open button on the top of the front cover a, open it gently b.

A B C D E

b

a
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7 Remove the toner cartridge from the printer.

Immediately place the removed toner cartridge into the original protective bag or 
wrap it with a thick cloth.

NOTE
For details on handling the toner cartridge, see "Precautions for Handling the Toner 
Cartridge," on p. 7-15.

8 If you see the top of the paper jammed inside the front cover, 
pull out the paper in the direction of the arrow to remove it.

Remove the jammed paper gently to prevent unfixed toner from spilling.

IMPORTANT
If you pull the jammed paper obliquely upward, unfixed toner may spill. When 
removing the jammed paper, pull it as horizontally as possible. Dirt inside the 
printer may cause deterioration in print quality.

A B C D E

A B C D E
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9 Raise the transport guide, then tilt it toward you.

Raise the transport guide by holding the green tab, then tilt it toward you.

CAUTION
Do not take your hands off the transport guide. The transport guide may 
snap back to its original position, and this may result in personal injury.

A B C D E
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10 Remove any jammed paper.

Remove the jammed paper gently to prevent unfixed toner from spilling.

• If you can see the rear edge of the jammed paper

Remove the paper by pulling it in the direction of the arrow.

• If you cannot see either edge of the jammed paper

Pull out the rear edge of the paper a, then remove the paper by pulling it in the direction
of the arrow b.

A B C D E

a

b
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• If you can see the top edge of the jammed paper

Remove the paper by pulling it in the direction of the arrow.

IMPORTANT
If the jammed paper cannot be removed easily, do not try to remove it forcefully but 
proceed to Step 11.

11 Move the transport guide back to its original position slowly.

CAUTION
Do not take your hands off the transport guide until it moves back to its 
original position. The transport guide may snap back to its original 
position, and this may result in personal injury.

A B C D E
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12 Remove any jammed paper by pulling it in the direction of the 
arrow.

• If the top edge of the paper is output

• If you cannot see either edge of the jammed paper

• If you can see only the top edge of the jammed paper

A B C D E
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13 Move the green pressure release levers of the fixing unit back 
to their original positions.

14 Close the output selection cover.

A B C D E

A B C D E
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15 Open the duplex unit cover.

Holding the opening at the center of the duplex unit cover, open it gently.

16 Remove any jammed paper by pulling it in the direction of the 
arrow.

IMPORTANT
If the jammed paper cannot be removed easily, do not try to remove it forcefully but 
proceed to Step 17.

A B C D E

A B C D E
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17 Close the duplex unit cover.

Holding the opening at the center of the duplex unit cover, close it gently and 
firmly.

18 Close the front cover.

Close the front cover gently and firmly.

A B C D E

A B C D E
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19 Remove any jammed paper while pushing it down slightly.

• In case of the printer unit

• In case of the paper feeder

A B C D E
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IMPORTANT
Do not touch the feed rollers (A) in the printer unit and paper feeder. This may 
result in damage to the printer or a printer error.

20 Open the duplex print transport guide.

Holding the green tab, push the duplex print transport guide downward.

(A)

A B C D E
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21 Remove any jammed paper by pulling it in the direction of the 
arrow.

22 Close the duplex print transport guide.

Holding the green tab, close both sides of the duplex print transport guide 
securely.

IMPORTANT
Be sure to check if the duplex print transport guide is closed completely. If the 
duplex print transport guide is not closed completely, this may result in misfeeds or 
paper jams.

A B C D E

A B C D E
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23 Set the paper cassette in the printer.

Push the paper cassette into the printer firmly until the front side of the paper 
cassette is flush with the front surface of the printer.

If the paper feeder is installed, set the paper cassette of the paper feeder also.

CAUTION
When setting the paper cassette in the printer, be careful not to catch your 
fingers.

A B C D E
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24 Open the front cover.

While pressing the open button on the top of the front cover a, open it gently b.

25 Install the toner cartridge.
1. Take the toner cartridge out of the protective bag or thick cloth.

2. Hold the toner cartridge properly with the arrowed side facing up as shown in the
figure.

A B C D E

b

a

A B C D E
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3. Push the toner cartridge into the printer firmly until it touches the back of the printer
while aligning (A) on both sides of the toner cartridge with the toner cartridge guides
inside the printer.

26 Close the front cover.

Close the front cover gently and firmly.

IMPORTANT
• If you cannot close the front cover, make sure that the toner cartridge is installed 

properly. If you try to close the front cover forcefully, this may result in damage to 
the printer.

• Do not leave the front cover open for a long time after installing the toner cartridge. 
This may result in deterioration in print quality.

(A)

Side View (Left) Side View (Right)

A B C D E
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If a problem occurs in the printer, the  (Alarm) indicator (orange) comes on or 
blinks. Take the following measures according to the state of the  (Alarm) 
indicator.

• On: The Alarm Indicator Is On (a Service Error Appears) (See p. 8-26)

• Blinking: The Alarm Indicator Is Blinking (See p. 8-29)

On/Blinking
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The Alarm Indicator Is On (a Service Error Appears)
If a problem occurs and the printer is not working properly, the  (Alarm) indicator 
(orange) comes on and the following service error appears in the Printer Status 
Window.

If the service error appears, cycle the power of the printer using the following 
procedure. This may clear the message.

NOTE
For details on methods for displaying the Printer Status Window, see "Displaying the 
Printer Status Window," on p. 5-35.

On
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1 Turn the printer OFF, wait for 10 seconds or longer, and then 
turn it ON again.

If the message does not reappear, the printer can be used as normal.
If the error message still appears, proceed to Step 2.

2 Note down the error code displayed in the Printer Status 
Window.

ON

OFF

After 10 seconds
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3 Turn the printer OFF, then disconnect the cables from the 
printer.

Turn the printer OFF a.
If a USB cable is connected, turn the computer off b, and then disconnect the 
USB cable from the printer c.
Disconnect the power plug from the AC power outlet d.

4 Contact your local authorized Canon dealer.

When contacting your Canon dealer, please report the problems and the error 
code that you have noted.

b

c

d

a
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The Alarm Indicator Is Blinking
If an error has occurred in the printer and the printer requires attention, the  
(Alarm) indicator (orange) blinks and the following error message appears in the 
Printer Status Window.

If an error message appears, follow the directions displayed in the Printer Status 
Window.

NOTE
For details on methods for displaying the Printer Status Window, see "Displaying the 
Printer Status Window," on p. 5-35.

Blinking
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Print Quality Problems
If any problems occur while you are using the printer, take the following measures 
depending on the symptoms.

IMPORTANT
• If a message appears in the Printer Status Window, follow the directions in the message.
• If a paper jam occurs, see "Paper Jams," on p. 8-3.
• Contact your local authorized Canon dealer under the following circumstances.

- If a symptom that is not indicated in this section occurs
- If none of the indicated remedies solve the problem
- If you cannot determine the problem

White streaks appear.

Cause 1 The toner cartridge is almost out of toner.

Remedy Take the toner cartridge out of the printer, shake it gently 5 or 6 times to evenly 
distribute the toner, and then reinstall the toner cartridge.
If this does not solve the problem, replace the toner cartridge with a new one. 
(See "Replacing the Toner Cartridge," on p. 7-2)

Cause 2 The drum in the toner cartridge has deteriorated.

Remedy Replace the toner cartridge with a new one. (See "Replacing the Toner 
Cartridge," on p. 7-2)

Printed pages have white specks.

Cause 1 Appropriate paper is not being used.

Remedy Replace the paper with that which can be used with this printer. (See "Paper 
Requirements," on p. 3-2)

Cause 2 Paper is damp due to being stored under unsuitable conditions.

Remedy Replace the paper with new paper in an unopened package. (See "Paper 
Requirements," on p. 3-2)

Cause 3 The drum in the toner cartridge has deteriorated.

Remedy Replace the toner cartridge with a new one. (See "Replacing the Toner 
Cartridge," on p. 7-2)
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The overall print result is faint.

Cause 1 The setting for [Toner Density] is not appropriate.

Remedy Perform the following procedure in the printer driver.

1. Display the [Quality] sheet.

2. Click [Details].

3. Drag the [Toner Density] slider toward [Dark].

Cause 2 [Toner Save] is enabled.

Remedy Perform the following procedure in the printer driver.

1. Display the [Quality] sheet.

2. Click [Details].

3. Clear the [Toner Save] check box.

The overall print result is dark.

Cause 1 The setting for [Toner Density] is not appropriate.

Remedy Perform the following procedure in the printer driver.

1. Display the [Quality] sheet.

2. Click [Details].

3. Drag the [Toner Density] slider toward [Light].

Cause 2 The printer is exposed to direct sunlight or strong light.

Remedy Move the printer to a place where it will not be exposed to direct sunlight or 
strong light. Alternatively, move the strong light source away from the printer.

The print is uneven.

Cause 1 The toner cartridge is almost out of toner.

Remedy Take the toner cartridge out of the printer, shake it gently 5 or 6 times to evenly 
distribute the toner, and then reinstall the toner cartridge.
If this does not solve the problem, replace the toner cartridge with a new 
one.(See "Replacing the Toner Cartridge," on p. 7-2)

Cause 2 Paper is too moist or too dry.

Remedy Replace the paper with new paper in an unopened package. (See "Paper 
Requirements," on p. 3-2)

Cause 3 The drum in the toner cartridge has deteriorated.

Remedy Replace the toner cartridge with a new one. (See "Replacing the Toner 
Cartridge," on p. 7-2)
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The front or back of the printed paper has smudge marks.

Cause The fixing roller is dirty.

Remedy Clean the fixing roller. (See "Cleaning the Fixing Roller," on p. 7-18)

A portion of a page is not printed.

Cause 1 The scale factor is incorrect.

Remedy 1 Perform the following procedure in the printer driver.

1. Display the [Page Setup] sheet.

2. Clear the [Manual Scaling] check box.
If the check box for this option is cleared, the scale factor will be set according to 
[Page Size] and [Output Size] automatically.

Remedy 2 Perform the following procedure in the printer driver.

1. Display the [Page Setup] sheet.

2. Select the [Manual Scaling] check box, then specify an appropriate scale factor 
according to the paper size to be used.

Cause 2 The position of the paper is incorrect.

Remedy Load the paper properly. (See "Loading Paper in the Paper Cassette," on p. 
3-17, "Loading Paper in the Multi-purpose Tray," on p. 3-31)

Cause 3 A document with no margins was printed.

Remedy 1 Data cannot be printed within 5 mm margins (10 mm for envelopes and Index 
Card) on all sides of the paper. Ensure margins around the data.

Remedy 2 Perform the following procedure in the printer driver.

1. Display the [Finishing] sheet.

2. Click [Finishing Details].

3. Select the [Print with Upper Left of Sheet as Starting Point] check box.

IMPORTANT
The edges of the printout may be partly missing depending on the property of the 
document to be printed.

The printing position is skewed.

Cause 1 [Gutter] is specified.

Remedy Perform the following procedure in the printer driver.

1. Display the [Finishing] sheet.

2. Click [Gutter].

3. Set [Gutter] to "0".
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Cause 2 "Top Margin" and "Paper Position" in the application are not specified 
properly.

Remedy Specify the settings for "Top Margin" and "Paper Position" in the application 
properly.(See the instruction manual supplied with the application)

The next page is printed from halfway across the previous page.

Cause "Line Spacing" or "Lines/Page" in the application is not specified 
properly.

Remedy Specify the settings for "Line Spacing" and "Lines/Page" in the application so 
that data fits in one page.(See the instruction manual supplied with the 
application)

Nothing is printed on the paper.

Cause 1 The toner cartridge was installed with the sealing tape still attached.

Remedy Take the toner cartridge out of the printer, pull out the sealing tape, and reinstall 
the toner cartridge. (See "Replacing the Toner Cartridge," on p. 7-2)

Cause 2 Multiple sheets of paper were fed at a time.

Remedy Align the paper stack properly and load it again. If you are using transparencies 
or labels, fan them thoroughly and load them again. (See "Loading Paper in the 
Paper Cassette," on p. 3-17, "Loading Paper in the Multi-purpose Tray," on p. 
3-31)

The overall surface of the paper is printed in black completely.

Cause The drum in the toner cartridge has deteriorated.

Remedy Replace the toner cartridge with a new one. (See "Replacing the Toner 
Cartridge," on p. 7-2)

Colored lines and text come out faint.

Cause Thin lines or text are being used.

Remedy Perform the following procedure in the printer driver.

1. Display the [Quality] sheet.

2. Click [Details].

3. Select the [Print Colored Text and Lines in Black] check box.
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Colored text appears to be blurred.

Cause A bold font is being used for the colored text.

Remedy 1 Use a thinner font.

Remedy 2 Perform the following procedure in the printer driver.

1. Display the [Quality] sheet.

2. Select the [Manual Grayscale Settings] check box, then click [Grayscale Settings].

3. Display the [Matching] sheet.

4. Set [Matching Method] to [Perceptual [Monitor Color Matched]].

The back of the printed paper has smudge marks.

Cause The size of the print data was larger than that of the loaded paper.

Remedy Check if the size of the print data matches that of the loaded paper.

Vertical streaks appear on the printed paper.

Cause 1 The toner cartridge was replaced, or the printer has not printed for a long 
period of time.

Remedy Perform the following procedure in the printer driver.

1. Display the [Finishing] sheet.

2. Click [Finishing Details], then click [Advanced Settings] in the [Finishing Details] dialog 
box.

3. Set [Special Print Adjustment B] to [Mode 1].
If the problem is not solved by specifying [Mode 1], specify [Mode 2].
If the problem is not solved by specifying [Mode 2], specify [Mode 3].

Cause 2 Depending on the paper type or the operating environment, vertical 
streaks may appear on the printed paper.

Remedy 1 Replace the paper with new paper in an unopened package. (See "Paper 
Requirements," on p. 3-2)

Remedy 2 Perform the following procedure in the printer driver.

1. Display the [Finishing] sheet.

2. Click [Finishing Details], then click [Advanced Settings] in the [Finishing Details] dialog 
box.

3. Set [Special Print Adjustment A] to [Mode 2].
If the problem is not solved by specifying [Mode 2], specify [Mode 3].
If the problem is not solved by specifying [Mode 3], specify [Mode 4].
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Toner does not fix well.

Cause 1 Appropriate paper is not being used.

Remedy Replace the paper with that which can be used with this printer. (See "Paper 
Requirements," on p. 3-2)

Cause 2 The setting for [Paper Type] is not appropriate.

Remedy Perform the following procedure in the printer driver.

1. Display the [Paper Source] sheet.

2. Set [Paper Type] to the appropriate value.

Cause 3 A problem has occurred inside the printer.

Remedy 1 If <Service Error> is displayed in the Printer Status Window, turn the printer 
OFF, wait for 10 seconds or longer, and then turn it ON again. This may clear 
the message.

Remedy 2 If the message does not disappear even after applying the Remedy 1, contact 
your local authorized Canon dealer.
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Paper Problems
Paper comes out wrinkled.

Cause 1 Paper is not loaded properly in the paper cassette or multi-purpose tray.

Remedy Load the paper properly in the paper cassette or multi-purpose tray. (See 
"Loading Paper in the Paper Cassette," on p. 3-17, "Loading Paper in the 
Multi-purpose Tray," on p. 3-31)

Cause 2 Paper is damp due to being stored under unsuitable conditions.

Remedy Replace the paper with new paper in an unopened package. (See "Paper 
Requirements," on p. 3-2)

Paper curls.

Cause 1 Paper is damp due to being stored under unsuitable conditions.

Remedy Replace the paper with new paper in an unopened package. (See "Paper 
Requirements," on p. 3-2)

Cause 2 Appropriate paper is not being used.

Remedy Replace the paper with that which can be used with this printer. (See "Paper 
Requirements," on p. 3-2)

Cause 3 The paper is too thin.

Remedy Perform the following procedure in the printer driver.

1. Display the [Paper Source] sheet.

2. Set [Paper Type] to [Plain Paper L].

Cause 4 Paper that curls easily is output to the face-down output tray.

Remedy Switch to the face-up output slot when printing transparencies, labels, Index 
Card, or envelopes which tend to curl. (See "Paper Requirements," on p. 3-2)

White dust is attached to the printed transparencies.

Cause If you print transparencies after printing paper other than transparency 
continuously, chipped paper may attach to the transparencies when they 
are output.

Remedy Wipe and remove the chipped paper with a soft cloth.
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If the printer driver cannot be installed properly, perform the following procedure to 
check problems.

NOTE
For details on problems on the network installation, see "Chapter 4 Troubleshooting" in 
Network Guide.

*1 [Programs] for Windows 2000

*2 [Add/Remove Programs] for Windows 2000; [Uninstall a program] for Windows Vista

[Canon Printer Uninstaller] is 
displayed in [All Programs]*1 

from the [Start] menu.

[Canon LBP3310] is displayed in 
[Add or Remove Programs]*2.

Yes

No No
Cannot 
uninstall

Cannot print

Cannot 
uninstall

Cannot install

Cannot install

The icon for this printer is 
displayed in the 

[Printers and Faxes] or 
[Printers] folder after the 
installation is completed.

No

Yes

Yes

A problem has occurred 
during the installation.

No

Yes

Yes
No

No
Yes

[Canon Printer Uninstaller] is 
displayed in [All Programs]*1 

from the [Start] menu.

[Canon LBP3310] is displayed in 
[Add or Remove Programs]*2.

Uninstall the USB class driver.

(See "Uninstalling the USB Class 
Driver," on p. 8-45)

Uninstall the printer driver with 
Uninstaller.

(See "Uninstalling the Printer 
Driver," on p. 4-69)

Uninstall the printer driver with 
Uninstaller.

(See "Uninstalling the Printer 
Driver," on p. 4-69)

Uninstall the printer driver with 
Uninstaller.

(See "Uninstalling the Printer 
Driver," on p. 4-69)

Delete [Canon LBP3310] from 
[Add or Remove Programs]*2.

(See "If Uninstallation Fails," on p. 
8-42)

Delete [Canon LBP3310] from 
[Add or Remove Programs]*2.
(See "If Uninstallation Fails," on p. 
8-42)

Install the printer driver again.

(See "Installing the Printer Driver," 
on p. 4-5)

Install the printer driver again.

(See "Installing the Printer Driver," 
on p. 4-5)

Uninstall the USB class driver.

(See "Uninstalling the USB Class 
Driver," on p. 8-45)

Print a test page.

(See "Printing a Test Page," on p. 8-41)

Check the power supply, cables, etc.

(See "Problems with Local Installation," on p. 8-38)
(See "Installation Problems When the Printer Is 
Shared on a Network," on p. 8-39)

Install the printer driver again.

(See "Installing the Printer Driver," 
on p. 4-5)

Install the printer driver again.

(See "Installing the Printer Driver," 
on p. 4-5)
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Problems with Local Installation

When installing the printer driver from the CD-ROM, the printer is not recognized 
automatically even after the USB cable is connected.

Cause 1 The USB cable has already been connected and the printer is ON before 
installing the printer driver.

Remedy Perform the following procedure.

1. Turn the printer OFF.

2. Disconnect the USB cable.

3. Connect the USB cable again.

4. Turn the printer ON.

Cause 2 The printer is not turned ON.

Remedy Turn the printer ON.

Cause 3 The USB cable is not connected properly.

Remedy Make sure that the printer and computer are connected with the USB cable 
properly.

Cause 4 An inappropriate USB cable is being used.

Remedy Use a USB cable appropriate for the USB interface of this printer. The USB 
interface is USB 2.0 Hi-Speed and USB Full-Speed (USB1.1 equivalent).
Additionally, use a USB cable with the following symbol.

Cause 5 The USB class driver is installed.

Remedy Uninstall the USB class driver. (See "Uninstalling the USB Class Driver," on p. 
8-45)
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Installation Problems When the Printer Is Shared on a 
Network

The print server to be connected cannot be found.

Cause 1 The print server has not been started up.

Remedy Start up the print server.

Cause 2 The printer is not specified as a shared printer.

Remedy Specify the printer as a shared printer. (See "Print Server Settings," on p. 4-37)

Cause 3 The user does not have permission to access the print server or printer.

Remedy Ask your network administrator to change the user permissions.

Cause 4 If you are using Windows Vista, [Network discovery] is not set to [On].

Remedy Perform the following procedure.

1. From the [Start] menu, select [Control Panel].

2. Click [View network status and tasks].

3. Set [Network discovery] to [On].

The shared printer cannot be accessed.

Cause 1 The user of the computer to be used has not been registered, or the 
password has not been specified yet.

Remedy Register the user registration of the computer to be used or specify the 
password on the print server. For more details, ask your network administrator.

Cause 2 The path to the network is not correct.

Remedy 1 Check the following.

1. Select [Windows Explorer].

From the [Start] menu, select [Programs] ➞ [Accessories] ➞ [Windows Explorer].

    

From the [Start] menu, select [All Programs] ➞ [Accessories] ➞ [Windows Explorer].

Windows 2000

Windows XP Windows Server 2003 Windows Vista
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2. Select the print server from [My Network Places] (from [Network] for Windows Vista), 
then confirm the icon for this printer.

• If you cannot find the icon for this printer

Ask your network administrator about the problem.

• If you can find the icon for this printer

You can install the printer driver by performing either of the following procedures and
following the instructions on the screen.

- Double-clicking the icon for this printer

- Dragging and dropping the icon for this printer into the [Printers and Faxes] folder or
[Printers] folder

Remedy 2 If you want to install the printer driver from the [Printers and Faxes] folder or the 
[Printers] folder and specify the network path using "\" directly, check if the 
correct path is specified as "\\the print sever name (the computer name of the 
print server)\the printer name".
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Printing a Test Page
Print a test page using the following procedure to check the operations of the 
printer driver.

1 Check if any error message is displayed in the Printer Status 
Window.

IMPORTANT
If any error message appears, follow the directions in the message displayed in the 
Printer Status Window. For details on the Printer Status Window, see "Printer 
Status Window," on p. 5-34.

2 Display the [Printers and Faxes] folder or the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other Hardware]
➞ [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printer].

3 Right-click the icon for this printer, then select [Properties] 
from the pop-up menu.

4 Click [Print Test Page] in the [General] sheet.

● When the test page is printed

Printing can be performed from the printer driver. Check the application to make 
sure that all the printing preferences are specified properly.

● When the test page cannot be printed

See "Installation Problems," on p. 8-37.

Windows 2000

Windows XP Professional Windows Server 2003

Windows XP Home Edition

Windows Vista
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If Uninstallation Fails
If you cannot uninstall the printer driver using the Uninstaller that was created 
during the installation, use the following procedure to uninstall the printer driver.

1 Perform the following procedure.

From the [Start] menu, select [Settings] ➞ [Control Panel], and then double-click [Add/
Remove Programs].

From the [Start] menu, select [Control Panel], and then click [Add or Remove Programs].

From the [Start] menu, select [Control Panel] ➞ [Add or Remove Programs].

From the [Start] menu, select [Control Panel], and then click [Uninstall a program].

2 Perform the following procedure.

    

Select [Canon LBP3310] a, then click [Change/Remove] b.

Select [Canon LBP3310] a, then click [Uninstall/Change] b.

Windows 2000

Windows XP

Windows Server 2003

Windows Vista

Windows 2000 Windows XP Windows Server 2003

a

b

Windows Vista

a
b
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NOTE
• If [Canon LBP3310] is not displayed in the dialog box, perform "Uninstalling the 

USB Class Driver" (See p. 8-45) to install the printer driver again.
• If you are using Windows Vista and the [User Account Control] dialog box appears, 

click [Continue].

3 Perform the following procedure.

● If this printer is on the list in the [Delete Printer] dialog box

Select the name of this printer a, then click [Delete] b.

● If this printer is not on the list in the [Delete Printer] dialog box

Click [Delete].

4 Click [Yes].

a

b
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If the printer is used as a shared printer, the following screen appears. Confirm 
the contents of the message, and then click [Yes] if you want to uninstall the 
printer driver.

Uninstallation starts. Please wait a moment.

5 Click [Exit].

6 Display the [Printers and Faxes] folder or the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other Hardware]
➞ [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printer].

7 Make sure that the icon for this printer is not displayed in the 
[Printers and Faxes] folder or [Printers] folder.

Windows 2000

Windows XP Professional Windows Server 2003

Windows XP Home Edition

Windows Vista
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IMPORTANT
If the icon for this printer is displayed, be sure to delete it. Unless you delete the 
icon, you cannot install the printer driver again. 
To delete the icon for this printer, right-click it, and then select [Delete] from the 
pop-up menu.

8 Restart Windows.

Uninstalling the USB Class Driver
Uninstall the USB class driver under the following circumstances.

• If you cannot install the printer driver properly even after reinstalling it

• If you cannot uninstall the printer driver

1 Make sure that the computer is connected to the printer with 
the USB cable and that the printer is ON.

2 Perform the following procedure.

From the [Start] menu, select [Settings] ➞ [Control Panel], and then double-click [Add/
Remove Programs].

From the [Start] menu, select [Control Panel], and then click [Add or Remove Programs].

From the [Start] menu, select [Control Panel] ➞ [Add or Remove Programs].

From the [Start] menu, select [Control Panel], and then click [Uninstall a program].

3 Make sure that [Canon LBP3310] is not displayed in the dialog 
box aaaa, and then click [ ] bbbb.

Windows 2000

Windows XP

Windows Server 2003

Windows Vista

b

a
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NOTE
If [Canon LBP3310] is displayed in the dialog box, see "If Uninstallation Fails" (p. 
8-42) and delete [Canon LBP3310] in the dialog box.

4 Display [Device Manager].

1. From the [Start] menu, select [Settings] ➞ [Control Panel].

2. Double-click the [System] icon.

3. Click [Hardware] ➞ [Device Manager].

1. From the [Start] menu, select [Control Panel].

2. Click [Performance and Maintenance] ➞ [System].

3. Click [Hardware] ➞ [Device Manager].

1. From the [Start] menu, select [Control Panel] ➞ [System].

2. Click [Hardware] ➞ [Device Manager].

1. From the [Start] menu, select [Control Panel].

2. Click [Hardware and Sound] ➞ [View hardware and devices].

NOTE
If you are using Windows Vista and the [User Account Control] dialog box appears, 
click [Continue].

5 Double-click [Universal Serial Bus controllers].

Windows 2000

Windows XP

Windows Server 2003

Windows Vista
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6 Right-click [USB Printing Support], then select [Uninstall] 
from the pop-up menu.

IMPORTANT
• If the USB class driver is under [Other Devices], the printer is not installed properly. 

Select [Unknown device], then uninstall it.
• Do not uninstall any drivers for other devices. If you uninstall them by mistake, 

Windows may not operate properly.
• If the USB class driver is not installed properly, [USB Printing Support] is not 

displayed.

7 Click [OK].

8 Click [ ].

[Device Manager] closes.

9 Disconnect the USB cable from the computer, then restart 
Windows.

After Windows restarts, reinstall the printer driver. (See "Installing the Printer 
Driver," on p. 4-5)
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When Data Is Not Sent to the Printer
NOTE
If the printer and computer are connected by a LAN cable, see "Chapter 4 
Troubleshooting" in Network Guide.

If the Printer and Computer Are Connected by a USB Cable
The following are probable causes if the printer and computer are connected by a 
USB cable, and the data cannot be printed because it is not sent to the printer. Take 
the appropriate measures. 

The power source of the printer has a problem.

Cause 1 The printer is not turned ON.

Remedy Turn the printer ON. (See "Turning the Printer ON," on p. 2-33)

Cause 2 The power plug is unplugged from the AC power outlet.

Remedy Plug the power plug into the AC power outlet.

Cause 3 The printer is plugged to an extension cord or multiple power strip.

Remedy Plug the power plug of the printer directly into an AC power outlet on the wall.

Cause 4 The breakers have tripped.

Remedy Reset the breakers on the switch board.

Cause 5 There is a break in the power cord.

Remedy Replace the power cord with a similar type used for other devices to test the 
printer. If the power can be turned ON, then you can assume that there is a 
break in the original power cord. In this case, purchase a new power cord of the 
same type and replace it with the broken one.
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The USB connection has a problem.

Cause 1 The USB cable is not connected properly.

Remedy Make sure that the printer and computer are connected with the USB cable 
properly.

Cause 2 An inappropriate USB cable is being used.

Remedy Use a USB cable appropriate for the USB interface of this printer. The USB 
interface is USB 2.0 Hi-Speed and USB Full-Speed (USB1.1 equivalent).
Additionally, use a USB cable with the following symbol.

The port to be used has a problem.

Cause The port to be used is not selected properly.

Remedy Perform the following procedure.

1. Display the [Printers and Faxes] folder or the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other
Hardware] ➞ [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printer].

2. Right-click the icon for this printer, then select [Properties] from the pop-up menu.

Windows 2000

Windows XP Professional Windows Server 2003

Windows XP Home Edition

Windows Vista
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3. Display the [Ports] sheet a, then make sure that the port to be used is selected 
properly b.

• If the appropriate port is not selected

Select the appropriate one, then click [OK].

• If you cannot find the port to be used

Uninstall the printer driver and install it again. (See "Uninstalling the Printer Driver," on p.
4-69, "Installing the Printer Driver," on p. 4-5)

Bi-directional communication has a problem.

Cause Bi-directional communication is not enabled.

Remedy Perform the following procedure.

1. Enable bi-directional communication.

2. Restart the computer.

3. Restart the printer (Turn OFF the printer once, wait for 10 seconds or longer, and then 
turn it ON.).

NOTE
Specify the setting for bi-directional communication using the following procedure.
1. Display the [Printers and Faxes] folder or the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other Hardware]
➞ [Printers and Faxes].

a

b

Windows 2000

Windows XP Professional Windows Server 2003

Windows XP Home Edition
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From the [Start] menu, select [Control Panel], and then click [Printer].

2. Right-click the icon for this printer, then select [Properties] from the pop-up menu.

3. Display the [Ports] sheet, then select the [Enable bidirectional support] check box.

When the Printer Is Shared on a Network
The following are probable causes if the printer is shared on a network, and the 
data cannot be printed because it is not sent to the printer. Take the appropriate 
measures.

The power source of the printer has a problem.

Cause 1 The printer is not turned ON.

Remedy Turn the printer ON. (See "Turning the Printer ON," on p. 2-33)

Cause 2 The power plug is unplugged from the AC power outlet.

Remedy Plug the power plug into the AC power outlet.

Cause 3 The printer is plugged to an extension cord or multiple power strip.

Remedy Plug the power plug of the printer directly into an AC power outlet on the wall.

Cause 4 The breakers have tripped.

Remedy Reset the breakers on the switch board.

Cause 5 There is a break in the power cord.

Remedy Replace the power cord with a similar type used for other devices to test the 
printer. If the power can be turned ON, then you can assume that there is a 
break in the original power cord. In this case, purchase a new power cord of the 
same type and replace it with the broken one.

The interface cable connection has a problem.

Cause 1 The interface cable is not connected properly.

Remedy Make sure that the printer is connected to the print server, and the print server 
is connected to the client computer by the interface cable properly.

Windows Vista
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Cause 2 An inappropriate USB cable is being used.

Remedy When connecting the printer using a USB cable, use a USB cable appropriate 
for the USB interface of this printer. The USB interface is USB 2.0 Hi-Speed and 
USB Full-Speed (USB1.1 equivalent).
Additionally, use a USB cable with the following symbol.

The print server has a problem.

Cause 1 The print server is not turned on.

Remedy Turn on the print server.

Cause 2 The print server is not connected to the network properly.

Remedy 1 Make sure that the print server and network are connected by a LAN cable 
properly.

Remedy 2 Make sure that the network settings for the print server are appropriate.

Cause 3 The print server runs on 64-bit Windows XP/Server 2003/Vista, and the 
additional driver (alternate driver) is not updated properly.

Remedy If you want to update the additional driver (alternate driver), perform the 
following procedure.

1. Uninstall the printer driver used in the print server. (See p. 4-69)

2. Install the new printer driver on the print server. (See p. 4-5)

3. See "Print Server Settings" (p. 4-37) and install the additional driver again.

NOTE
If you are not sure whether you are using 64-bit Windows Vista, see "Checking the 
Processor Version of Windows Vista," on p. 10-8.

The network path to the print server has a problem.

Cause 1 An incorrect network path was specified on the installation of the printer 
driver.

Remedy If you want to install the printer driver from the [Printers and Faxes] folder or the 
[Printers] folder and specify the network path using "\" directly, specify the 
correct path as "\\the print sever name (the computer name of the print 
server)\the printer name".
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Cause 2 The network path to the print server was changed.

Remedy Ask your network administrator about the problem.
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Miscellaneous Problems
NOTE
For details on problems on installing the optional network board, see "Chapter 4 
Troubleshooting" in Network Guide.

LBP3310 does not function properly.

Cause 1 LBP3310 is not specified as the default printer.

Remedy Specify it as the default printer.

Cause 2 The printer driver is not installed properly.

Remedy See "Installation Problems," on p. 8-37.

Excessive time is required until the next job starts after finishing a job.

Cause The printer cools down the fixing unit so that the print quality is 
maintained (Especially after paper with a narrower width is printed).

Remedy Please wait a moment. The printer cools down the fixing unit automatically. 
When the printer finished cooling down the fixing unit, the printer begins 
printing.

CD-ROM Setup does not appear automatically. (Windows Vista only)

Cause CD-ROM Setup is not specified to appear automatically.

Remedy Perform the following procedure.

1. From [Control Panel], click [Play CDs or other media automatically].

2. Select the [Use AutoPlay for all media and devices] check box.

3. Set [Software and games] to [Install or run program].
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The message <Specified Paper Different from Set Paper> appears in the Printer Status 
Window.

Cause The size of the loaded paper and the specified settings are different from 
each other as follows.

• Examples of printing from the paper cassette:

*1 The setting located in the [Page Setup] sheet

*2 The setting located in the [Cassette Settings] dialog box in the Printer Status Window

• Examples of printing from the multi-purpose tray:

* The setting located in the [Page Setup] sheet
 

Remedy If the message appears, perform the following procedures.

• If you want to print paper of the size specified for B

- Printing from the paper cassette: 
Load the appropriate paper, then specify the appropriate paper size for C.

- Printing from the multi-purpose tray: 
Load the appropriate paper.

• If you want to print the currently loaded paper

Click [ ] (Resolve Error) in the Printer Status Window.

A. The Size of 
the Loaded 
Paper

B. [Output 
Size]*1

C. [Register 
Paper 
Sizes]*2

Printer Operation

A5 A4 A5 Because the settings for 
B and C are different 
from each other, the 
message appears, and 
printing is paused.

A4 A4 A5

A. The Size of 
the Loaded 
Paper

B. [Output 
Size]*

C. Setting for 
[Output 
Size]* for the 
Previous Job

Printer Operation

A4 A4 A5 Because the settings for 
B and C are different 
from each other, the 
message appears, and 
printing is paused.

A5 A4 A5
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Confirming the Printer Features
This printer is provided with a function of Configuration Page Print that allows you to 
confirm the following current printer status.

• The optional settings of the printer

• The settings for [Device Settings] in the [Options] menu in the Printer Status 
Window

• [Number of Total Printed Pages]

Use these functions when required after installing and connecting the printer, for 
example when you want to check the operation.

NOTE
• Configuration Page Print is designed to be printed on A4 size paper. Load A4 size paper.
• For details on Network Status Print that allows you to check the version of the optional 

network board as well as the TCP/IP settings, see "Chapter 4 Troubleshooting" in 
Network Guide.

1 Display the Printer Status Window.

For details on methods for displaying the Printer Status Window, see "Displaying 
the Printer Status Window," on p. 5-35.

2 From the [Options] menu in the Printer Status Window, select 
[Utility] ➞ [Configuration Page Print].
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3 Click [OK].

4 Confirm the contents of the Configuration Page Print.

IMPORTANT
This is a sample of Configuration Page Print. The contents may differ from the 
Configuration Page Print printed by your printer.
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Installing the Optional Accessorie
This chapter describes the procedures for installing the optional accessories for the printer.
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Paper Feeder
The paper feeder is to be installed at the bottom of the printer.

WARNING
Be sure to turn the printer OFF, unplug the power plug, and then disconnect all 
the interface cables and power cord from the printer before installing the paper 
feeder. Otherwise, the power cord or interface cables may be damaged, 
resulting in a fire or electrical shock.

IMPORTANT
• Do not touch the connector (A) in the paper feeder. This may result in damage to the 

printer or misfeeds.

• If you are printing from Cassette 2, make sure that Cassette 1 is set before printing. If you 
print from Cassette 2 when Cassette 1 is not set, this will cause paper jams.

PAPER FEEDER PF-35P

(A)
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NOTE
Load paper in the paper feeder in the same manner as you would load paper in Cassette 
1. For details, see "Loading Paper in the Paper Cassette," on p. 3-17.

Moving the Printer
When installing the paper feeder in the printer after installing the printer, move the 
printer to an appropriate location temporarily using the following procedure.

WARNING
Be sure to turn the printer and computer OFF, unplug the power plug, and then 
disconnect all the interface cables from the printer before moving the printer. 
Otherwise, the power cord or interface cables may be damaged, resulting in a 
fire or electrical shock.

CAUTION
Do not carry the printer with the paper cassette attached. If you do so, the paper 
cassette may drop, resulting in personal injury.

1 Turn the printer OFF, then disconnect the cables from the 
printer.

Turn the printer OFF a.
If a USB cable is connected, turn the computer off b, and then disconnect the 
USB cable from the printer c.
Disconnect the power plug from the AC power outlet d.

b

c

d

a
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2 Remove the power cord from the printer.

3 If a LAN cable is connected, disconnect it from the network 
board.

4 Pull out the paper cassette.
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5 Move the printer from the installation site.

From the front side, securely hold the printer by the lift handles on the lower 
portion of the printer with both hands.

CAUTION
• This printer weighs approximately 11 kg without the paper cassette 

installed. Please be careful not to hurt your back or other portions of your 
body when carrying the printer.
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• Do not hold the printer by the front portion, rear portion, or any portions 
other than the lift handles. If you do so, you may drop the printer, resulting 
in personal injury.

• The rear portion (A) of the printer is relatively heavy. Be careful not to 
become off-balance when lifting the printer. If you do so, you may drop the 
printer, resulting in personal injury.

(A)
9-6 Paper Feeder
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IMPORTANT
Make sure that the front cover and multi-purpose tray are closed before carrying 
the printer.

Removing the Packing Materials and Installing the Paper 
Feeder

CAUTION
• Put the printer or paper feeder down slowly and carefully. Be careful not to hurt 

your hands.
• Do not carry the printer with the paper cassette attached. If you do so, the paper 

cassette may drop, resulting in personal injury.
• Do not carry the printer with the paper feeder installed. If you do so, the paper 

feeder may drop resulting in personal injury.

IMPORTANT
• If there are any packing materials remaining inside the paper feeder, this may result in 

misfeeds or damage to the printer when operating the printer. Be sure to remove all the 
packing materials following the procedure.

• The removed packing materials are required when transporting the printer for relocation 
or maintenance. Be sure not to misplace them.

NOTE
The packing materials may be changed in form or placement, or may be added or 
removed without notice.
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1 Pull out the paper cassette.

2 Remove the tape that is securing the packing material in the 
paper cassette (2 locations).
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3 Remove the packing material in the paper cassette.

4 Place the paper feeder at the installation site.

When carrying the paper feeder, hold the lift handles on both sides with both 
hands as shown in the figure.
9-9Paper Feeder
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IMPORTANT
• Do not touch the connector (A) in the paper feeder. This may result in damage to 

the printer or misfeeds.

• Do not install the paper feeder on a platform that may warp from the weight of the 
printer and optional accessories, or where the printer is liable to sink (such as a 
carpet or mat).

5 Gently place the printer on the paper feeder so that each 
surface of the printer is flush with the front or side surfaces of 
the paper feeder.

Also, match the positioning pins (A) and connector (B) when placing the printer.

IMPORTANT
If the printer cannot be placed on the paper feeder properly, lift the printer once, 
hold it horizontally, and place it again. If you try to place the printer forcefully 
without lifting it, the connector and positioning pins may be broken.

(A)

(A)(A)

(B)
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6 Set the paper cassettes in the printer and paper feeder.

7 Connect the LAN cable to the network board as needed.

8 Connect the power cord to the printer.

9 Plug the power plug into the AC power outlet.

10 Connect the USB cable to the printer as needed.

IMPORTANT
Be sure to turn the printer ON once when loading paper in the paper cassette for 
the first time after installing the paper feeder.

Specifying the Status of the Paper Feeder
Specify the status of the paper feeder after installing it using the following 
procedure.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other Hardware]
➞ [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printer].

Windows 2000

Windows XP Professional Windows Server 2003

Windows XP Home Edition

Windows Vista
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2 Right-click the icon for this printer, then select [Properties] 
from the pop-up menu.

3 Display the [Device Settings] sheet aaaa, then click [Get Device 
Status] bbbb.

The status of the paper feeder is obtained automatically.

NOTE
If you cannot obtain the status of the paper feeder automatically, select the [250 
Sheet Cassette] check box in [Paper Source Options].

a

b

9-12 Paper Feeder
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Removing the Paper Feeder

WARNING
Be sure to turn the printer OFF, unplug the power plug, and then disconnect all 
the interface cables and power cord from the printer before removing the paper 
feeder. Otherwise, the power cord or interface cables may be damaged, 
resulting in a fire or electrical shock.

CAUTION
• Do not carry the printer with the paper cassette attached. If you do so, the paper 

cassette may drop, resulting in personal injury.
• Do not carry the printer with the paper feeder installed. If you do so, the paper 

feeder may drop resulting in personal injury.

IMPORTANT
When moving or servicing the printer, remove the paper feeder and paper cassette.
9-13Paper Feeder
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1 Turn the printer OFF.

2 If a USB cable is connected, turn the computer off, and then 
disconnect the USB cable from the printer.

3 Disconnect the power plug from the AC power outlet.

4 Remove the power cord from the printer.

5 If a LAN cable is connected, disconnect it from the network 
board.

6 Pull out the paper cassettes from the printer and paper feeder.

7 Lift the printer unit and remove it from the paper feeder.

8 Move the paper feeder.

9 Move back the printer to the installation site.

10 Set the paper cassette in the printer.

11 Connect the LAN cable to the network board as needed.

12 Connect the power cord to the printer.

13 Plug the power plug into the AC power outlet.

14 Connect the USB cable to the printer as needed.
9-14 Paper Feeder
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Install the network board in the expansion slot located on the rear of the printer.

* Depending on the network board, a CD-ROM may be supplied with it.

Network board (NB-C2) Screws (2 pieces)

ERR LNK 100

Guide booklet
9-15Network Board
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By installing the optional network board, you can use LBP3310 as a printer directly 
connected to a network.

* If you want to connect this printer via a print server, you must perform the following settings.

1. Install the printer driver on the print server. (See Network Guide) 
2. Configure the print server. (See p. 4-37)
3. Install the printer driver on a client computer. (See p. 4-48)

CAUTION
• Be sure to turn the printer OFF, unplug the power plug, and then disconnect all 

the interface cables and power cord from the printer before installing the 
network board. If a USB cable is connected, turn the computer off, and then 
remove the USB cable. If you attempt to install the network board when the 
printer is ON or when any cables are connected to the printer, this may result in 
an electrical shock.

• Be careful when handling the network board. Touching the edges or any sharp 
parts of the network board may result in personal injury.

Connecting the printer directly to the computer

Connecting the printer to the computer via a print server

Client

Client

Client

Client

Printer

Printer

: TCP/IP

: TCP/IP
: Usable Protocols

Print server
9-16 Network Board
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IMPORTANT
• The network board contains components that are sensitive to static electricity. Observe 

the following precautions when handling the network board to prevent damage from 
static electricity.
- Touch a metal object to dissipate static electricity before handling the network board.
- When handling the network board, do not touch anything that generates static 

electricity such as the computer display.
- Do not touch the network board parts, printed circuits, or connectors with your hands.
- To prevent the network board from being affected by static electricity, keep it in the 

protective bag until it is ready to be installed. You will need the protective bag after you 
remove the network board to hold it. Keep the protective bag. Dot not discard it.

• The firmware versions of the network board compatible with this printer are as follows.

If the firmware version is not 1.30 or later, the printer may not operate properly. Make 
sure that the version is 1.30 or later after installing the network board and the printer 
driver. 
If the version is not 1.30 or later, update the firmware of the network board using the 
update file in the "NB-C2_Firmware" folder in the CD-ROM supplied with the printer. 
For details on the procedures for checking and updating the firmware version, see the 
README file in the "NB-C2_Firmware" folder. 
Also, you can download the firmware update file from the Canon website.

NOTE
This network board does not come with a LAN cable or a hub. Have cables or a hub 
ready as needed. 
Use a Category 5 twisted pair cable for the LAN.

Printer Firmware Version of the Network Board

LBP3310 Ver. 1.30 or later
9-17Network Board
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Parts and Their Functions

aaaa Printer Connector
Connects to the printer. Do not touch the connector 
directly with your hands.

bbbb LAN Connector
Connects to a 10BASE-T/100BASE-TX LAN cable.

cccc 100 Indicator (Green)
Comes on if the network board is connected to the 
network by 100BASE-TX.
Does not come on when connected by 10BASE-T.

dddd LNK Indicator (Green)
Comes on if the network board is connected to the 
network properly.

eeee ERR Indicator (Orange)
Comes on or blinks if the network board is not 
working properly.

ffff MAC Address
Required when setting the IP address using the 
ARP/PING command. This may be also required 
when installing the printer driver.

ERR LNK 100

a

c bde

f
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Installing the Network Board
Install the network board in the expansion slot of the printer using the following 
procedure.

NOTE
A Phillips screwdriver is required for installing the network board. Have a screwdriver 
ready in advance that matches the size of the screws.

1 Turn the printer OFF, then disconnect the cables from the 
printer.

Turn the printer OFF a.
If a USB cable is connected, turn the computer off b, and then disconnect the 
USB cable from the printer c.
Disconnect the power plug from the AC power outlet d.

2 Remove the power cord from the printer.

If there is insufficient space to install the network board, move the printer to a 
place where you can work easier.

b

c

d

a

9-19Network Board
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3 Remove the screws and remove the protective plate for the 
expansion slot.

IMPORTANT
• Do not drop screws, paper clips, staples, or other metal objects inside the printer. If 

any of these objects should drop inside the printer, do not plug the power plug into 
the AC power outlet and contact your local authorized Canon dealer.

• Be sure not to misplace the removed protective plate and screws. You will need 
them after you remove the network board.

4 Insert the network board into the expansion slot in the 
orientation shown in the figure.

Hold the metal panel portions of the network board and insert the board straight 
while aligning it with the guide rails inside the expansion slot.
9-20 Network Board
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IMPORTANT
• Do not touch the network board parts, printed circuits, or connectors with your 

hands.
• Insert the network board securely so that there is no space between the expansion 

slot and the panel portion of the network board.

• Keep the protective bag for the network board. You will need it after you remove the 
network board.

5 Secure the top and bottom portions of the network board with 
the two screws supplied with the network board.

There is space. There is no space.
9-21Network Board
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6 Connect the LAN cable to the LAN connector of the network 
board.

NOTE
This network board does not come with a LAN cable or a hub. Have cables or a 
hub ready as needed. 
Use a Category 5 twisted pair cable for the LAN.

7 Connect the other end of the LAN cable to the hub.
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8 Connect the power cord to the printer.

9 Plug the power plug into the AC power outlet.

10 Connect the USB cable to the printer as needed.

11 Turn the printer ON.

IMPORTANT
If the printer does not operate properly, or an error message appears in the Printer 
Status Window, see "Troubleshooting," on p. 8-1.

12 Make sure that the LNK indicator (green) on the network 
board is on.

If the network board is connected by 10BASE-T, the board is working properly 
when the LNK indicator is on.
If the network board is connected by 100BASE-TX, the board is working properly 
when the LNK indicator and 100 indicator are on.
((A): ERR Indicator (B): LNK Indicator (C): 100 Indicator)

● If the network board is not working properly

Turn the printer OFF, then check the following.

• Whether the LAN cable is connected properly
• Whether the hub operates properly
• Whether the network board is installed properly

(A)

(B)

(C)
9-23Network Board
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IMPORTANT
The firmware versions of the network board compatible with this printer are as follows.

If the firmware version is not 1.30 or later, the printer may not operate properly. Make 
sure that the version is 1.30 or later after installing the network board and the printer 
driver. 
If the version is not 1.30 or later, update the firmware of the network board using the 
update file in the "NB-C2_Firmware" folder in the CD-ROM supplied with the printer. 
For details on the procedures for checking and updating the firmware version, see the 
README file in the "NB-C2_Firmware" folder. 
Also, you can download the firmware update file from the Canon website.

Setting the Network Board
The default value of the network board is set at "Auto detect". Usually, you do not 
need to change the setting, since the transmission speed and transfer mode of 
10BASE-T/100BASE-TX are detected automatically.
If the printer cannot communicate with other devices on the network, you can 
specify the transmission speed and transfer mode by setting the DIP switches using 
the following procedure. Set the DIP switches according to the transmission speed 
of the connected network as follows.

IMPORTANT
When setting the DIP switches, be careful not to damage the main board with a small tool 
such as the tip of a ball-point pen. Do not use a sharp object such as a mechanical 
pencil.

NOTE
A Phillips screwdriver is required for removing or installing the network board. Have a 
screwdriver ready in advance that matches the size of the screws.

Printer Firmware Version of the Network Board

LBP3310 Ver. 1.30 or later

ERR LNK 100

ON

OFF OFF

1 2 3 4

DIP switches

* Shown above is the Auto 
  detect setting (default 
  setting)
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■ Setting the Network Transmission Speed/Transfer Mode and the DIP 
Switches

1 Turn the printer OFF.

2 If a USB cable is connected, turn the computer off, and then 
disconnect the USB cable from the printer.

3 Disconnect the power plug from the AC power outlet.

4 Remove the power cord from the printer.

5 Disconnect the LAN cable from the network board.

6 Remove the two screws and remove the network board.

Communication speed and 
Transmission mode of LAN

10BASE-T/Half-duplex

ON

OFF

ON

OFF

ON

OFF

ON

OFF

ON

OFF

Auto detect (default setting)

10BASE-T/Full-duplex

100BASE-TX/Half-duplex

100BASE-TX/Full-duplex

DIP switch setting

OFF

1 2 3 4

OFF

1 2 3 4

OFF

1 2 3 4

OFF

1 2 3 4

OFF

1 2 3 4
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IMPORTANT
• Do not touch the network board parts, printed circuits, or connectors with your 

hands.
• Do not drop screws, paper clips, staples, or other metal objects inside the printer. If 

any of these objects should drop inside the printer, do not plug the power plug into 
the AC power outlet and contact your local authorized Canon dealer.

7 Set the DIP switches.

Set the DIP switches with a small tool such as the tip of a ball-point pen. For 
details on methods for setting the DIP switches, see the table of p. 9-25.

IMPORTANT
When setting the DIP switches, be careful not to damage the main board with a 
small tool such as the tip of a ball-point pen. Do not use a sharp object such as a 
mechanical pencil.

8 Insert the network board into the expansion slot.

Hold the metal panel portions of the network board and insert the board straight 
while aligning it with the guide rails inside the expansion slot.

IMPORTANT
• Do not touch the network board parts, printed circuits, or connectors with your 

hands.
• Insert the network board securely.

ERR LNK 100

ON

OFF OFF

1 2 3 4

DIP switches
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9 Secure the top and bottom portions of the network board with 
the two screws supplied with the network board.

10 Connect the LAN cable to the network board.

11 Connect the power cord to the printer.

12 Plug the power plug into the AC power outlet.

 

13 Connect the USB cable to the printer as needed.

Resetting the Network Board
If you want to reset the network board to the default values, use any one of the 
following methods. For details, see "Network Guide".

• Remote UI

• FTP Client

• NetSpot Device Installer

Even if none of the above methods work, you can reset the settings for the network 
board by setting the DIP switches using the following procedure.

NOTE
A Phillips screwdriver is required for removing or installing the network board. Have a 
screwdriver ready in advance that matches the size of the screws.
9-27Network Board
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1 Turn the printer OFF.

2 If a USB cable is connected, turn the computer off, and then 
disconnect the USB cable from the printer.

3 Disconnect the power plug from the AC power outlet.

4 Remove the power cord from the printer.

5 Disconnect the LAN cable from the network board.

6 Remove the two screws and remove the network board.

IMPORTANT
• Do not touch the network board parts, printed circuits, or connectors with your 

hands.
• Do not drop screws, paper clips, staples, or other metal objects inside the printer. If 

any of these objects should drop inside the printer, do not plug the power plug into 
the AC power outlet and contact your local authorized Canon dealer.

7 Switch the DIP switch 1 to ON.

Set the DIP switches with a small tool such as the tip of a ball-point pen.

IMPORTANT
When setting the DIP switches, be careful not to damage the main board with a 
small tool such as the tip of a ball-point pen. Do not use a sharp object such as a 
mechanical pencil.

ERR LNK 100

ON
OFF

1 2 3 4

DIP switch 1
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8 Insert the network board into the expansion slot.

Hold the metal panel portions of the network board and insert the board straight 
while aligning it with the guide rails inside the expansion slot.

IMPORTANT
• Do not touch the network board parts, printed circuits, or connectors with your 

hands.
• Insert the network board securely.

9 Secure the top and bottom portions of the network board with 
the two screws supplied with the network board.

10 Connect the power cord to the printer.

11 Plug the power plug into the AC power outlet.

12 Turn the printer ON, then wait until the  (Ready) indicator 
comes on.

13 Turn the printer OFF.

14 Disconnect the power plug from the AC power outlet.

15 Remove the power cord from the printer.
9-29Network Board
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16 Remove the network board, then reset the DIP switch 1 to 
OFF.

Set the DIP switches with a small tool such as the tip of a ball-point pen.

IMPORTANT
• Do not touch the network board parts, printed circuits, or connectors with your 

hands.
• Do not drop screws, paper clips, staples, or other metal objects inside the printer. If 

any of these objects should drop inside the printer, do not plug the power plug into 
the AC power outlet and contact your local authorized Canon dealer.

• When setting the DIP switches, be careful not to damage the main board with a 
small tool such as the tip of a ball-point pen. Do not use a sharp object such as a 
mechanical pencil.

17 Install the network board.

18 Connect the LAN cable to the network board.

19 Connect the power cord to the printer.

20 Plug the power plug into the AC power outlet.

21 Connect the USB cable to the printer as needed.

ERR LNK 100

OFF
OFF

1 2 3 4

DIP switch 1
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Removing the Network Board
Remove the network board using the following procedure. Have ready the 
protective plate and screws that were removed from the expansion slot when the 
network board was initially installed.

CAUTION
• Be sure to turn the printer and computer OFF and disconnect all the interface 

cables and power cord from the printer before removing the network board. If a 
USB cable is connected, turn the computer off, and then remove the USB cable. 
If you attempt to remove the network board when the printer is ON or when any 
cables are connected to the printer, this may result in an electrical shock.

• Be careful when handling the network board. Touching the edges or any sharp 
parts of the network board may result in personal injury.

1 Turn the printer OFF.

2 If a USB cable is connected, turn the computer off, and then 
disconnect the USB cable from the printer.

3 Disconnect the power plug from the AC power outlet.

4 Remove the power cord from the printer.

5 Disconnect the LAN cable from the network board.

6 Remove the two screws and remove the network board.

Store the removed network board in the original protective bag.

IMPORTANT
• Do not touch the network board parts, printed circuits, or connectors with your 

hands.
• Do not drop screws, paper clips, staples, or other metal objects inside the printer. If 

any of these objects should drop inside the printer, do not plug the power plug into 
the AC power outlet and contact your local authorized Canon dealer.

• Be sure not to misplace the removed screws. You will need them when you install 
the network board again.
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7 Attach the protective plate to the expansion slot and secure it 
with the screws.

8 Connect the power cord to the printer.

9 Plug the power plug into the AC power outlet.

10 Connect the USB cable to the printer as needed.
9-32 Network Board
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Specifications
Hardware Specifications

Type Desktop Page Printer

Printing method Electrophoto Method (On-demand fixing)

Printing speed
Plain paper (60 to 89 g/m2)

If printing A4 size paper continuously
26 pages/min.
* Print speed may drop in stages, depending on the 

paper size, paper type, print copies, and the 
settings of the fixing mode. (This is because the 
safety function that prevents damage caused by 
heat becomes active.)

Warm up time
(Time from power on to printer 
ready)

8 seconds or less
* May vary depending on the use conditions (such as 

the toner cartridge you are using, availability of the 
optional accessories, and installation environment).

First print time

When printing A4/outputting face-down
Approx. 6.5 seconds or less
* May vary depending on the toner cartridge you are 

using or output environment.

Paper size

Cassette 1 - Standard sizes
A4, B5, A5, Legal, Letter, Executive, 16K

- Custom paper sizes
Width 148.0 to 215.9 mm; Length 210.0 to 355.6 
mm

Paper capacity: approx. 250 sheets (64 g/m2)

Cassette 2
(Optional)

Multi-purpose 
tray

- Standard sizes
A4, B5, A5, Legal, Letter, Executive, 16K, Envelope 
DL, Envelope COM10, Envelope C5, Envelope 
Monarch, Index Card

- Custom paper sizes
Width 76.2 to 215.9 mm; Length 127.0 to 355.6 
mm

Paper capacity: approx. 50 sheets (64 g/m2)

Automatic 2-sided printing A4, Legal, Letter

Paper output Face-down/Face-up
10-2 Specifications
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Output capacity
Face-down Output Tray: approx. 125 sheets (64 g/

m2)
Face-up Output Slot: 1 sheet

Noise (Declared noise 
emission in accordance with 
ISO 9296)

Lwad (declared A-weighted sound power level (1 B = 
10 dB))

During standby: Background noise level
During operation: 6.81 B or less

Sound pressure level (Bystander position)
During standby: Background noise level
During operation: 55 dB (A) or less

Operating environment 
(Printer unit only)

Operating environment temperature: 10 to 32.5 °C 
(50 to 90.5 °F)
Humidity: 20 to 80 % RH (no condensation)

Host interface

USB interface
- USB 2.0 Hi-Speed/USB Full-Speed (USB1.1 equivalent)
Network interface
- 10BASE-T/100BASE-TX (RJ-45)

Full duplex; Half duplex

User interface
5 LED indicators
1 Operation key

Power supply
110 - 127 V (± 10 %) 50/60 Hz (± 2 Hz)
220 - 240 V (± 10 %) 50/60 Hz (± 2 Hz)

Power consumption (at 
temperature of 20 °C (68 °F))

110 - 127 V
Average during operation: approx. 372 W
Average during standby: approx. 4 W
Maximum: 890 W or less

220 - 240 V
Average during operation: approx. 392 W
Average during standby: approx. 4 W
Maximum: 950 W or less

Consumables Toner cartridge

Number of printable pages: approx. 3,000 pages*1 or 
7,000 pages*1 (Canon Genuine Cartridge)
*1 When the pages are on the basis of "ISO/IEC 

19752"*2 on printing A4 size paper with the default 
print density setting

*2 "ISO/IEC 19752" is the global standard related to 
"Method for the determination of toner cartridge 
yield for monochromatic electrophotographic 
printers and multi-function devices that may contain 
printer components" issued by ISO (International 
Organization for Standardization).
10-3Specifications
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Software Specifications

Weight

Printer unit 
and included 
parts

Printer unit 
(excluding the toner cartridge)............approx. 11.2 kg
Toner cartridge .....................................approx. 0.8 kg

Consumables 
and optional 
accessories

Toner cartridge (Canon Genuine Cartridge)
(Number of printable pages: approx. 3,000 pages)
.............................................................approx. 0.8 kg
Toner cartridge (Canon Genuine Cartridge)
(Number of printable pages: approx. 7,000 pages)
.............................................................approx. 1.0 kg
PAPER FEEDER PF-35P
(Including the cassette) .......................approx. 3.5 kg

Printing software CAPT (Canon Advanced Printing Technology)

Printable area

Data cannot be printed within 5.0 mm margins on all sides 
of the paper. (10 mm for envelopes and Index Card)
* If you print a document with no margins, specify the 

following setting.
1.Click [Finishing Details] in the [Finishing] sheet.
2.Select the [Print with Upper Left of Sheet as Starting 

Point] check box.
If data is printed with the edges missing even after the 
above setting is specified, specify the scaling factor in 
the printer driver to print smaller so that all of the 
document will fit on one sheet of paper, and then print 
again.
10-4 Specifications
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■ Printer unit
• Standard configuration

• With the paper feeder installed

(mm)

385

60 130

100

378.6 94.3

39
9.

7

25
8

150

Front Surface

Output selection cover

Paper cassette

Front cover

Tray extension

Auxiliary tray

Multi-purpose tray

(mm)

385

60 130

100

378.6 94.3

39
9.

7

34
6.

8
150

Front Surface

Output selection cover

Paper cassette
Front cover

Tray extension

Auxiliary tray

Multi-purpose tray
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■ Paper Feeder Unit PF-35P

11
7.

4

11
6.

6

39
9.

7

421.1
(mm)Front Surface
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The supplied CD-ROM includes the "NetSpot Device Installer", which is a utility that 
can initialize the settings of a printer connected to the network, as well as the 
printer driver. "NetSpot Device Installer" is software that allows you to easily 
initialize the settings of printers connected to the network.

For more details on "NetSpot Device Installer", see "Network Guide".

NOTE
When the printer driver is installed from CD-ROM Setup, the initial settings for the 
network are performed automatically. Use "NetSpot Device Installer" as needed if you 
want to reset the IP address manually without using CD-ROM Setup.
10-7NetSpot Device Installer
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Checking the Processor Version of Windows Vista
If you are not sure whether you are using 32-bit Windows Vista or 64-bit Windows 
Vista, you can check that using the following procedure.

1 From the [Start] menu, select [Control Panel].

2 Click [System and Maintenance] ➞ [System].

3 Check the processor version of Windows Vista in [System 
type].

For 32-bit Windows Vista, [32-bit Operating System] appears.
For 64-bit Windows Vista, [64-bit Operating System] appears.
10-8 Checking the Processor Version of Windows Vista
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You can confirm the setting for [Spooling at Host] (whether the jobs are processed 
in the computer) using the following procedure.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

From the [Start] menu, select [Settings] ➞ [Printers].

  

From the [Start] menu, select [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printers and Other Hardware]
➞ [Printers and Faxes].

From the [Start] menu, select [Control Panel], and then click [Printer].

2 Right-click the icon for this printer, then select [Properties] 
from the pop-up menu.

Windows 2000

Windows XP Professional Windows Server 2003

Windows XP Home Edition

Windows Vista
10-9Confirming the Setting for [Spooling at Host]
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3 Display the [Device Settings] sheet aaaa, then confirm the setting 
for [Spooling at Host] bbbb.

NOTE
If [Disabled] is specified, some options are disabled.

a

b

10-10 Confirming the Setting for [Spooling at Host]
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Numerics
100 Indicator (Green), 9-18
2-sided Printing

Automatic 2-sided Printing, 5-10
Manual 2-sided Printing, 5-16

A
Alarm Indicator, 1-10, 8-25
Auxiliary Tray, 1-7

B
Booklet Printing, 6-33
Borders, 6-31
Brightness, 6-49

C
Cancel Job Indicator, 1-11
Cancel Job Key, 1-11, 5-23
Canceling a Job, 5-20
Canon Printer Uninstaller, 4-30, 4-31, 4-32
CAPT (Canon Advanced Printing Technology), 1-

2
CD-ROM, 1-4
Changing the Default Values for Printing 

Preferences, 5-8
Cleaning

Fixing Roller, 7-18
Outside of the Printer, 7-21

Client, 4-36, 4-48
Contrast, 6-49
Control Panel, 1-8, 1-10

D
[Device Settings] Sheet, 6-15
Dimensions, 10-5
Download Installation, 4-36, 4-48
Duplex Unit Cover, 1-8

E
Edit and Preview, 6-59
Enable Image Correction, 6-45
Envelopes, 3-4
ERR Indicator (Orange), 9-18
Expansion Slot, 1-8

F
Face-down Output Tray, 1-8, 3-13, 3-16
Face-up Output Slot, 1-8, 3-14, 3-16
Finishing, 6-37
[Finishing] Sheet, 6-12
Fixing Roller, 7-18
Foot Positions, 2-6
Front Cover, 1-7

G
Gutter, 6-35

H
Heavy Paper, 3-4
Help, 5-24
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I
Important Safety Instructions, xviii
Index Card, 3-4
Installation

Manuals, 5-29
Printer Driver, 4-5

Installation Environment, 2-3
Installation on Clients, 4-48
Installation Problems, 8-37
Installation Requirements, 2-4
Installation Site, 2-3
Installation Space, 2-5

L
Label, 3-4
LAN

Cable, 2-31
Connector, 9-18

Laser Beam, xxii
Lift Handles, 1-8
LNK Indicator (Green), 9-18
Load Paper Indicator, 1-10
Loading Paper

Custom Paper Size, 3-23
Custom Size Paper, 3-42
Envelope, 3-37
Index Card, 3-37
Multi-purpose Tray, 3-31
Paper Cassette, 3-17
Standard Size Paper, 3-17, 3-32

Local Installation, 4-36

M
MAC Address, 9-18
Manuals, 5-29
Miscellaneous Problems, 8-54
Multi-purpose Tray, 1-7, 3-12, 3-31

N
NB-C2, 9-15
NetSpot Device Installer, 10-7
Network Board, 1-13, 9-15

Initialization, 9-27
Installation, 9-19
Parts and Their Functions, 9-18
Removal, 9-31
Setting the DIP Switches, 9-24

Network Environment, 2-31, 4-36

O
Open Button, 1-8
Optional Accessories, 1-12, 9-1
Options

Network Board, 1-13, 9-15
Paper Feeder, 1-12, 9-2

Orientation, 6-41
Output Selection Cover, 1-8
Output Tray

Paper Capacity, 3-15
Selection, 3-16
Type, 3-13

P
[Page Setup] Sheet, 6-11
PageComposer, 6-59
Paper

Printable Area, 3-6
Storage, 3-8
Storing Printouts, 3-8

Paper Cassette, 1-7, 3-12, 3-17
Paper Feeder, 1-12, 9-2

Installation, 9-7
Removal, 9-13
Setting Printer Information, 9-11

Paper Guide, 1-7
Paper Jam Indicator, 1-10
Paper Jams, 8-3
Paper Level Indicator, 1-7
10-12 Index
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Paper Orientation, 3-40, 3-49
Paper Size, 3-2
Paper Size Switch Lever, 1-8
Paper Source, 3-9

Paper Capacity, 3-10
Precautions for Handling, 3-12
Selection, 3-11
Type, 3-9

[Paper Source] Sheet, 6-13
Paper Type, 3-3
Parts and Their Functions, 1-7
Peripheral Space Required, 2-5
Plain Paper, 3-3
Plug and Play

Windows 2000, 4-24
Windows Vista, 4-12
Windows XP/Server 2003, 4-19

Poster Printing, 6-25
Power Cord, 2-26
Power Socket, 1-8
Power Supply

Turning the Printer OFF, 2-34
Turning the Printer ON, 2-33

Power Supply Requirements, 2-4
Power Switch, 1-8
Pressure Release Levers, 1-8
Preview, 6-17
Print Grayscale Sample, 6-51
Print Server, 4-37
Print with Upper Left of Sheet as Starting Point, 

6-39
Printer

Cleaning, 7-21
Handling, 7-30
Moving, 7-24
Parts and Their Functions, 1-7

Printer Connector, 9-18
Printer Driver

Installation, 4-5
Uninstallation, 4-69

Printer Sharing Settings, 4-39
Printer Status Window

Cancel Job, 5-39
Canceling a Job, 5-22
Device Settings Menu, 5-37
Display, 5-35

Parts and Their Functions, 5-34
Preferences (Administrators) Dialog Box, 5-36
Preferences (Users) Dialog Box, 5-36
Print Queue, 5-39
Refresh, 5-38
Remote UI, 5-38
Resolve Error, 5-38
Utility Menu, 5-37

Printing, 5-2
Printing Date, 6-31
Printing Multiple Pages on One Sheet, 6-19
Problems

Installation, 8-37
Others, 8-54
Paper, 8-36
Paper Jams, 8-3
Print Quality, 8-30
Service Error Display, 8-26

Processor Version Check, 10-8
Profile

Adding, 6-55
Deleting, 6-57
Editing, 6-56
Selecting to Print, 6-53

[Profile] Sheet, 6-16

Q
[Quality] Sheet, 6-14

R
Ready Indicator, 1-11

S
Scaling, 6-22
Selecting Paper for Each Page, 6-43
Serial Number, 10-15
Service Error Display, 8-26
Shared Printer, 4-36
Specifications, 10-2
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Hardware, 10-2
Software, 10-4

Spooling at Host, 10-9
System Requirements, 4-2

T
Temperature/Humidity Conditions, 2-3
Test Page, 8-41
Toner Cartridge

Before replacing, 7-3
Precautions for Handling, 7-15
Replacement, 7-2
Storage, 7-17

Toner Cartridge Guide, 1-9
Toner Density, 6-47
Transparency, 3-4
Transport Guide, 1-9
Tray Extension, 1-7
Troubleshooting Flowchart, 8-2

U
Ultrasonic Humidifier, 2-3
Uninstallation

Manuals, 5-32
Printer Driver, 4-69

Unusable Paper, 3-7
Usable Paper, 3-2
USB

Cable, 2-29
Class Driver, 8-45
Connector, 1-8

V
Ventilation Slots, 1-8

W
Watermark, 6-27
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The serial number is required for receiving maintenance service. The serial number 
for this printer can be found at the locations shown in the following figure.

IMPORTANT
The labels on which the serial number is indicated are required for printer service or 
maintenance. Do not remove them.

■ Rear of the Printer

■ Outside View of the Packaging Box

Serial Number

Serial Number
10-15Location of the Serial Number



10

A
pp

en
di

x

10-16 Location of the Serial Number
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